LENESAS

-
7z
)
ﬁ“
7
=
Q
-
-
QO

ROE420000MCUOQO

User's Manual

Supported Devices:
H8S Family / H8S/Tiny Series

All information contained in these materials, including products and product specifications,
represents information on the product at the time of publication and is subject to change by
Renesas Electronics Corporation without notice. Please review the latest information published
by Renesas Electronics Corporation through various means, including the Renesas Electronics
Corporation website (http://www.renesas.com).

Renesas Electronics Rev.4.02 Sep 2021

www.renesas.com



N

1.

10.

11.

12.

13.
14.

otice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com/contact/.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products
covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor
devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the
level at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal
elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal
produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the
input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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Preface
The ROE420000MCUOQO is a full-spec emulator for MCUs of the H8S/Tiny-series. This user’s manual mainly describes
specifications of the ROE420000MCUOQ0 and how to set it up.

All the components of the ROE420000MCUOQ0 are listed under “1.1 Package Components” (page 16). If you have any
questions about the ROE420000MCUO00O, contact your local distributor.

The manuals relevant to usage of the ROE420000MCUQO are listed below. You can download the latest manuals from the
Renesas Tools homepage (https://www.renesas.com/tools).

Related manuals

Item Manual
Accessory ROE420000CFJ30 User’s Manual
ROE420000CFK30 User’s Manual
ROE420000CFG40 User’s Manual
ROE420000CFK40 User’s Manual
Integrated development environment | High-performance Embedded Workshop User’s Manual
Emulator debugger ROE420000MCUO00 User’s Manual
C/C++ compiler and assembler H8S, H8/300 Series C/C++ Compiler, Assembler, Optimizing Linkage Editor
Compiler Package User’s Manual

R20UT0967EJ0402 Rev.4.02 Page 4 of 230
Sep.01.21 ENESAS
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Important

Before using this product, be sure to read this user’s manual carefully.
Keep this user’s manual, and refer to it when you have questions about this product.

Emulator:
"Emulator"” in this document collectively refers to the following products manufactured by Renesas Electronics Corporation.

(1) E100 emulator main unit
(2) MCU unit
(3) Pitch converter board for connecting the user system

"Emulator" herein encompasses neither the customer's user system nor the host machine.

Purpose of use of the emulator:

This emulator is a device to support the development of systems that use the H8S family H8S/Tiny series of Renesas 16-bit
single-chip MCUs. It provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this emulator other than for its

intended purpose of use.

For those who use this emulator:
This emulator can only be used by those who have carefully read the user’s manual and know how to use it.
Use of this emulator requires basic knowledge of electric circuits, logical circuits, and MCUSs.

When using the emulator:

)

)
©)

(4)

(5)

(6)

()

This emulator is a development-support unit for use in your program development and evaluation stages. When a
program you have finished developing is to be incorporated in a mass-produced product, the judgment as to whether it
can be put to practical use is entirely your own responsibility, and should be based on evaluation of the device on which
it is installed and other experiments.

In no event shall Renesas Electronics Corporation be liable for any consequence arising from the use of this emulator.
Renesas Electronics Corporation strives to provide workarounds for and correct trouble with products malfunctions, with
some free and some incurring charges. However, this does not necessarily mean that Renesas Electronics Corporation
guarantees the provision of a workaround or correction under any circumstances.

The emulator covered by this document has been developed on the assumption that it will be used for program
development and evaluation in laboratories. Therefore, it does not fall within the scope of applicability of the Electrical
Appliance and Material Safety Law and protection against electromagnetic interference when used in Japan.

Renesas Electronics Corporation cannot predict all possible situations and possible cases of misuse that carry a potential
for danger. Therefore, the warnings in this user's manual and the warning labels attached to the emulator do not
necessarily cover all such possible situations and cases. The customer is responsible for correctly and safely using this
emulator.

The emulator covered by this document has not been through the process of checking conformance with UL or other
safety standards and IEC or other industry standards. This fact must be taken into account when the emulator is taken
from Japan to some other country.

Renesas Electronics Corporation will not assume responsibility of direct or indirect damage caused by an accidental
failure or malfunction in this emulator.

When disposing of the emulator:
Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

R20UT0967EJ0402 Rev.4.02
Sep.01.21 ENESAS
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Usage restrictions:
The emulator has been developed as a means of supporting system development by users. Therefore, do not use it as an
embedded device in other equipment. Also, do not use it to develop systems or equipment for use in the following fields.
(1) Transportation and vehicular
(2) Medical (equipment that has an involvement in human life)
(3) Aerospace
(4) Nuclear power control
(5) Undersea repeaters
If you are considering the use of the emulator for one of the above purposes, please be sure to consult your local distributor.

About product changes:
We are constantly making efforts to improve the design and performance of this emulator. Therefore, the specification or
design of this emulator, or this user’s manual, may be changed without prior notice.

About rights:

(1) We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of
any information, products or circuits presented in this user’s manual.

(2) The information or data in this user’s manual does not implicitly or otherwise grant a license to patent rights or any other
rights belonging to Renesas or to a third party.

(3) This user’s manual and this emulator are copyrighted, with all rights reserved by Renesas. This user’s manual may not be
copied, duplicated or reproduced, in whole or part, without prior written consent from Renesas.

About diagrams:
Some diagrams in this user’s manual may differ from the objects they represent.

R20UT0967EJ0402 Rev.4.02

Page 6 of 230
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Precautions for Safety

This chapter, by showing the relevant diagrammatic symbols and their meanings, describes the precautions which should be
taken in order to use this product safely and properly. Be sure to read and understand this chapter before using this product.
Contact us if you have any questions about the precautions described here.

WARNING indicates a potentially dangerous situation that will cause death or heavy

A WARNING wound unless it is avoided.

A CAUTION indicates a potentially dangerous situation that will cause a slight injury or
CAUTION a medium-degree injury or property damage unless it is avoided.

In addition to the two above, the following are also used as appropriate.

/\ means WARNING or CAUTION.

Example: ﬁ
CAUTION AGAINST AN ELECTRIC SHOCK

O means PROHIBITION.

Example: ®
DISASSEMBLY PROHIBITED

@ means A FORCIBLE ACTION.

Example: %
UNPLUG THE POWER CABLE FROM THE RECEPTACLE.

R20UT0967EJ0402 Rev.4.02 Page 7 of 230
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/\ WARNING
Warnings for AC Power Supply:

If the attached AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it forcibly.
Failure to comply may cause electric shock and/or fire.

Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.

This emulator is connected signal ground with frame ground. If your developing product is transform-less (not having
isolation transformer of AC power), this may cause electric shock. Also, this may give an un-repairable damage to this
emulator and your developing product.

While developing, connect AC power of the product to commercial power through isolation transformer in order to
avoid these dangers.

If other equipment is connected to the same branch circuit, care should be taken not to overload the circuit.

9 When installing this equipment, insure that a reliable ground connection is maintained.
%

If you smell a strange odor, hear an unusual sound, or see smoke coming from this product, then
disconnect power immediately by unplugging the AC power cable from the outlet.

Do not use this as it is because of the danger of electric shock and/or fire. In this case, contact
your local distributor.

Before setting up this emulator and connecting it to other devices, turn off power or remove a
power cable to prevent injury or product damage.

Warnings to Be Taken for Handling this Emulator:
Do not disassemble or modify this emulator. Personal injury due to electric shock may occur if
this emulator is disassembled and modified. Disassembling and modifying the emulator will void
your warranty.

Make sure nothing falls into the cooling fan on the top panel, especially liquids, metal objects, or
anything combustible.

Warning for Installation:
Do not set this product in water or areas of high humidity. Make sure that the product does not
%‘ get wet. Spilling water or some other liquid into the product may cause un-repairable damage.

Warning for Use Environment:
This equipment is to be used in an environment with a maximum ambient temperature of 35°C.
Care should be taken that this temperature is not exceeded.

Caution for AC Adapter:
The DC plug of the AC adapter has the polarity shown below.

@90

Use an AC adapter which complies with the safety standards of the country where it is to be
used.

R20UT0967EJ0402 Rev.4.02

Page 8 of 230
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ACAUTION

Cautions to Be Taken for Turning On the Power:

Turn ON/OFF the power of the emulator and the user system as simultaneously as possible.

When turning on the power again after shutting off the power, wait about 10 seconds.

Cautions to Be Taken for Handling This Product:

Use caution when handling the emulator. Be careful not to apply a mechanical shock.

Do not touch the connector pins of the emulator main unit and the target MCU connector pins directly. Static
electricity may damage the internal circuits.

When attaching and removing the cable, hold the plug of the cable and do not touch the cable. Do not pull the emulator
by the communications interface cable or the flexible cable. And, excessive flexing or force may break conductors.

Do not flex the flexible cable excessively. The cable may cause a break.

Do not use inch-size screws for this equipment. The screws used in this equipment are all 1ISO (meter-size) type
screws. When replacing screws, use same type screws as equipped before.

Do not tape the flexible cable or apply adhesives to secure the cable. The shielding material on the surface of the cable
may come off.

Caution to Be Taken for System Malfunctions:

-~

If the emulator malfunctions because of interference like external noise, do the following to remedy the trouble.

(1) Exit the emulator debugger, and shut OFF the emulator and the user system.
(2) After a lapse of 10 seconds, turn ON the power of the emulator and the user system again, then launch the
emulator debugger.

Note on Transporting the Product:

-~

When sending your product for repair, use the packing box and cushioning material supplied with the product when it
was delivered to you and specify caution in handling (handling as precision equipment). If packing of your product is
not complete, it may be damaged during transportation. When you pack your product in a bag, make sure to use the
conductive plastic bag supplied with the product (usually a blue bag). If you use a different bag, it may lead to further
trouble with your product due to static electricity.

Caution to Be Taken for Disposal:

)

Penalties may be applicable for incorrect disposal of this waste, in accordance with your national legislation.

European Union regulatory notices:

=

The WEEE (Waste Electrical and Electronic Equipment) regulations put responsibilities on producers for the
collection and recycling or disposal of electrical and electronic waste. Return of WEEE under these regulations is
applicable in the European Union only. This equipment (including all accessories) is not intended for household use.
After use the equipment cannot be disposed of as household waste, and the WEEE must be treated, recycled and
disposed of in an environmentally sound manner.

Renesas Electronics Europe GmbH can take back end of life equipment, register for this service at
“http://www.renesas.eu/weee”.

Contents

R20UT0967EJ0402 Rev.4.02
Sep.01.21 ENESAS

Page 9 of 230


http://www.renesas.eu/weee

ROE420000MCUO00 User’s Manual Contents

g 0Z0] £ 2= 1 o | TSP UPPPPRTTTNN 5
= Tor= 10 [0 TSR {0 G- -1 PR 7
L0 1 (=T o K3 SO PPTRR P 9
(ST g =T 115 1 = U1 o] o PRSP 14
JLIC=T 1110 T PSR 15
O 1 1 1 = SRR 16
IO T =T [ O o] 4] oo 1T o | £ O PSP PP OUPPPPP 16

1.2 Other Tool Products Required for DEVEIOPMENT .........ciiiiiiiieiiiiie ettt e 16

1.3 SYSEEM CONFIGUIALION ....ciitiieeiitie ettt ettt e e et e e e e s bt e e e aa b et e e e st et e e s anbe e e e e anbre e e e anbneeeeanneas 17
1.3.1 SyStem CONFIGUIALION ....coiviiiii ittt e ettt e st e e e st e e e e e sabb et e e e abbeeeeabnneeeanes 17

1.3.2 Names and Functions of the EMUIALOr PAITS ...........cueiiiiiiiiiiiiiie ettt 18

S 0T Tod o= L1 o] 1SRRI 20
1.4.1 ProducCt SPECIfICALIONS........c..iiiiiiie e e e e e e e e e e e e e s et e e e e e e e s santataeeeeaeeesannnnrrerraaaean 20

1.4.2 Regulatory ComplianCe NOLICES ........ccciiiiiiiee st e st e e e e e e e e e s s s st e e e e e e e e annrnraeeeeaeaen 21

1.4.3 Operating ENVIFONMENT .........uiiiiiiieeii e e e e s r e e e e e s e e e e e e e e s sste e e e e aaesssantataeeeeaeessannnnraneeaaeenn 22

P < LU o TR PP OPPPPPRTPN 24
2.1 Flowchart of Starting Up the EMUIALON ........coioiiiiiicc et e e e e e e e e e e s nrrane s 24

2.2 Installing the INCIUAEd SOTIWAIE ......coiiiiiiiiiiie et e et e et e e e st e e e e sabb e e e e sbneeeeaaes 26

2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit ............ccccceeeiiiieeenns 27

2.4 Connecting the HOSE IMACKHINE ........coiiiiiii et e et e e et b e e e st e e e e sbbeeeesbneeeeanes 28

2.5 Connecting the EMUIator POWET SUPPIY ......veeiiiiiiiie ittt ettt e et e e e st e e e e sbneeeeaaes 29

2.6 TUMNING ON The POWET ...ttt ettt e st e e e st e e e st bt e e e e bbe e e e e bb e e e e sbbeeeesbneeaeanes 30
2.6.1 Checking the Connections of the EMUIAtor SYStEM.........cocuuiiiiiiiiiiiii e 30

2.6.2 Turning the POWEr ON @0 OFF ........ouiiiiiiiiiiiiiiiieeeeeieeeeeeeeeeeeeseeeeeeeesesesasessssessssesssssssssssssssssssssssssnsnrnnes 30

2.7 SeIf-CRECKING e 31

2.8 Selecting the ClOCK SUPPIY ..o 32
2.8.1 ClOCK SOUICE ......ceeeie ettt ettt e e skt e e sttt e sk et e s st e e s bttt e s s e e e e s nn e e e e s nnnneee s 32

2.8.2 Using an Internal OsCillator CirCUit BOAIU ............uuuriieiieiieieieeiieiieeeeereseseseeeesseeerereeererererrrerere————. 33

2.8.3 Using the Oscillator Circuit 0N the USEr SYSIEM ........uviviiiiiiiiiiiiieieierireeieeeeeersesseeseereseeesererererrrerrre—... 34

2.8.4 Using the Internal GENErator CIrCUIL...........cuueiieiiieie ittt e e st e e s sabe e e e s snneee s 34

2.9 CoNNECHING the USEI SYSTEIM ...ttt ettt et e e e st e e e st b e e e e sbb e e e e sabbe e e e abbeeeesbneeeeanes 35
2.9.1 Connection to an 80-pin 0.65-mm Pitch Pad Pattern.............ccooiiiiiiiiiiiieiieee e 36

2.9.2 Connection to an 80-pin 0.5-mm Pitch Pad Pattern............ccoveiiiiiiiiiiiee e 37

2.9.3 Connection to a 64-pin 0.8-mm Pitch Pad Pattern.............cccvveiiiiiiiiiii e 38

2.9.4 Connection to a 64-pin 0.5-mm Pitch Pad Pattern.............ccceiiiiiiiiiiiii e 39

T V(o] = OO OO PP OP PR PPPRPTOUPRP 40
O A [ (oo (3Tt £ o T o OSSP PP PP TPTP 40

3.2 Starting the High-performance Embedded WOIrKSNOP ......covviiiiiiiiiiiiiiiiiiiiiiiieeeeieeeeeeeeeee e eeeveseeesessseseseseseseennes 41

T o ] [=Tox 11 o IR u a0 =1 4210 = o ) SO POPPPPPPRt 41

3.4 Downloading the TULOAl PrOQIAIM ..........eiiiiiiiiiiieieieeeieeeeeeeeeeeeeeeeeeeeeeeeeesseaeaesesssassssssssssssssssssssssssssssssssssnsnnnnnns 42
3.4.1 Downloading the TULOrial PrOQIAM...........uuieieiiiiiieeieeeeeeeieseeeeesseeseeesssesesasesesesesssarseererererarersrerrrarrrerrrrne 42

3.4.2 Displaying the SOUICE PrOGIaM .......oouuiiiiiiiiie ettt sttt e e bt e e s sb et e e s nanaeee s 43

3.5 Setting SOftWare BreakPOINTS ...........iii ittt b bbbt nnnree s 44

3.6 EXECULING the PTrOGIAM ....ciiiiiiiiieiiitiee ettt sttt e s bbbt e e s bbbt e e e enbb e e e e aabb e e e e sabbe e e e annneee s 45
3.6.1 RESELHNG the CPU......eeiiiiiii ettt ettt e bb bt e e s aab bt e e s aabb e e e s nanneee s 45

3.6.2 EXECULING T PrOGIGIM ...cci ittt ettt b et e skt e e s bbbt e e s abe e e e s anbbe e e s annneee s 45

3.7 CheCKing BreakPOiNtS. ......coi i uiiiiiiiiie ettt s bbbt s b bt e s bbbt e e e anbb e e e e anbb e e e e nb et e e e nnnree s 46
3.7.1 L@ aT=Tod (] o T = (== 14 0101 46

3.8 ALEriNG REQISTEI CONTENES. ....iiiiiiiiiiiiiiiiiiee e eeeeeee et eeee et eeeeeeeeeeeeeeeeeeeeeeaseesssseessesesasssssssssssssssssssssssesssnsssssnnsnnnnnes 47

3.9 REFEITING 10 SYMIDOIS ...ttt e oo e ettt e e e e e e e s bbb e et e e e e e e s e anbbbeeeeaaeeeaaannes 48
3.10 Checking MEmMOIY CONLENLS ......uuiiiiiieiiiiiitet it e e ettt e e e e e e et bbb et e ee e e s e s s e beeeeeeeeeaaabnbeeeeaaeeesaaassbbeeeaaaeeaaaannes 49
3.11 RefErriNgG 10 VAIADIES ......coo ittt e e e e e s e s bbbt e e e e e e e e e e s nnbeeeeeaeeeeaannes 50
3.12 ShowWiNg LOCAl VAADIES ...ttt ettt e e e e e s ettt e e e e e e s e e nnbbeeeeaaeeeaannes 52
3.13 Single-Stepping through @ PrOGram .. ......ooiiiiiie et e e st e e abe e e s enbae e e s anneeee s 52
3.13.1 Executing Step IN COMIMANT ......ooiiiiiiiieiiiiie ettt et e ettt e et e e s ab et e e s nee e e e sabeeeesnnbeeeessnneeeens 53

3.13.2 Executing the Step OUt COMMIEANG.........ciiuiiiiiiiiiii et e e st e e s snbe e e s snnneee s 54

3.13.3 Executing the Step OVEr COMMANT.........cuuiiiiiiiiiie ittt e e s e e s snbe e e s snbeeeessnneeeess 55

3.14 Forcibly Breaking Program EXECULION ........c..eiiiiiiiiie ittt sttt e e e e s nnae e e s snneeee s 56
3.15 Hardware Bre@k FACIILy .........oooiiiiiiiiiiiee ettt sttt ettt e s ettt e e s et e e s anbb e e e s snnt e e e s nnneeee s 57
3.15.1  Stopping a Program when It Executes the Instruction at a Specified Address ..........ccccuvveeeeeennn. 57

3.16 Stopping a Program When It ACCESSES MEMOIY .......uuiiiiiiiiiiiiiieiie ettt ee e e e e st e e e e e e e s annbeeeeeaaeeeaannes 58
T I = T [ To = T 1 Y ST OPPUPPPRTN 59

R20UT0967EJ0402 Rev.4.02

Page 10 of 230
Sep.01.21 ENESAS



ROE420000MCUO00 User’s Manual Contents

3.17.1  Showing the Information Acquired in “Fill Until Stop” Tracing........ccccccceeeviiiciiieieeee e ecieeeeeeen 60
3.17.2  Showing the Information Acquired in “Fill around TP” Tracing........cccccveevivicirieeeeee e seeiiieeeeeeen 63
3.17.3  Showing a History of FUNCLION EXECULION .........cuiiiiiiiiiiiiiiecc e e e e e e e 65
3.17.4 L 1L =T g Vo ) SRR 67
TS S v Tt I = Uo =T -V 1) SRR 69
oL WWNAE INEXE? .ttt ettt ettt ettt ekt o ettt oo he e ookt e e o a ket e oh ke e e a bt e ek e e e 4R ke a2 eh e e e ehb e e e b e e e ambeeenbeeeanbeeeabeeeenbeeaa 70
4. Preparation fOr DEIUGGING . ... .uiii ittt ettt e s bbbt e sttt e e s bbe et e s bbbt e e s b b be e e s anb e e e e e annne e s 71
4.1 Starting the High-performance Embedded WOrKSNOP .........c.uviiiiiiiiiii e 71
4.2 Creating a New Workspace (Toolchain UNUSE) ...........uiiiiiiiiiiiiiie et 72
4.3 Creating a New Workspace (with @ Toolchain in USE).........cuuiiiiiiiiiiiii e 74
4.4  Opening an EXiStNG WOIKSPACE .......couuiiieiiiiieeiiiiie ettt ettt et e st e e e anb et e e anbn e e e nnns 77
I @4o ) ] a [=Tod 1o IR TN =1 01U F= o SRR 78
4.5.1 ConNECtiNG the EMUIALOT ........cii it e e s r e e e e s s et e e e e e e e s santaaaeeeeeeeessnnrrnnees 78
45.2 Reconnecting the EMUIALOL .......oeiiiiii e e e r e e e s e e e e e e e e s e e anrrnaeees 78

4.6 DisconnNeCtiNg the EMUIALOL ........uuiiiiie i e e e e e s s e e e e e e s et e e e e e e s e ssastaaeeeeeeessassnnaraneeaeeaaannnes 78
46.1 DisScoNNECting the EMUIALOT .......cciii it e e e r e e e e e st ee e e e e e e s e s anrrnneees 78

4.7 Quitting the High-performance Embedded WOrkShOp .........coocuiiiiiiii e 78
4.8 Making Debugging-Related SEtliNGS.......cociiiriiiiiiiiieiiiee et 79
48.1 Specifying a Module for DOWNIOAAING .......cccoiuiiiiiiiiiieiiit e 79
4.8.2 Setting Up Automatic Execution of Command Line Batch FileS...........occcviiiiiiiiiiiee s 80

5. DEBUGGING FUNCLIONS .....eeieiiii ettt et e e e ot e e e e sa bt e e e oa ket e e e aab et e e e aabb e e e e anbb e e e e anbbeeeeanbneeeesbbeeeennes 81
5.1 Setting Up the EMUIation ENVIFONMENT .......ouuiiiiiiiiii ittt eb e e anne e e nnnneee s 83
51.1 Emulator Settings DUring BOOTING U .....veieiiiiiieiiiiie ettt 83
5.1.2 Setting Up the Target MCU ... s 84
5.1.3 Setting UP the SYStemM ... .o 85
514 Setting for Overwriting Blocks of the Flash ROM ........cccoooiiiiiiiiiiccceesee e 87
5.1.5 Settings to Request Notification of Exceptional EVENS........cccooeiiiiiiiiiiiiiiicccceccceeees e 88
5.1.6 Viewing the Progress of BOOt-UP PrOCESSING........uuuuureirieriiiieiieeeeeererereeerereresereeerererereeere... 89

LT o 111V o1 [0 7= To [T T = {0 | = 1 o PO PPPPPNt 91
5.2.1 DOWNIOAAING @ PrOGIAM ...coiiuiiiiieiiiiti ettt ettt e e et e e s e bt e e e e abne e e e nnenas 91
5.2.2 VIEWING the SOUMCE COOE ....cociiiiiiiiiiiiee ettt ettt e e e st e e e e sbae e e e abreeeeanes 91
5.2.3 Turning columns in all SOUrce files Off ..........ooi i 93
524 Turning columns off for oNe SOUICE file .......oooiiiiiii e 93
525 Viewing Assembly Language COOE ........cocuuiiiiiiiiiei ittt e et e e e e e e anes 94
5.2.6 Correcting Assembly Language COOE .......oooiiiiiiiiiiie ettt et e 95

5.3  Viewing Memory Data in REaAI TIME .......ouiiiiiiiiiiiiiiiiiieieeeieeeeeeeeee e e e eeeaesesasssesssssssssssssssssssesssssssssesssnnnnns 96
5.3.1 Viewing Memory Data in Real TIMe ... 96
5.3.2 Setting the Update Interval for RAM MORNItOING ....ccoooeeeeeee e 97
5.3.3 Clearing RAM Monitoring ACCESS HiSOIY ... ..ciiiii i 97
5.34 Clearing RAM Monitoring Error Detection Data..........ccooeeeiiiiieciiececccccccece s 97

5.4 VieWiNQ the CUIMENT STALUS ......ooviiiiiiiieiiiiiiiieieieieeeeeeee e eeeeeeeeeeseaeeeesesesasesesssesesasssssssssssssssssssssssessssssssssssnnnnnns 98
54.1 Viewing the EMUIATOT STALUS........ccoiiiiiiii ittt e et e e e sbneeeeanes 98
54.2 Viewing the Emulator Status in the Status Bar ... 99

5.5 Periodically Reading Out and Showing the EmMulator Status.............occieiiiiee i 100
55.1 Periodically Reading Out and Showing the Emulator Information..............ccooecviveeeiiiicinnnnen. 100
5.5.2 Selecting the 1tems t0 Be DiSPIaYEd..........coiiiiiiiiiiiiiic et 101

5.6 USING SOftWAre Bre@KPOINTS ........uiiiiiiiiiie ittt ettt ettt e st e e e ekt e e s e st e e e e nabee e e e nnnas 102
5.6.1 Using Software BreakPOINTS ............eeueeeiiii s 102
5.6.2 Adding and Removing Software BreakpointS ..............uuueveeriiiieriiiieeieeieeeeeeeeeeeesreseseresereeer... 102
5.6.3 Enabling and Disabling Software Breakpoints. ... 104

LT A U 1o To =T o £ PP PP PPPRRPT 106
5.7.1 USING EVENTS ...ttt e e o4 e e bbbttt e e e e e e e bbb et e e e e e e e s e nbbbbeeeeaeeesannbeeneeas 106
5.7.2 P Yo (o [T gVl A= o] £ TP UPPTT PP 106
5.7.3 REMOVING EVENTS ..ottt e bt e et e e e snb et e e e st e e e e s snbbeeeennteas 112
5.7.4 REGISIEIING EVENTS...coiiiiiiiiii ittt ettt e bt e e s ra bt e e e anb et e e e snbee e e s snbaeeeennneas 114
5.7.5 Creating Events for Each Instance of Usage or Reusing EVents ...........cccccvviiieiiiiieeiciiieenens 116
5.7.6 ACHVALING EVENTS ...eiiiiiiiiieie et e st e e e e bt e e e e nb e e e e nbae e e e nneeas 117

5.8 Setting Hardware Break CONItIONS ........coouuuiiiiiiiiie ettt sttt e e st e e e e nbe e e e e nneeas 118
5.8.1 Setting Hardware Break CONItIONS. ..........eiiiiiiiieiiiiiee ettt e e e e baeee e 118
5.8.2 Setting Hardware BreakPOiNtS .......... o i iiereieieee ittt e e ettt e e e e e e s s snnbeeeeaaeeeaannnnes 118
5.8.3 Saving/Loading Hardware Break SettiNgS.........ooi it e e 121

5.9  Viewing Trace INFOIMALION .........eiiiiiiiiiiii ittt e ettt e e e e ettt e e e e e e s e s anbbeeeeeaeeseannnbbeeeaaaeesaannnes 122

R20UT0967EJ0402 Rev.4.02
Sep.01.21 ENESAS

Page 11 of 230



ROE420000MCUO00 User’s Manual Contents

5.9.1 Viewing Trace INfOrMAtION ........ciiii i e s s e e e e e s s et e e e e e e s e annreeneees 122
5.9.2 PaXoto [0 1¢TaTe I I c= Vot [0 {0] €. =1 1 o o PR 122
5.9.3 Setting Conditions for Trace Information ACQUISItION...........cccviiiiiieeei e e e 124
5.9.4 Selecting the TraCe MOUE.........uiiiiiiie e e e e e s e s r e e e e e s e snnntaeeeeeeeeaaannes 126
5.9.5 Y=y 0] o I = To I o | € PRSP 128
5.9.6 Setting Extraction or Elimination ConditioNS...........c..ueiiiiiiiiiiiiiee e 132
5.9.7 Selecting the Type of Trace Information to be ACQUIred .........c.coeiiiiieiiiiiiee e 134
5.9.8 VIEWING TIACE RESUILS ...ttt ettt ettt et e e s st e e s nbr e e e s aanneee s 135
5.9.9 Filtering Trace INfOrMEAaLION ........ccoiuiiii et 137
5.9.10  Searching for Trace RECOIS........uuiii ittt anb e e e e 139
5.9.11  Saving Trace INformation iN FlES ...........oiiiiiii e 140
5.9.12 Loading Trace Information from FileS ..........ccoiiiiiiiiiiie e 141
5.9.13  Temporarily Stopping Trace ACQUISITION ........ccuuiiiiiieeeie it e e e e s s st e e e e e s s s rr e e e e e e s e e snnnrnnees 141
5.9.14 Restarting Trace ACQUISITION .........coiiiiiiiiiiie e e e e e s s e e e e e s s e e e e e e e s st e e e e e e e e e snnnrnnneees 141
5.9.15  Switching the Timestamp DiSPIAY ........uueerieeiiiiiiiiiiiie e s s e e e e e rrr e e e e e s e e snararees 141
5.9.16  Viewing the History of FUNCLION EXECULION .........uuviiieeeiiiiiiiieeie e e e s ciirer e e e e s s e e e e e e e e e snnneene s 142
5.9.17  Viewing the History of Task EXECULION ..........occiiiiiiiei et e e 143
5.10 MeasUING PeITOMMIANCE ........oiiiiiiiieiiiit ettt ettt et e s e b bt e e ek bt e e e b e e e e nnbn e e e e nnenes 144
5.10.1 MeasUING PErfOrMANCE .........uiiiiiiiii ettt e e e e et e e e snnns 144
5.10.2  Viewing the Results of Performance MeasuremMent ...........cccuveiiieieiiiiiee i 144
5.10.3  Setting Performance Measurement CONAItIONS ...........c.uuiiiiiiiieiiiiiie e 145
5.10.4  Starting Performance MEaSUIEIMENT.........cocuuiie ittt e e neees 147
5.10.5  Clearing Performance Measurement CONAItIONS...........uuiiiriiiieiiiiiee e 148
5.10.6 Clearing Results of Performance Measurement..........ccooieiieiieiiiiicceeeeescc e 148
5.10.7 Maximum Time of Performance MeasUremMent ...........cccveeiiirieeiiiiee e 148
5.11 MeaSUrNG COUE COVEIAQE ......uuveeieieeiiieeieeeeeeeeeeeeeteteeeteeesaaeeeeeeeeesarereereererererererarererererrerrrrrrrm 149
5.11.1 Y =T U o T @ o [T @0 1V =T = Vo [ 149
5.11.2 Opening the Code Coverage WINAOW ........coooiiiiiioiiiiciee s 149
5.11.3  Allocating Code Coverage Memory (Hardware RESOUICE) .........uvuvererereeereeereeerereresnnenesnnenennnenes 150
5.11.4  Code Coverage in an AdAreSS RANGE ......cocuuuiie ittt ettt 153
5.11.5  Code Coverage in @ SOUICE Fil.........cuuiiiiiiiiieiiiie e 154
5.11.6  Showing Percentages and GrapRiS.........cooiuiiie ittt 155
5.11.7 SOrtiNG COVEIAGE DALA .....eeiiiiiiiii ittt e st e e e st e e e sbb e e e e sbreeeeabaeeeeanes 156
5.11.8  Searching for NONEXECULEA LINES.......c.uuiiiiiiiiieiiiie ettt 157
5.11.9  Clearing Code Coverage INfFOrMEALION .........c.uuiieiiiiiieiiie e 158
5.11.10 Updating Coverage INfOrMALtION............euuiiiiiiiieieiieeeiiieieeeeeeeeeeseeeresareseseeeseserererererererererer—————. 158
5.11.11 Preventing Updates to Coverage INfOrmMation ...............eueviieiiiiiiiirieiieeeeeeeeeeereeeserererererererer... 158
5.11.12 Saving the Code Coverage Information in @ Fil€.............uuviiiiiiiiiiiiiiiiieiieeeieieeeeeeeeeeeeeeeeeeeeeanenenes 159
5.11.13 Loading Code Coverage Information from a File................eeviiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeveeeeeeeaeaeens 159
5.11.14 Modes of Loading for Coverage INformation FileS.............uuuiiiiiiiiiiiiiiiiiieeeieeeeeeeeeeeeeeeeeeeeeeeeneaenes 160
5.11.15 Displaying Code Coverage Information in the Editor Window.................evvvvieivieveviieieveiiiiiennnnnns 162
5.12 MeaSUIiNg Dat@ COVEIAGE ......ccuueiiaiiiiiie ittt ettt ettt ettt e e s e bt e e s e bt e e e s et be e e e e bb e e e e sabbe e e e eanbbeeeenabaeeeeanbeas 163
5.12.1 MeEaSUINNG DAtB COVETAGE ... ..eeieiiiiiee ettt ettt ettt et e e st e e e e aabe e e e e anbe e e e e anbeeeeeanbnas 163
5.12.2  Opening the Data Coverage WINGOW .............oiiiiiiieiiiiee e 163
5.12.3  Allocating Data Coverage Memory (Hardware RESOUICE) ........cccueieiiiiiieiiiiiiee e 164
5.12.4 Data Coverage in an AddreSS RANGE ......cooiiiiiiiiiiiie ettt 166
5.12.5 Data COVEIage iN SECHONS ......ccii ittt ettt e e et e e et e e e anenas 167
5.12.6 Data Coverage in the TasK StACK ...........uuiiiiiiii s 168
5.12.7 Clearing Data Coverage INfOrmation ...........cooooiiiiiiiiiii e 169
5.12.8 Updating Coverage INfOrMAatioN ...........uuuiiiiiiiiiiee et e e e 169
5.12.9 Preventing Updates to Coverage INfOrmMation ... 169
5.12.10 Saving the Data Coverage Information in @ File ..o, 170
5.12.11 Loading Data Coverage Information from a File............occuuiiiiiiiiiiiii e, 170
5.13 Viewing Realtime Profile INfOrMAatIoN ............oooiiiiiiiii e 172
5.13.1  Viewing Realtime Profile INfOrmation..............cooiiiiiiiiii e 172
5.13.2  Selecting a Realtime Profile Measurement MOGE ..........coooiiiiiiiiiiie e 174
5.13.3 Measuring FUNCLION PrOfIlES .......oouiiiii e e 175
5.13.4  Setting Ranges for Function Profile Measurement ..o 176
5.13.,5  Saving Function Profile Measurement SEttiNgS.........oocuuiiiiiiiieiiiiiee e 177
5.13.6 Loading Function Profile Measurement SEttNQS ......c.oooiiiiiiiiiiiieee it 177
5.13.7 Measuring TasK Profiles ...t 178
5.13.8  Setting Ranges for Task Profile MeasuremMent...........cooiiiiiiiiiaiiiiiiieieee e 179

R20UT0967EJ0402 Rev.4.02

Sep.01.21

Page 12 of 230
RENESAS



ROE420000MCUO00 User’s Manual Contents

5.13.9  Saving Task Profile Measurement SEttNgS.........uuevieeeiiiiiiiiiiiee e e e e e 180
5.13.10 Loading Task Profile Measurement SEttiNGS .........uuieeeiiiiiiiiiiiee et e e e e s e e e e snereeees 180
5.13.11 Clearing Results of Realtime Profile Measurement..........cccvevveeeiiiciiieiiee e 181
5.13.12 Saving Results of Realtime Profile Measurement ..........cccvvvviieee i 181
5.13.13 Setting the Unit 0f MEASUIEMENT ........uuiiiiii i e e e e e e e e e e e s e e snrraaeees 181
5.13.14 Maximum Measurement Time for Realtime Profiles...........ccccceiiiiiic e, 182
5.14 Detecting EXCEPLIONAI EVENTS .......oooiiiiiiiiiiiii ittt ettt e e e et e e e e 183
514.1 Detecting EXCePioNal EVENTS ..........oiiiiiii ittt 183
5.14.2 Detecting Violations 0f ACCESS ProteCioN .........coccuviiiiiiiiieiiiiie e 183
5.14.3  Setting ProteCtion fOr @N ATCa.........cooiiiiiieiiiie ettt 185
5.14.4 Detecting Reading from a Non-initialized Area............ocviiiiiiiiiiiiiiee et 189
5.14.5 Detecting Stack ACCESS VIOIAtIONS ........uuiiiiiiiiiiiiiiec e 190
5.14.6 Detecting a Performance-Measurement OVErflow ...........cccvveviie i 191
5.14.7 Detecting a Realtime Profile OVErflOW ..........cooiiiiiiiie e 191
5.14.8 Detecting a Trace Memory OVEITIOW .......cciieiiiiiiiiiiieie e r e e e st e e e e e e s nnaenae s 192
5.14.9 Detecting Task Stack ACCESS VIOIAtioONS .........ccuvviiiiieeiiiciiie e 192
5.14.10 Setting @ TASK STACK AIB@ ...uuiiiieeiiiiiiiieii ettt e e e e e e e s e s e e e e e e s e st e rn e e e e e e s e annnrnneees 193
5.14.11 Detecting an OS DISPALCH ......ccciiuiiiiiiiiiiie ittt 197
5.15 UsiNg the STart/STOP FUNCLON .......cooiiiiieiiiiii ettt e et e e s e nb e e e e nabn e e e e nnenes 198
5.15.1  Opening the Start/Stop Function Setting Dialog BOX .........cccuvieiiiiiieiiiiiie et 198
5.15.2  Specifying the WOrK a00rESS ........uuiiiiiiiieiiie ettt 198
5.15.3  Specifying the Routine t0 be EXECULE..........uviiiiiiiiiie e 198
5.15.4 Limitations of the Start/Stop FUNCHON...........cuiiiiiii e 199
5.15.5 Limitations on Statements within Specified ROULINES ...........coiiiiiiiiiiiie e 199
5.16 Using the Trigger OULPUL FUNCIION ...........viiiiiiiiieiiieieeeeeeeeeeeeeeeeeeeeeeeseeeeeseessesesesassssssssssssssssssssssssnssnsssnnsnnnes 200
5.16.1 Using the External Trigger Cable for OQUIPUL ............uuiiii e 200
5.16.2 Opening the Trigger Output Conditions Dialog BOX .....cccceeeeiiiiiiiiiiccice s 201
5.16.3 Manual Setting for Output through Trigger PiNS 3110 24 ........uuuuuiii e 202
5.16.4 Setting for Output through Trigger Pins 20 10 16.......ccooeiiiiiiiie e 204
5.16.5 Y] 0 PP P P U PP PPTTPRRPPRPPPIN 205
5.17 Measuring the Execution Times in @ SPeCific SECHON .......c..uiiiiiiiiiiiii e 205
5.17.1  Setting Trace CONMILIONS .......eiiiiiiiiieiiie ittt ettt et e e s s bt e e e aebe e e e e annnas 205
5.17.2  ACQUINNG TrACE DALA .....eeiiiieiiieiiiiie ettt ettt et e et e e e et e e e e e nbe e e e e anenes 206
5.17.3  SPECITYING 8 SECLON .....eeiiiiiiiii ettt et et e e e bt e e e s bb e e e enbr e e e e annnes 206
5.17.4  Saving the Execution TIMES 10 & FIle .......coiuiiiiiii e 207

6. Troubleshooting (ACtion iN Case Of @N EFTOK) .......uuu s 208
6.1 Flowchart for Remediation Of TrOUDIE .......oooiiiiii e 208
6.2 Error in Self-CheCKing ... 209
6.3 Errors Reported in Booting-up of the Emulator ... 210
6.4 HOW 1O REQUEST SUPPOIT . eeititiiiiii ettt e ettt e e e e e et ae e a e s e e et et e te bt e e e e et eesbaaan s e e et eeeesb s seeeeeeeesbnnnneeaaaees 212
7. Hardware SPECITICALIONS ........uuuiiiii s 213
7.1 Target MCU SPECITICALIONS .....cciitiiiii ittt ettt et bt e s bbbt e s bbbt e e s anbe e e e s anbbeeesannneeens 213
7.2 Differences between the Actual MCU and EMUIALOT ........cocuuiiiiiiiiiiiiii et 214
FAR N oo ala=Tol i{o] ol BIT: Vo] = 1o (PRSP PUPROPPP 216
7.3.1 Connection Diagram for the ROE420000MCUOD ..........uuiiiiiiiieiiiiie ettt 216

A e =T g = U D 4 1= 1] o 217
7.4.1 External Dimensions of the EL100 EMUIALON .........oioeiiiiiiie et e e e e e e 217
7.4.2 External Dimensions of the Converter Board (ROE420000CFJ30) ........cvvviiiieiiieieeeiereeeeerereeerennnnnnnns 218
7.4.3 External Dimensions of the Converter Board (ROE420000CFKS30)........ccuuviirriiieieiieerereeererererennnnnnnn. 219
7.4.4 External Dimensions of the Converter Board (ROE420000CFG40) ........cuuviiiiieiiiiiiiiiieeee e 220
7.4.5 External Dimensions of the Converter Board (ROE420000CFKA40)..........uuviiiiiiiiiiiiiieeee e, 221

7.5 Notes 0N USING the MCU UNIL .....oooiiiiiieiie ettt e e e e e st e e e e e s e s annb et ae e e e e e e e s anrneneeas 222
8. MaNtENANCE AN WAITANTY ......eeeiiiiiei ittt e ettt e e e ettt e e e e e o s aababe e e e e e e e e s e ababeeeeaaeeesannbebeeeeaaeeeaannbnbneaaaaaaeas 226
W LT g m LT o 113 = o] PP PSR 226
S I .- 11 (=1 = o - SO SES 226
RV oL =T o | PP PP P PP PPPPPPRRPPP 226
R =T o F= 11 g o (Y7 1= o g PP PSR 227
8.5 HOW tO REGQUEST REPEIIS. ...ttt ettt ettt e sttt e e s ekt e e e e a bt e e e e st e e e e e st e e e e e nbee e e e nbaeeeenneeas 227
VIS To] o I ] o RSO PRTTPI 1

R20UT0967EJ0402 Rev.4.02

Page 13 of 230
Sep.01.21 ENESAS



ROE420000MCUQ0 User’s Manual User Registration

User Registration

When you install debugger software, a text file for user registration is created on your PC. Fill it in and email it to your local
distributor. If you have replaced an emulator main unit or emulation probe, rewrite an emulator name and serial number in the
text file you filled in earlier to register your new hardware products.

Your registered information is used for only after-sale services, and not for any other purposes. Without user registration, you
will not be able to receive maintenance services such as a notification of field changes or trouble information. So be sure to

carry out the user registration.

For more information about user registration, please contact your local distributor.
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Terminology

Some specific words used in this user's manual are defined below.

MCU unit (ROE420000MCUO00)
This means the E100 emulator for the H8S/Tiny series.

Emulator system

This means an emulator system built around the MCU unit (ROE420000MCUO00). The emulator system is configured with an
emulator main unit (ROE001000EMUO00), MCU unit (ROE420000MCUQ0), emulator power supply, USB cable, emulator
debugger and host machine.

Integrated development environment: High-performance Embedded Workshop

This tool provides powerful support for the development of embedded applications for Renesas microcomputers. It has an
emulator debugger function allowing the emulator to be controlled from the host machine via an interface. Furthermore, it
permits a range of operations from editing a project to building and debugging it to be performed within the same application.
In addition, it supports version management.

Emulator debugger
This means a software tool that is started up from the High-performance Embedded Workshop, and controls the MCU unit and
enables debugging.

Firmware
This means a control program stored in the emulator. This analyzes the contents of communications with the emulator
debugger and controls the emulator hardware. To upgrade the firmware, download the program from the emulator debugger.

Host machine
This means a personal computer used to control the emulator.

Target MCU
This means the MCU to be debugged.

User system
This means a user's application system in which the MCU to be debugged is used.

User program
This means the program to be debugged.

Evaluation MCU
This means the MCU mounted on the emulator which is operated in a dedicated mode for use with tools.

#
This symbol indicates that a signal is active-low (e.g. RESET#).
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1. Outline

This chapter describes the package components, the system configuration, and the specifications of the emulator functions and
operating environment.

1.1 Package Components
The ROE420000MCUO00 package consists of the following items. After you have unpacked the box, check if your
ROE420000MCUO0O contains all of these items.

Table 1.1 Package components

Item Quantity
ROE420000MCUQ00 MCU board 1
Oscillator module (20 MHz) mounted in the 1C11 socket
ROE001000FL X10 flexible cable
ROE420000MCUO00 Release Notes (English)
ROE420000MCUO00 Release Notes (Japanese)
Repair Request Sheet (English)
Repair Request Sheet (Japanese)
CD-ROM - H8S/Tiny H8S/2400 E100 Emulator Software
(H8S/Tiny H8S/2400 E100 Emulator Debugger included)
- User’s Manual
* Please keep the ROE420000MCUOQ0's packing box and cushioning materials at hand for later reuse in sending the product
for repairs or for other purposes. Always use the original packing box and cushioning material when transporting the MCU
unit.
* If you have any questions or are in doubt about any point regarding the packaged product, contact your local distributor.

L LN

1.2 Other Tool Products Required for Development
To proceed with the development of a program for an H8S-family H8S/Tiny-series MCU, the products listed below are
necessary in addition to those contained in the package and listed above. Procure these products separately.

Table 1.2 Other tool products required for development

Product Part No.
Emulator main unit E100 ROE001000EMUOQ0
80-pin 0.65-mm pitch LQFP (PLQPO080JA-A  Former code: FP-80W) ROE420000CFJ30
80-pin 0.5-mm pitch LQFP (PLQPO080KB-A  Former code: 80P6Q-A) ROE420000CFK30
64-pin 0.8-mm pitch LQFP (PLQPO064GA-A  Former code: 64P6U-A) ROE420000CFG40
64-pin 0.5-mm pitch LQFP (PLQP0064KB-A  Former code: 64P6Q-A, FP-64K) | ROE420000CFK40

* To purchase these products, contact your local distributor.

R20UT0967EJ0402 Rev.4.02 Page 16 of 230

Sep.01.21 RENESAS



ROE420000MCUOQ0 User’s Manual 1. Outline

1.3 System Configuration

1.3.1 System Configuration
Figure 1.1 shows the configuration of the emulator system.

(4) USB interface cable (1) MCU unit
ROE420000MCU00

(2) Flexible cable

L

(7) Pitch converter board for
connecting the user system

[ et i (G0 (R (et 1B I 0,

3 257 ¢ 1 e =7 1 e

-

/ / "v}rﬁlltrlr;erlllf1*|*1‘1;xl|“l1‘" \
|

i = o N (5) AC adapter power
\ supply for the emulator
(6) Host machine (3) E100 emulator (8) User system and user
main unit system power supply

Figure 1.1 System configuration

(1) MCU unit ROE420000MCUOQO (this product)
This is an MCU board for the H8S/Tiny-series MCUs and contains an evaluation MCU.
(2) Flexible cable ROEO01000FLX10 (included)
(3) E100 emulator main unit ROE001000EMUOQO
This is the E100 emulator main unit.
(4) USB interface cable
This is an interface cable for the host machine and emulator.
(5) AC adapter supply for the emulator
(6) Host machine
A personal computer to control the emulator.
(7) Pitch converter board for connecting the user system (e.g. ROE420000CFJ30).
(8) User system and user system power supply
User system is your application system. This emulator can be used without the user system.
The user system power supply is power supply for the user system. This emulator cannot supply power to the user system.
Get a power supply separately.
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1.3.2 Names and Functions of the Emulator Parts
Figure 1.2 shows the names of the emulator parts.

(5) System status LEDs (4) External trigger connector

(1) Power switch

(2) USB cable connector

\ : 5 (3) Power connector

(6) Target status LEDs

Figure 1.2 Names of the emulator parts

(1) Power switch
This is a switch to turn the emulator ON and OFF.

(2) USB cable connector
This is a connector for connecting the USB cable of the emulator.

(3) Power connector
This is a connector for connecting the DC cable of the AC power adapter of the emulator.

(4) External trigger connector
This is a connector to connect the external trigger cable of the emulator.
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(5) System Status LEDs

The system status LEDs indicate the E100 emulator’s power supply, operating state of firmware, etc. Table 1.3 lists the
definitions of the system status LEDs.

Table 1.3 Definitions of the system status LEDs

Name Status Meaning
POWER ON Emulator system power is turned ON.
OFF Emulator system power is turned OFF.
SAFE ON Emulator system is operating normally.
Flashing Emulator system cannot communicate with the host machine.
Flashing Self-checking is in progress.
(every 2 seconds)
OFF Emulator system is not operating normally (system status error).

(6) Target Status LEDs

The target status LEDs indicate the operating state of the target MCU and power supply of the user system. Table 1.4 lists
the definitions of the target status LEDs.

Table 1.4 Definitions of the target status LEDs

Name Status Meaning
POWER ON Power is being supplied to the user system.
OFF Power is not being supplied to the user system.
RESET ON Target MCU is being reset, or reset signal of the user system is held low.
OFF Target MCU is not being reset.
RUN ON User program is being executed.
OFF User program has been halted.

Note on the Target Status POWER LED:
If your MCU has two or more Vcc pins, the LED does not light up unless power is supplied to all the pins.
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1.4 Specifications
1.4.1 Product Specifications

Table 1.5 lists the specifications of the ROE420000MCUQ0.

Table 1.5 Specifications of the ROE420000MCUQ0

Applicable MCU

H8S-family H8S/Tiny-series MCUs

Applicable MCU mode

Single-chip mode

Maximum ROM/RAM capacity

1. Internal flash ROM: 256 Kbytes
2. Internal RAM: 12 Kbytes

Maximum operating frequency

Power supply voltage: 2.7 to 5.5V, 20 MHz

Software break

4096 points

Hardware break

16 points (Execution address, bus detection, interrupt, external trigger signal)

Combination, pass count

- Cumulative AND/OR/simultaneous AND/subroutine/ sequential/state transition
- 255 pass counts

Detection of exceptional events

Violation of access protection/task stack access violation/OS dispatch/reading
from a non-initialized area

Real-time tracing

192 bits x 4 M cycles
(Address, data, status, CPU status, bus status, target status, task 1D, timestamp, 32
external trigger inputs)

Trace modes

Fill until stop/fill until full/fill around TP/repeat fill until stop/repeat fill until full

Extraction/deletion of trace data

- Extracting or deleting data by specifying events or extracting the instruction that
accesses the specified data
- Extracting data before and after trace points

Real-time RAM monitor

- 16,384 bytes (512 bytes x 32 blocks)
- Data/last access

Time measurement

- Execution time between program start and stop

- Maximum/minimum/average execution time and number of passes through eight
specified sections

- Clock used to count times: Equal to the MCU clock or 10 to 1.6 us

Coverage measurement

C0:2 MB (256 Kbytes x 8 blocks)

Connection to user system

80-pin 0.65 mm pitch LQFP ROE420000CFJ30
80-pin 0.5 mm pitch LQFP ROE420000CFK30
64-pin 0.8 mm pitch LQFP ROE420000CFG40
64-pin 0.5 mm pitch LQFP ROE420000CFK40

Emulator power supply

Supplied from an AC adapter (power supply voltage: 100 to 240 V, 50/60 Hz)
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1.4.2 Regulatory Compliance Notices

® European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European Union.)
CE Certifications:
e Electromagnetic Compatibility (EMC) Directive 2014/30/EU
EN 55032 Class A

WARNING: This is a Class A product. This equipment can cause radio frequency noise when used
in the residential area. In such cases, the ser/operator of the equipment may be
required to take appropriate countermeasures under his responsibility.

EN 55024

e Information for traceability
e Authorised representative

Name: Renesas Electronics Corporation

Address: Toyosu Foresia, 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
e Person responsible for placing on the market

Name: Renesas Electronics Europe GmbH

Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
e Trademark and Type name

Trademark: Renesas )

Product name: E100 Emulator MCU Unit

Type name: ROE420000MCUOQ0

Environmental Compliance and Certifications:
e Waste Electrical and Electronic Equipment (WEEE) Directive 2012/19/EU

e United States Regulatory notices

This product complies with the following EMC regulation. (This is only valid in the United States.)

FCC Certifications:

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(2) this device may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.
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1.4.3 Operating Environment

Make sure to use this emulator in the operating environments listed in Tables 1.6 to 1.8.

Table 1.6 Operating environmental conditions

Item

Description

Operating temperature

5 to 35°C (no condensation)

Storage temperature

-10 to 60°C (no condensation)

Table 1.7 Operating environment of the host machine (Windows® XP)

Item Description
Host machine IBM PC/AT compatible
0S Windows® XP 32-bit editions [*1] [*3]
CPU Pentium 4 running at 1.6 GHz or more recommended
Interface USB 2.0 [*2]
Memory 768 Mbytes or larger (more than 10 times the file size of the load module)

recommended

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be
connected to the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Table 1.8 Operating environment of the host machine (Windows Vista®)

Item Description
Host machine IBM PC/AT compatible
0S Windows Vista® 32-bit editions [*1] [*4]
CPU Pentium 4 running at 3GHz or
Core 2 Duo running at 1GHz or more recommended
Interface USB 2.0 [*2]
Memory 1.5 Gbytes or larger (more than 10 times the file size of the load module)

recommended

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be
connected to the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Notes:

*1: Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries. All other company or product names are the property of their respective owners.
*2: Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.
*3: The 64-bit editions of Windows® XP are not supported.
*4: The 64-bit editions of Windows Vista® are not supported.
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1.4.4 Specifications of the AC Adapter

The user must prepare an AC adapter and a power cable. Use an AC adapter which complies with the safety standards of the
country where it is to be used. Table 1.9 lists the recommended specifications of the AC adapter.

Table 1.9 Recommended Specifications of the AC Adapter

Item Description
AC input voltage range AC 100 to 240 V, 50/60Hz single phase
Output power 36 W
DC output voltage, current 120V,30A
DC output polarity EIAJ TYPE IV, inner-side positive/outer-side negative
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2. Setup

This chapter describes the preparation for using the MCU unit, the procedure for starting up the emulator and how to change
settings.

2.1 Flowchart of Starting Up the Emulator

The procedure for starting up the emulator is shown in Figures 2.1 and 2.2. For details, refer to each section hereafter. If the
emulator does not start up normally, refer to “6. Troubleshooting (Action in Case of an Error)” (page 208).

1|

Check the package components.

v

2 |

User registration

v

3 |

Install the included software, etc.

v

Connect the MCU unit to the E100 main
unit.

v

Connect the host machine.

v

Connect the emulator power supply.

v

Turn on the power supply.

v

Check the LEDs on the emulator.

v

Try to use the emulator debugger according
to the tutorial.

v

10

Create a project in the High-performance
Embedded Workshop.

v

11

Start up the emulator debugger from the
High-performance Embedded Workshop.

v

12

Make device- and system-related settings on
the emulator debugger.

v

13 |

Self-checking

Refer to “1.1 Package Components” (page 16).
Refer to “User Registration” (page 14).
Install them from the included CD-ROM.

Refer to “2.3 Connecting the MCU Unit to and Disconnecting it
from the E100 Emulator Main Unit” (page 27)

Connect the USB interface connector of the emulator and the USB
port of the host machine.

Connect an emulator power supply to the power connector.
Turn ON the power to the emulator.

Check that the system status LEDs are lighting. When the user
system is not connected, the POWER LED does not light up.

When using the emulator debugger for the first time, try to use the
emulator functions, referring to “3. Tutorial” (page 40).

If the emulator debugger does not start, follow steps 10 through 13
in this chart to perform self-checking.

Start up the High-performance Embedded Workshop and create a
project by following “4. Preparation for Debugging” (page 71).

Start up the High-performance Embedded Workshop to launch the
emulator debugger by following
“4. Preparation for Debugging” (page 71).

Make settings on the Device setting dialog box of the emulator
debugger and select the “Start booting up on successful completion
of self-checking” checkbox by following

“4. Preparation for Debugging” (page 71).

Figure 2.1 Flowchart for starting up the emulator (for the first time)
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14

16

17

18

19

20

Change the settings.

v

Connect the user system.

v

Turn on the power supply.

v

Check the LEDs on the emulator.

v

Start up the emulator debugger from the
High-performance Embedded Workshop.

v

Make device- and system-related settings on
the emulator debugger.

v

Debug a program with various functions of
the emulator debugger

Change the settings of the power supply and clock supply to the
MCU, according to the conditions of use.

Connect the user system as the occasion demands.

Turn ON the power to the emulator and the user system as close to
simultaneously as is possible.

Check that the system status LEDs, and the POWER and RESET
LEDs among the target status LEDs, are lit. When the user system is
not connected, the POWER LED does not light up.

Start up the High-performance Embedded Workshop to launch the
emulator debugger.

Check the contents set in step 12 in Figure 2.1. Do not select the
“Start booting up on successful completion of self-checking”
checkbox.

Refer to the High-performance Embedded Workshop and
“5. Debugging Functions” (page 81).

Figure 2.2 Flowchart for starting up the emulator (after self-checking)
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2.2 Installing the Included Software
If you have Windows Vista® or Windows® XP on the host machine, this installation must be executed by a user with
administrator rights. Note that users without administrator rights cannot complete the installation.

Place the CD-ROM in the CD-ROM drive and follow the instructions to install the software.
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2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit
Figure 2.3 shows the procedure for connecting the MCU Unit to the E100 Emulator Main Unit.

Connecting
MCU Unit
ROE420000MCU00

Insert the MCU unit Push the MCU unit down

following the inside to check it is attached properly.
rails of the main unit.

-

E100 emulator main unit

ROE001000EMUQ0
oL -

Disconnecting

Pull the MCU unit up.

IR

Figure 2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit

A CAUTION

Note on Connecting the MCU Unit to the E100 Emulator Main Unit:
Always shut OFF power when connecting the MCU unit to the E100 emulator main unit. Otherwise, internal
circuits may be damaged.
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2.4 Connecting the Host Machine
USB interface is used to connect the emulator to the host machine. The USB cable is connected to the USB cable connector of

the emulator and the USB port of the host machine.

Figure 2.4 Connecting the host machine
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2.5 Connecting the Emulator Power Supply
Power is supplied from an AC adapter to the emulator. The following shows how to connect the AC adapter.

(1) Turn OFF the power to the emulator.

(2) Connect the DC cable of the AC adapter to the emulator.
(3) Connect the AC power cable to the AC adapter.

(4) Connect the AC power cable to the outlet.

Figure 2.5 Connecting the emulator power supply

A CAUTION

Cautions for AC Power Cable:
é If the AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it forcibly.
Failure to comply may cause electric shock and/or fire.
Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.
Cautions for AC Adapter:

0 The DC plug of the AC adapter has the polarity shown below.

E5CES)

Use an AC adapter which complies with the safety standards of the country where it is to be used.
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2.6 Turning ON the Power

2.6.1 Checking the Connections of the Emulator System
Before turning the power ON, check the connection of the interface cable with the host machine, emulator, and user system.

2.6.2 Turning the Power ON and OFF

- Turn ON power to the emulator before attempting to start supplying power to the user system. Turn OFF power to the

emulator and user system as close to simultaneously as is possible.

- When the SAFE LED of the system LEDs is flashing, check that the USB cable is connected to the host machine. When each
of the target status LEDs is flashing, check that the MCU unit is connected.

- When turning ON the power again after shutting OFF the power, wait for about 10 seconds.

Notes on Power Supply:
The emulator pin Vcc is connected to the user system in order to monitor user system voltage. For this reason, the
emulator cannot supply power to the user system. Supply power to the user system separately.

The voltage of the user system should be as follows.
27V <Vcc<h5V

When you start the emulator without the user system, do not attach a converter board. When starting with a
converter board, the MCU will be in a reset status.

When you start the emulator without the user system, take care that metallic pieces are not touched to the
connector at the head of the flexible cable.

Do not leave either the emulator or user system powered on. The internal circuits may be damaged due to leakage
current.
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2.7 Self-checking

Self-checking is a test run by the emulator itself to check if its functions are operating correctly. To run the self-checking
function of the emulator, follow the procedure below. While self-checking is in progress, the states of the LEDs will change as

shown in Figure 2.6. In case of an ERROR, because the states of the target status LEDs will change according to the type of
error, check the system status LEDs.

(1) If the user system is connected, disconnect the converter board and the user system.
(2) Turn on the emulator.

(3) Launch the emulator debugger, and select the “Start booting up on successful completion of self-checking” checkbox in the
Device setting dialog box.

(4) When you click on OK, self-checking will start. If the normal result is displayed within about 70 seconds, self-checking
has ended.

NS
WER

SR
o

NV

%
B!

%
B
o

?

T
)

\\
A\
;

A
%
)
%

O
A
%
«

o

3\ 0
®\T
R

3
Z
©
.\
3
B
b
\
3
\é

A

°
N
)
0

2
\%
2
\%
2
\%

Emulator turned on Self-checking has started
or
Self-checking is in progress

@ on

QO :0oFF @]\-
3 :Flashing 5{‘
@ : ON or OFF eOWNE

: Undefined \@

)

B
o

2
\%

Self-check error

Note:
See the error message on the debugger

Figure 2.6 LEDs during self-checking
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2.8 Selecting the Glock Supply

2.8.1 Clock Source

You can choose the source of the clock signal for supply to the evaluation MCU on the System page in the Configuration
properties dialog box of the emulator debugger. Table 2.1 shows the clock sources and their default settings.

Table 2.1 Clock supply to the MCU

Clock selection in the

Clock Description Default setting
emulator debugger
Emulator Oscillator module mounted in 1IC11 Yes
Main (OSC1) User Oscillator circuit on the user §ystem -
Generate Internal generator circuit i
(1.0 to 20.0 MHz)
Emulator Internal oscillator circuit Yes
Sub (X1) (32.768 kHz)
User Oscillator circuit on the user system -

Note on Changing the Clock Supply:
The clock supply can be set by the Configuration properties dialog box when starting up the emulator debugger or
by an input of the emulator_clock command on the Command Line window.
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2.8.2 Using an Internal Oscillator Circuit Board

Kinds of Oscillator Circuit Boards

An oscillator module (20 MHz) is mounted in IC11 at shipment of the ROE420000MCUOQO. If you wish to change the
frequency, replace the oscillator module.

(1) Replacing the Oscillator Module
Remove the MCU unit from the E100 emulator main unit, and replace the oscillator module in IC11 (see Figure 2.7).

EPSON TOYOCOM
SG-8002DC/DB Series
(power voltage 2.7 to 3.6V: PC/SC)

sG-80020c (]
7 4 ' 1

Q000000
C
QOO0
8 11 14

-1 {1

SG-8002DB (]

1

(o]
100 51
1 CN5 50
© 1 50 o
{10 CN6 51 i}
la CN1 40a la CN2 40a 1a CN3 402 12 CN4 404
"t Mo Moo 1o 3
I i i P i
= i s B
iy AR || R 1"

Figure 2.7 Replacing the oscillator module

A CAUTION

Notes on Replacing the Oscillator Module and Oscillator Circuit Board:
Always shut OFF power when replacing the oscillator module. Otherwise, internal circuits may be damaged.

When replacing the oscillator module, remove it with a tool such as an IC extractor so as not to damage the board.
If the board is damaged, the pattern on the board may be cut and the emulator may not be able to operate.
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2.8.3 Using the Oscillator Circuit on the User System

To operate the MCU unit with an external clock source, connect an oscillator circuit to pin OSC1 of the user system as shown
in Figure 2.8. The oscillator must have an output within the operating range of the evaluation MCU and a duty cycle of 50%.
Pin OSC2, on the other hand, should be open-circuit. Choose "User" in the emulator debugger to use this clock source.

MCU
PJ 0/0SCL PJ_1/0SC2/CLKOUT
L Oscillator Open

circuit

Figure 2.8 External oscillator circuit

Note that in the oscillator circuit of Figure 2.9, which is configured by connecting an oscillator between pins OSC1 and OSC2,
oscillation is not possible because of the pitch-converter board between the evaluation MCU and the user system. It is the same
for sub-clock oscillator circuits (X1 and X2).

MCU

PJ_0/0SC1 PJ_1/0SC2/CLKOUT

A
—

] J

Figure 2.9 Oscillator circuit that is not usable with the emulator

2.8.4 Using the Internal Generator Circuit

The dedicated circuit in the E100 can generate a clock signal at any frequency specified in the emulator debugger, and this
signal can be supplied as the main clock signal. This does not depend on the oscillator circuit board of the MCU unit or the
oscillator circuit on the user system. If you want to debug programs without the user system or change the frequency
temporarily, you can use the internal clock to check operation before purchasing an oscillator. If you want to use the internal
generator circuit in the E100 to generate the main clock signal, choose "Generate” in the emulator debugger and specify the
frequency you want.

Select frequencies between 1.0 and 99.9 MHz in 0.1-MHz steps on the E100, do not specify a value that exceeds the 20-MHz
maximum input frequency for OSC1 of the MCU.

Notes on Using the Internal Generator Circuit:
The internal generator circuit is envisaged as a provisional measure for debugging purposes. Its temperature
characteristics with frequency and so on are not guaranteed.

In final evaluation, mount an oscillator with the same frequency as that of the oscillator module or oscillator
circuit (internal clock).
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2.9 Connecting the User System
Figure 2.10 shows how to connect the MCU unit to your system.

Flexible cable

80 pins 64 pins

.

0.65-mm pitch 0.5-mm pitch 0.8-mm pitch 0.5-mm pitch

ROE420000CFJ30 ROE420000CFK30 ROE420000CFG40 ROE420000CFK40
80-pin LQFP 80-pin LQFP 64-pin LQFP 64-pin LQFP

Figure 2.10 Connecting the MCU unit to the user system

A CAUTION

Note on Connecting the User System:
Take care not to attach the converter board in the wrong orientation. Attachment in the wrong orientation may
cause fatal damage to the emulator and user system.
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2.9.1 Connection to an 80-pin 0.65-mm Pitch Pad Pattern
The following is the procedure for connection to an 80-pin 0.65-mm pitch pad pattern on the user system by using the
ROE420000CFJ30 (not included). For details on the ROE420000CFJ30, refer to its user’s manual.

(1) Install the NQPACKO080SB, which comes with the ROE420000CFJ30, on the user system.

(2) Connect the YQPACKO080SB, which also comes with the ROE420000CFJ30, to the NQPACKO080SB and secure it with the
YQ-GUIDEs.

(3) Connect the ROE420000CFJ30 to the YQPACKO080SB.

(4) Connect CN2 of the ROE420000CFJ30 to CN2 of the flexible cable.

(5) Connect CN1 of the ROE420000CFJ30 to CN1 of the flexible cable.

4 Evaluation with
@ ﬂ ﬂ (5) the actual MCU

ROE420000CFJ30

HQPACKO080SB160
ﬁ (3) (not included)
|

>

Flash MCU
These corners
are not round. \
- (1) . .
80-pin 0.65-mm pitch pad pattern
P
o

Pin 1
User system

*: These four products are available in one package.

Figure 2.11 Connection to an 80-pin 0.65-mm pitch pad pattern

A CAUTION

Notes on Connecting the User System:
Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.

The connectors of the ROE420000CFJ30 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACK080SB160, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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2.9.2 Connection to an 80-pin 0.5-mm Pitch Pad Pattern
The following is the procedure for connection to an 80-pin 0.5-mm pitch pad pattern on the user system by using the
ROE420000CFK30 (not included). For details on the ROE420000CFK30, refer to its user’s manual.

(1) Install the NQPACKO080SD-ND, which comes with the ROE420000CFK30, on the user system.

(2) Connect the YQPACKO080SD, which also comes with the ROE420000CFK30, to the NQPACKO080SD-ND and secure it
with the YQ-GUIDEs.

(3) Connect the ROE420000CFK30 to the YQPACKO080SD.

(4) Connect CN2 of the ROE420000CFK30 to CN2 of the flexible cable.

(5) Connect CN1 of the ROE420000CFK30 to CN1 of the flexible cable.

S

4) ﬂ H 5) Evaluation with

the actual MCU

ROE420000CFK30

3 HQPACKO080SD
( ) (not included)

- |

‘ﬂ’ YQPACKO080SD

| <>

/ ﬂ ) Flash MCU
T~
- (1)

ﬂ YQ-GUIDE (x 4)
0

NQPACKO080SD-ND

ﬂ 80-pin 0.5-mm pitch pad pattern

~
~

These corners

are not round. \

v
~
Pin 1

User system

*: These four products are available in one package.

Figure 2.12 Connection to an 80-pin 0.5-mm pitch pad pattern

A CAUTION

Notes on Connecting the User System:
Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.

The connectors of the ROE420000CFK30 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACKO080SD, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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2.9.3 Connection to a 64-pin 0.8-mm Pitch Pad Pattern
The following is the procedure for connection to a 64-pin 0.8-mm pitch pad pattern on the user system by using the
ROE420000CFG40 (not included). For details on the ROE420000CFG40, refer to its user’s manual.

(1) Install the NQPACKO064SA160, which comes with the ROE420000CFG40, on the user system.

(2) Connect the YQPACKO064SA, which also comes with the ROE420000CFG40, to the NQPACKO064SA160 and secure it
with the YQ-GUIDEs.

(3) Connect the ROE420000CFG40 to the YQPACKO064SA.

(4) Connect CN2 of the ROE420000CFG40 to CN2 of the flexible cable.

(5) Connect CN1 of the ROE420000CFG40 to CN1 of the flexible cable.

S

4) ﬂ ﬂ ) Evaluation with

the actual MCU

L

ROE420000CFG40

3) HQPACKO064SA160
ﬂ YQ-GUIDE (x 4) (not included)
. % ‘ﬂ’ YQPACKO064SA ﬂ

<

/ (2) Flash MCU
NQPACKO064SA160
These corners
are not round. \ <
\_
(1) . .
64-pin 0.8-mm pitch pad pattern

N
~

Pin 1
User system

*: These four products are available in one package.

Figure 2.13 Connection to a 64-pin 0.8-mm pitch pad pattern

A CAUTION

Notes on Connecting the User System:
0 Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.

The connectors of the ROE420000CFG40 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACK064SA160, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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2.9.4 Connection to a 64-pin 0.5-mm Pitch Pad Pattern
The following is the procedure for connection to a 64-pin 0.5-mm pitch pad pattern on the user system by using the
ROE420000CFK40 (not included). For details on the ROE420000CFKA40, refer to its user’s manual.

(1) Install the NQPACKO064SD-ND, which comes with the ROE420000CFK40, on the user system.

(2) Connect the YQPACKO064SD, which also comes with the ROE420000CFK40, to the NQPACKO064SD-ND and secure it
with the YQ-GUIDEs.

(3) Connect the ROE420000CFK40 to the YQPACKO064SD.

(4) Connect CN2 of the ROE420000CFK40 to CN2 of the flexible cable.

(5) Connect CN1 of the ROE420000CFK40 to CN1 of the flexible cable.

S

(4) ﬂ ﬂ 5) Evaluation with

the actual MCU

ROE420000CFK40

HQPACKO064SD
(not included)

<>

/ \ \ Flash MCU
T~

F

_ 1
ﬂ ( ) 64-pin 0.5-mm pitch pad pattern

These corners

are not round. ~

Pin 1
User system

*: These four products are available in one package.

Figure 2.14 Connection to a 64-pin 0.5-mm pitch pad pattern

A CAUTION

Notes on Connecting the User System:
0 Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.

The connectors of the ROE420000CFKA40 are guaranteed for only 50 insertion/removal iterations.

For purchasing the HQPACKO064SD, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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3. Tutorial

3.1 Introduction

A tutorial program for the E100 emulator is provided as a means of presenting the emulator’s main features to you. The tutorial
is described in this section.

The tutorial program was written in the C and C++ languages, and sorts random data (10 items) into ascending and descending
order.
Processing by the tutorial program is as follows.

The main function repeatedly calls the tutorial function in order to repeatedly execute the process of sorting.

The tutorial function generates the random data to be sorted and calls the sort and change functions, in that order.

The sort function accepts input of an array that contains the random data generated by the tutorial function and sorts this data
into ascending order.

The change function accepts input of the array that was sorted into ascending order by the sort function and sorts the data into
descending order.

The tutorial program is designed to help users to understand how to use the functions of the emulator and emulator debugger.
When developing a user system or user program, refer to the user’s manual for the target MCU.

CAUTION
If the tutorial program is recompiled, the addresses in the recompiled program may not be the same as those described in this
chapter.
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3.2 Starting the High-performance Embedded Workshop

Open a workspace by following the procedure described in “4.4 Opening an Existing Workspace” (page 77).

Specify the directory given below.

(Drive where the OS is installed)\Workspace\Tutoria\E100\H8STiny\Tutorial

Specify the file shown below.

Cpen Workspace

Look jn: I 5 Tutarial

~| & & B

2=

l Tukorial

File nanne: IT utorial bz

Select I

Files of type: | HEW warkspaces [* hus)

j Cancel |

A

Figure 3.1 Open Workspace dialog box

3.3 Connecting the Emulator

When the debugger is connected to the emulator, a dialog box for setting up the debugger is displayed. . Make initial settings

of the debugger in this dialog box.

When you have finished setting up the debugger, you are ready to start debugging.
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3.4 Downloading the Tutorial Program

3.4.1 Downloading the Tutorial Program

Download the object program you want to debug. Note, however, that the name of a program to be downloaded and the
address where the program will be downloaded depend on the MCU in use. Accordingly, strings shown in the screen shots

should be altered to those for the MCU in use.
Choose Download for Tutorial.abs under Download modules.

-1

El@ Tutanal

= IE Tutonial

=k a [ zource file
dbzct.c
shik.c

rezetprg. cpp
=| sort.cpp
Tutarial.cpp
B a Dl:lwnll:uad modules

= a Dependencies
...... . 0207k

..... shrk.h

...... IR Tuitorial sbs LO0OONANDS

Ciovenload
Download (Debug Data Cnl
Unlaad

Dovenload & MNew Module, .
Rernove

Debug Settings. ..

Configure Yiew. .,

IT Alloww Docking

Hide

Properties. ..

Figure 3.2 Downloading the tutorial program
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3.4.2 Displaying the Source Program

In the High-performance Embedded Workshop you can debug programs at the source level.
Double-click on the C++ source file Tutorial.cpp.

B

o

=3 Tutorial
= ﬁg Tutonal
-4 C source file
@ dhzctc
-] shik.c
1423 C++ source file
. |£| resetprg. cpp
[Z] socop
E]TMmhhmp
-4 Download modules
[£] Tuterialabs - 00000000
Fl-‘3 Dependencies
--[E] 20203k
[E] sbrkh
% gort b

2] stackscth

HE,'FL..]T... [dn.. | [ Test |

Line

Source, ..

| 5.. Source

21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
ig
39
40
41
42
43
44
45
46
1]

001044

001044
001054

001060

001062

O0106E
001076
OO107E
oo1086
oolo84s

nol1oac

0010AG
OO10AE

woid main(void)
{
while (1)1
tucorial [);
}
H

woid tutorial (void)
{
long a[10] :
long j:
int i;

class Sample *p_sam:

P_Sam= Sample:

for( i=0; 1i<10; i++ )4

3 = rand():
ifiy < 0){
= -1
}
afi] = 3:
}
P_Sam->3ort(a);
p_sam->change (&) ;

<l Tutorial epa I

Figure 3.3 Editor window (displaying the source program)

If necessary, you can change the font and size to make the text more easily readable. For details, refer to the High-performance

Embedded Workshop User’s Manual.

The Editor window initially shows the beginning of the program. Use the scroll bar to view other parts of the program.
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3.5 Setting Software Breakpoints

Setting of software breakpoints is one simple debugging facility.
Software breakpoints are easy to set in the Editor window. For example, you can set a software breakpoint at the line where the
sort function is called.

Double-click in the row of the S/W Breakpoints column which corresponds to the source line containing the call of the sort
function.

=
Elll=
Line Source... | E.| C.| 5. Source |
35 ZI
36 |0010G6E p_Sam= Sample;
37 001076 for( i=0; i<10; i++ )4
38 |00107E J = randi)
39 001086 if(y < 014
40 (001084 1= -a:
41 B
4z |00108cC ali] = 3:
43 B
44 |0010LE L ] p_Sam—>50rt(a)
45 |00O10AE b_sam-rchange (a) ;
45
47 |0010E6 b_sam—x=s0=a[0] ;
45 |0O010EBE b _sam-=sl=a[1l]:
49 |0010Chk b _sam-=si=alZ];
S50 |0010Da b _sam-=s3=al[3];
51 |0O010EZ b _sam-=s4=a[4] ;
52 |0O010EE b_sam-=s5=a[3] ;
53 |0010F & b _sam-=s6=al[6] ;
54 (001106 b _sam—=sV=al[7]
55 |00111Z2 b_sam-»s8=a[8] ;
56 |0O0111E b _sam—-=s3=a[2] ;
57 |0011z 4 P_Sam;
53 001130 B
59 (I
60 |00113E wold abort (wvoid)
Gl { =
1] | v

Figure 3.4 Editor window (setting a software breakpoint)

The source line that includes the sort function will be marked with a red circle, indicating that a software breakpoint has been
set there.
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3.6 Executing the Program
The following describes how to run the program.

3.6.1 Resetting the CPU

To reset the CPU, choose Reset CPU from the Debug menu or click on the Reset CPU toolbar button ].

3.6.2 Executing the Program

To execute the program, choose Go from the Debug menu or click on the Go toolbar button ].

The program will be executed continuously until a breakpoint is reached. An arrow will be displayed in the S/W Breakpoints
column to indicate the position where the program stopped.

o x|
= &l
Line Source... | 5. Source |
35 ZI
36 |0010G6E p_Sam= Sample;
37 001076 for( i=0; i<10; i++ )4
38 |00107E J = randi):
39 001086 if(y < 014
40 (001084 1= -a:
41 B
4z |00108cC ali]l] = 3:
43 ¥
44 (001046 =43 p_Sam-rsortia) :
45 |00O10AE b_sam->change (a) ;
45
47 |0010E6 b_sam-x>s0=a[0] ;
45 |0O010EBE b _sam-x>sl=al[l]:;
49 |0010ChA b _sam-x»sZ=alZ]:
S50 |0010Da b _sam-=s3=al[3];
51 |0O010EZ b _sam-=s4=a[4] ;
52 |0O010EE b_sam-=s5=a[3] ;
53 |0010F & b _sam-=s6=al[6] ;
54 (001106 b _sam—=sV=al[7]
55 |00111Z2 b_sam-»s8=a[8] ;
56 |0O0111E b _sam—-=s3=a[2] ;
57 |0011z 4 P_Sam;
53 001130 B
59 (I
60 |00113E wold abort (wvoid)
Gl { -
1] | v

Figure 3.5 Editor window break)
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The Status window permits you to check the cause of the last break to have occurred.
Choose CPU —> Status from the View menu or click on the View Status toolbar button [ ]. When the Status window is
displayed, open the Target sheet and check the cause of the break.

Status £l
Item | Itatus
M status Ready
PC:0010AE
TazskID:-

Wiolation of access protection -

Fead from uninitialized memory -

Stack access wiolation -

Performance owverflow -

Fealtime profile owverflow -

Trace mwewmory overflow -

Taszk stack access wiolation -

05 dispatch -

Fun time count Q0:00:00.082.913.120
Cauze of last kbresk Software break

I i

1 Pr\. Mernary }1. Platfarm }1. Events hTarget f

Figure 3.6 Status window

CAUTION
The contents displayed in this window differ with the product. For details of the contents displayed for particular products,
refer to Chapter 5. Debugging Functions,” (page 81) or the online help.

3.7 Checking Breakpoints

Use the Breakpoints dialog box to check all software breakpoints that have been set.

3.7.1 Checking Breakpoints
Press the keys Ctrl + B on the keyboard of your PC. The Breakpoints dialog box shown below will be displayed.

Breakpoints 2 x|

OF.

X

Cance

Edit Code

Bemove

LOREL

Remove All

Figure 3.7 Breakpoints dialog box

Use this dialog box to remove a breakpoint or enable or disable a breakpoint.
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3.8 Altering Register Contents

Choose CPU -> Registers from the View menu or click on the Registers toolbar button ]. The Register window shown
below will be displayed.

|
Name |¥alue | Radix|
ERO QOFFEFSA Hex
ERl Qooooono Hex
ERZ QOFFEODS Hex
ER3 QO0DOFFE Hex
ER4 QOFFEFSA Hex
ERS EESFO00A Hex
ERA 4ETAFIFTY Hex
ER7 QOFFEFYE Hex
P 0o010a6 Hex
CCR Qoooo100 -0-—-z-- Ein
EXR o1111111 ————- 111 EBin

Figure 3.8 Register window

The contents of any register can be altered.
Double-click on the line for the register you want to alter. The dialog box shown below is displayed, allowing you to enter the
new value for the register.

I
SetAs: IWhnIe Regizter j

] I Cancel |

Figure 3.9 Set value dialog box (PC)
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3.9 Referring to Symbols

The Labels window permits you to view the symbolic information in a module.

Choose Symbols —> Labels from the View menu or click on the Labels toolbar button [ ].The Labels window shown below

will be displayed. Use this window to look at the symbolic information a module includes.

label 7
S =m A R E
EP | Address | Name :I
0azooo Sample: :Samwple()
0azoso Sample: :sort(long *)
002124 __ T1000000%73
00z1e4 Sample: :change (long *)
FFEOOQO _heap area
FFE400 __rnext
FFE404 _needed_destruction head
FFE408 _brk
FFE40OC dtors donefd
FFE40E _use patch info
FFE410 __new handler
FFE414 _ _head
FFE4183 _ freeptr
FFE41cC __dtors
FFEFCO _g IntBuf
FFEFCZ _ g CharBuf -
KN —
Figure 3.10 Label window
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3.10 Checking Memory Contents

After you have specified a label name, you can use the Memory window to check the contents of memory where that label is
registered. For example, you can check the contents of memory corresponding to _main in byte units, as shown below.

Choose CPU —> Memory from the View menu or click on the Memory toolbar button [|ml|] to open the Display Address
dialog box.

Enter “_main” in the edit box of the Display Address dialog box.

Display Address i |

Digplay Address: I 'I
Serall Start Address: IDUUUDU |
Scroll End Address: IFFFFFF j

ok I Cancel |

Figure 3.11 Display Address dialog box

Click on the OK button. The Memory window will be displayed, showing a specified memory area.

Memory[main] L]
(o ooz (6 040 8 2 |labe il dp i s i | £ @ a6 2 [

Address | +0 +1 42 43 +4 +5 +5 +7 48 +30 +x +B += 4D +E +F | AScIIT -
ooio4s | Fa 00 0O 00 00 O1 OF &0 47 O¢ 55 Oc A 00 00 00 z....... G0,z

ooig5se |00 01 oOF @80 46 F4 54 7O 01 10 D FZ 01 10 6D FP4 ....F.Tp..m...Mm.
O0i0ER 79037 00 32 1a 80 5E OO0 20 OO0 Op 82 19 55 79 I5 ¢T.Z..%. ... .Uv%
0o0107a oo oA 4C 28 5E OO0 11 AE 17 FO OF 83 OF 80 4C 02 ..L(%......... L.
ooigss 1Y B3 OF F4 Op 30 17 FO 10 770 0Oa 84 OF <O OF B1 ..... ey

O0igsa SE OO0 12 78 0O 535 79 Z5 00 0a 4p p8 OF Fl1 OF A0 “..x.Uy%..M.....
O010AR SE OO 20 50 OF FlL OF AD S5E OO 21 e4 O1 0O &9 70 4. P....*. !d..ip
0010BA |01 00 &9 a0 01 00 eF 70 00 04 01 OO0 eF A0 00 04 ..i...0pcesa00as

O0igca 01 O0O sF 70 OO 08 01 OO0 G6F AOD OO0 08 01 OO0 GF 70 ..0p....0..... ap
0010DA 00 Oc 01 00 6F A0 OO Oc 01 00 6F 70 00O 10 01 00 ... 0ceses@Peces
O010Ea | 6F AO 0O 10 01 00 &F 70 OO 14 01 00O 6EF A0 00 14 a..... OpPe.ealon.
onioFe 01 OO0 &F 70 00 18 01 OO0 &F A0 OO0 18 0O1 OO0 &F 70 ..op....0..... ap
001102 oo 1c 01 OO0 &F A0 OO0 1c 01 00 &F 70 00 20 01 00 ....0c0.ass OP. =
oo111s EF A0 OO 20 01 OO eF 70 OO 24 01 OO eF ADO OO 24 o.. ..op.%..0..%

ooilga | OF a0 3E OO 11 a4 79 17 00 32 01 10 eb 795 01 10 ..“...y..E..mu.;j:J
4 2

Figure 3.12 Memory window
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3.11 Referring to Variables

When single-stepping through a program, you can see how the values of the variables used in the program change as you step
through source lines or instructions. For example, by following the procedure described below, you can look at the long-type
array ‘a’ that is declared at the beginning of the program.

Click on the left-hand side of the line containing the array ‘a’ in the Editor window to place the cursor there. Right-click and
select Instant Watch. The dialog box shown below will be displayed.

Instant Watch 2|

[H-a {FFEF7E }lang[10])

Add

Figure 3.13 Instant Watch dialog box

Click on the Add button to add the variable to the Watch window.

E
RE [N/ X || @

{long[10]] [Auto]

[Ty weatens fwatehz Jy wiateha f, wiatcha [
Figure 3.14 Watch window (array display)

Alternatively, you can specify a variable name to be added to the Watch window. Click the right mouse button in the Watch
window and choose Add Watch from the popup menu. The dialog box shown below will be displayed.

fdd Watch 21x]

Yariable or expreszsion; aEk.

i Cancel

Figure 3.15 Add Watch dialog box
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Enter variable ‘i’ in the Variable or expression edit box and click on the OK button.
The int-type variable ‘i” will be displayed in the Watch window.

5
RE | o/ X ||

{ long[10] } [Auto]
i H'OODa { RS } [int} [Autao]

Imwachi [ Wiatchz J, watchd b Watchd

Figure 3.16 Watch window (showing a variable)

Click on the “+” mark shown to the left of the array ‘a’ in the Watch window. You can now look at the individual elements of

the array ‘a.’

£
RE o7 % |8 |

a {long[10]]
B [o] H'ODDD41=6 | FFEFTE | [ loneg)

B 11] H'ODOD167e | FFEFTA | [ Llong)

B [z H'ODODZT31 { FFEFTE | [ long)

R [3] H'ODDD44Eb | FFEFEZ ) [ long)

- 143 H'ODOD794b | FFEFEE [ Llong)

~B [5] H'ODOD15fb | FFEFERA | [ Llong)

~B e8] H'ODOD59e2 | FFEFEE | [ long)

~B 171 H'ODOD1cfb { FFEF9Z } [ long)

[ 18] H'ODOD2£54 | FPFEF9E |} [ Llong)

~B [9] H'ODODO££E | FREFOA |} [ Long)

i H'OOOs { RS } [int} [Auto]

[Ty weatens {watehz J wiateha J, wiatcha [

Figure 3.17 Watch window (showing array elements)
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3.12 Showing Local Variables

By using the Local window, you can view the local variables included in a function. As an example, let’s check the local
variables of the tutorial function. Four local variables are declared in this function: ‘a,” ¢j,” ‘i’ and ‘p_sam.’

Choose Symbols — Local from the View menu or click on the Locals toolbar button o display the Locals window.

The Locals window shows the values of local variables in the function indicated by the current value of the program counter
(PC).

If no variables exist in the function, no information is displayed in the Locals window.

locals A
‘ g6 108 2

Neaaue | Value | Type

----- a { FFEF7E } [long[10])

........ 4 H'OOOOODf£E { ER3 1} [ Lo

H'OOOa { RS 1}

----- p_sam Ox00ffe0ds { ERZ jzlass Sample*)

Al | ]

Figure 3.18 Locals window

Click on the “+” mark shown to the left of array a in the Locals window to display the elements comprising array a.
Confirm that the random data are being sorted into ascending order by inspecting the elements of array a before and after
execution of the sort function.

3.13 Single-Stepping through a Program

The High-performance Embedded Workshop provides various step commands that will prove useful in debugging programs.

Table 3.1 Step Options

Command Description
Step In Executes a program one statement at a time (including statements within functions).
Step Over Executes a program one statement at a time by ‘stepping over’ function calls, if there are any.
Step Out After exiting a function, stops at the next statement of a program that called the function.
Step... Single-step a program a specified number of times at a specified speed.
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3.13.1 Executing Step In Command

The Step In command ‘steps in’ to a called function and stops at the first statement of the function.
To enter the sort function, choose Step In from the Debug menu or click on the Step In toolbar button.

!

Figure 3.19 Step In button
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al=0;
az=0;
s3=0;
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a5=0;
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39=0;

int g_IntBuf:
cher g CharBuf:

{
long &:
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gap = 5;

fare |

1
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i

DOZ 1498

g ChacBuf =

wolic Sample::sort (long *m)

ap;

wvhile( gap > 0O 1{
for [ k=0; k<gap: k++){

i=k+gap: i<10; i=i+gap ) {
tor (J=i-gap; J1>=k; J=]-wap){
g_IncBuf = 3;
iffafjl>ali+gap] ]|
L = afil:
&li] = alj+gapl:
a[j+gap] = €:

gap = gap/2:

[char)g IntBuf & OxOODFF:

< Tutonalepp 0= zoitcpp I

Figure 3.20 Editor window (Step In)

The highlight in the Editor window moves to the first statement of the sort function.
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3.13.2 Executing the Step Out Command
The Step Out command takes execution out of a called function by completing its execution at once and only stopping at the
next statement of the program from which the function was called.
To exit from the sort function, choose Step Out from the Debug menu or click on the Step Out toolbar button.

i+

Figure 3.21 Step Out button
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40 001084 3= -3
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44 ODA0RE & p_sam->=ore [a)

45 |OD10EE e p_sam—rchange (a] : R IZ B/ X | @ |
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47 001086 B_same>a0=a0] : Ll Talus [ zype | scope |
48 O010BE p_sem-rsl=all] BB { EFEETE } (long[107) [Aste]

49 001004 p_sam-rsieall] B (0] H'OOO00€£E { FPEETE ! [ Longh
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56 |O0111E P_sam->39=al9] ; B .
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58 ODii%0 " B (7] H'0000446k { PPEPSZ | [ Long}

L B [a] H'00005G=2 { FPEFSE ! [ Longh

60 |00113E vold akort (void) B 9] H'0000794k | PPEFSA | [ Longh

g; t i H'000a { RS } [int) [Auta]

E: EOLEE ¢ L[] ek waich | Walshs | Washa [ :

al ' I o

Figure 3.22 Editor window (Step Out)
The data of the variable ‘a’ displayed in the Watch window will have been sorted into ascending order.
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3.13.3 Executing the Step Over Command

The Step Over command executes the whole of a function call as one step and then stops at the next statement of the main

program.

To execute all statements in the change function at once, choose Step Over from the Debug menu or click on the Step Over

toolbar button.

[T

Figure 3.23 Step Over button
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1| | L B
Figure 3.24 Editor window (Step Over)
The data of the variable ‘a’ displayed in the Watch window will have been sorted into descending order.
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3.14 Forcibly Breaking Program Execution

The High-performance Embedded Workshop permits you to forcibly break program execution.
Clear all breakpoints.
To execute the rest of the tutorial function, choose Go from the Debug menu or click on the Go toolbar button.

2l

Figure 3.25 Go button

Since the program execution is now in an endless loop, choose Stop Program from the Debug menu or click on the Halt toolbar
button.

Figure 3.26 Halt button

R20UT0967EJ0402 Rev.4.02

Page 56 of 230
Sep.01.21 ENESAS



ROE420000MCUO00 User’s Manual 3. Tutorial

3.15 Hardware Break Facility

A hardware break causes the program to stop when it executes the instruction at a specified address (instruction fetch) or reads
from or writes to a specified memory location (data access).

3.15.1 Stopping a Program when It Executes the Instruction at a Specified Address

It’s easy to set an instruction fetch event in the Editor window. For example, you can set an instruction fetch event where the
sort function is called.

Double-click in the row of the Event column which corresponds to the source line containing the call of the sort function.

_iolx
= &l
Line Source.. | E.| C.| 5. Source |
36 |00106E p_sam= Sample; EI
37 001076 for( i=0; i<10; i++ )¢
38 |00107E J = randi():
39 001086 if(y < 034
40 (001054 1= -a:
41 ¥
47 |00103cC ali] = 3:
473 ¥
44 (001046 |HY p_Sam-rsortia) ;
45 |0O10AE b_samw->change (a) ;
46
47 |0010E6 b_sam-x>s0=a[0] ;
45 |0OD010EBE b _sam->s1=a[1]:
49 |0010ChA p_sam-»si=alZ]:
5O |0010Dg& p_Sam-»23=al[3]:
51 |0O010EZ p_sam->s4=al4d]:
52 |0OD010EE p_sam-»=5=al[5]: -
4| | AW

Figure 3.27 Editor window (setting a hardware breakpoint)

The source line that includes the sort function will be marked with 7, indicating that a hardware breakpoint has been set
there. This will cause the program to stop when it fetches the corresponding instruction.
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3.16 Stopping a Program when It Accesses Memory

To make a program stop when it reads or writes the value of a global variable, follow the procedure below.

Choose Event -> Hardware Break from the View menu to open the Hardware Break dialog box.

Open the OR page of the Hardware Break dialog box. Select a global variable in the Editor window, and drag-and-drop the
selected variable into the OR page so that the program will stop when it reads or writes the value of that variable.

Then click on the Apply button.

The program will stop running when it reads or writes the value of the global variable you have set.

-loix

Hardware Break OR I

—Event:
Evert | T.] Descriptions | co... | Ta... | comment |
Em O [Address] _o_IntBuf... - -

add... I [relape | Enable | Disakle I

Evert used 1 Free 15 Dekai.-.l Reg'rstaradavmts...l
save... | Losd... | Hele | apply [ close |

g

Figure 3.28 Hardware Break dialog box

Notes: (1) To be selectable, a global variable must be represented by 1, 2, or 4 bytes in memory.
(2) Local variables outside scope cannot be registered. Moreover, when the local variable is set, the break not
intended outside scope might be generated.
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3.17 Tracing Facility

The tracing facility of the E100 emulator includes a special memory unit known as “trace memory” that can hold a record of
the execution of up to 4-M bus cycles. This memory is constantly updated during program execution. The contents of trace
memory are displayed in the Trace window.

Choose Code —> Trace from the View menu or click on the Trace toolbar button ].

The Trace window shown below will be displayed.

Tace e
m¥E o2 W@ (540 (R aca

Pange:, [Fla: [Cwch: Modrei: [Tee: |

_Cyole | Label | Address | pata | BUT | Size |_®éu | BuT | Stetws | Iee0 | IMp? | Dusacc | DEDDS | BV | meg | Tim=gtemp (himis,ms.us,oed

Figure 3.29 Trace window

The following section gives an outline of the tracing facility and how to set up the facility.
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3.17.1 Showing the Information Acquired in “Fill Until Stop” Tracing

In “fill until stop” tracing, trace information is successively acquired from the start of user program execution until a break is
encountered.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu. The Trace conditions dialog box shown below will be displayed. Check that the selected
trace mode is Fill until stop. Click on the Close button.

M Trace conditions -l0ix

Trace ] Option |

i
Trace Mode: I i Fill unkil stop :l
condition and combination setting
—# OF condition:
Eventinuse: 0 Cokall I

I~ other condtions:

I;-.r-:l::.’ﬂ-:unu'atmw} ;J

Everginuse: 0 et |

A Excepbion; ——————— Tokal : 0 Ewent

Dy evele) ——

Exeepkional . |
events ekl oM -

—Record condtion:
@ all ¢ Capture  Donot capbure [ Step execution is recorded

Ewent imuse ;0

Evert used 0 Freels Detai,.. | Registered events... |

Save... Load... I Help | Apaly I Close

|

Figure 3.30 Trace conditions dialog box (fill until stop)
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(2) Set a software break on the following line of the tutorial function: “p_sam ->s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to

the break will be displayed in the Trace window.
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Figure 3.31 Trace window (fill-until-stop tracing)

(4) A mixed display of bus information and disassembly listing

is possible. Choose Display Mode —> DIS from the popup
menu to view trace information in mixed bus and disassembly mode.
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Figure 3.32 Trace window (mixed bus and disassembly mode)
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(5) Choosing Display Mode —> SRC from the popup menu, on the other hand, shows a mixture of bus information,
disassembly listing, and source code as the trace information.
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Figure 3.33 Trace window (mixed bus, disassembly, and source mode)
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3.17.2 Showing the Information Acquired in “Fill around TP” Tracing

In “fill around TP” tracing, the acquisition of trace information is stopped a specified number of cycles after a trace point is
encountered. This facility allows you to use trace information to keep track of program flow without having to break the user
program.

(1) If any break conditions are set, clear all of them.

(2) Choose “Fill around TP” as the trace mode in the Trace conditions dialog box. In the Delay (cycle) section, specify 4M.
(Up to 4-M cycles of trace information from where a trace point is encountered will be acquired.)

M Trace conditions * ) _;lﬂlﬁl

Trace |oR | option |

1
Trace Made: | - am h?nli waine - Fill around TP :l
condition and combination setking
" R condition:

Eventinuse: 0 Detail I

[~ other candtions:

I-'-.r-:D'a'a.:tJnu ation ) j i

Evertinuse: 0  [ebail |

" Total : 0 Ewent
—;En:fptlnln . Delay(cvele:
ceptions P | ST
events ﬁ_rlll 4M -
—Record condtion:
@ all  Capture  Donot capbure " Stepexecifionis recorded

Ewvenkinuse : D

Event used 0 Free 16 Detal..-l Registﬂredavenbi...l
SEVE, ., | Load. .. ] Help | Apply I Close I
g
Figure 3.34 Trace conditions dialog box (Fill around TP)
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(3) Next, set the trace point, i.e. the point where the debugger will start acquiring trace information. Open the OR page of the
Trace conditions dialog box. Select the main function in the Editor window and drag-and-drop it onto the OR page. Click
on the Apply button and then the Close button.

Thus, the debugger will start acquiring trace information when the main function is executed.

I Trace conditions * ..-J.U.Iﬁl

Trace OR | Option |

—Ewvent:
Evert | T.] Descriptions | co... | Ta... | Comment |

m F [Address] _main - 5

add... | [elete | Erakle I Disable I

Event used 1 Free1S Detal.. Reuisbaredwmts...l
Save.. | Losd.. | wep | ety [ close |
E

Figure 3.35 Trace conditions dialog box (OR page)

(4) Choose Reset Go from the Debug menu. As soon as the trace point is reached, trace information as shown below will start
to be displayed in the Trace window.
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Figure 3.36 Trace window (Fill around TP)
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3.17.3 Showing a History of Function Execution

A function execution history can be displayed from the acquired trace information.

You can extract the history of executed functions from the acquired trace information.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu. The Trace conditions dialog box will open. Switch to fill-until-stop tracing and click on
the Apply button and then the Close button.

(2) Set a software break on the following line of the tutorial function: “p_sam—>s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to
the break will be displayed in the Trace window.

(4) Click the right mouse button with the cursor anywhere in the Trace window and choose Function Execution History ->
Function Execution History from the popup menu.
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Figure 3.37 Trace window (function execution history—before analysis)
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(5) Click the right mouse button with the cursor anywhere in the upper pane of the Trace window and choose Analyze
Execution History from the popup menu. The history of function execution will be displayed in the upper pane.
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Figure 3.38 Trace window (function execution history—after analysis)

(6) Double-click on a function in the upper pane to view the trace information corresponding to that function in the lower pane.
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Figure 3.39 Trace window (function execution history)
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3.17.4 Filter Facility

Use the filtering facility to extract specific cycles from the acquired trace information.

This is achieved by software filtering of the trace information that was acquired by hardware.

Unlike the “Capture/Do not Capture conditions” where you set conditions for acquisition before getting the trace information,
this facility allows you to change filter settings for the acquired trace information any number of times without having to
reexecute the program. This makes it easy to extract the information you need.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu that is displayed. The Trace conditions dialog box will be displayed. Check that the
selected trace mode is Fill until stop. Click the Close button.

(2) Set a software break on the following line of the tutorial function: “p_sam—>s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to
the break will be displayed in the Trace window.

(4) Choose Auto Filter from the popup menu of the Trace window. The columns for which filtering can be applied will be
marked by a [EI] button.
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Figure 3.40 Trace window (Auto Filter)
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(5) Click on the [El]button in the R/W column and choose R.
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Figure 3.41 Trace window (Auto Filter)

(6) The Trace window now only shows trace information for cycles that have R in the R/W column.
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Figure 3.42 Trace window (Auto Filter)

Notes:

(1) Filtering does not affect the trace memory, so that its contents remain intact.
(2) Filtering is available for trace information regardless of whether the setting is fill until stop, fill until full or fill around TP.
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3.18 Stack Trace Facility

Stack information can be used to find out which function called the function corresponding to the current PC value.
Set a software breakpoint in any line of the tutorial function by double-clicking on the corresponding row in the S/W
Breakpoints column.

Line Source... | E.| C.| 5. Source
29 001062 wold tutorial (woid)
30 {
31 lang af[10] »
3z long 3:
33 int ir
g class Sawple *p_=em:
35
36 |0010G6E p_sSam= Sample:
37 (001076 for( i=0; i<10; i4++ )4
35 [00107E J = randi():
39 (001086 & if(y < a4
40 (001084 1= -a:
41 B
4z (00108C ali]l] = 3:
43 B
44 |0010Lke p_Sam—>30rti(a):
45 |00O10AE p_Sam->change (&) ;
45
47 |0010E& P Sam-x==0=a[0] :
48 |0O010EE P Sam->=1=a[1]:
49 |0010ChA b Sam-xsZ=al[Z]:
5O |0010D& P _Sam-x>23=al3]:
51 |0O010EZ P Sam-xsd4=a[4]:
52 |0O010EE P Sam-x>25=a[5] :
53 |0010F A b Sam-x>s6=a[&] :
54 001106 b Sam-x=37=al7]:
55 001112 P Sam-x>35=a[8] :
Ee |O0111E P Sam-x>39=a[2] :
E7 (00112h p_Sam;
EE (DO1130 B
1=
60 |O0113E wold abort (woid)
61 i
62
63 |00113E B
< |

% Tutoralcpp |20+ sortepp I

Figure 3.43 Editor window (setting a software breakpoint)

Choose Reset Go from the Debug menu.
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After the break, choose Code —> Stack Trace from the View menu to open the Stack Trace window.

]
Kindl Name | Talues |

F tutoriall) { 001086 1}

F mwaini) { 001056 }

F Power 0N Reset () { o044z 1

Figure 3.44 Stack Trace window

You will see that the current PC value is within the tutorial() function, and that the tutorial() function was called from the
main() function.

Clear the software breakpoint that you set on a line of the tutorial function by again double-clicking on the corresponding row
in the S/W Breakpoints column.

3.19 What Next?

In this tutorial, we have introduced to you several features of the E100 emulator and usage of the High-performance Embedded
Workshop.

The emulation facilities of the E100 emulator provide for advanced debugging. You can apply them to precisely distinguish
the causes of problems in hardware and software and, once these have been identified, to effectively examine the problems.
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4. Preparation for Debugging

4.1 Starting the High-performance Embedded Workshop

Follow the procedure below to start the High-performance Embedded Workshop.

(1) Connect the host machine, E100 emulator, and user system. Then turn on power to the E100 emulator and user system.

(2) From Programs on the Start menu, choose Renesas -> High-performance Embedded Workshop -> High-performance
Embedded Workshop.
The Welcome! dialog box shown below will appear.

Welcome! 1' EI

| {+ ‘Create a new project workspace ok
Cancel

" Open arecent project workspace:
I j Adrminiztration. .

cJ

—' " Browse to another project workspace

i

Figure 4.1 Welcome! dialog box

Select the startup method from among the following.

- Create a new project workspace

- Open a recently used project workspace
Select this option when you use an existing workspace.
The names of recently opened workspaces will be displayed.

- Browse for another project workspace
Select this option when you intend to use an existing workspace.
This option is available when there is no record of a recently opened workspace.
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4.2 Creating a New Workspace (Toolchain Unused)

The procedure for creating a new project workspace differs according to whether you are using a toolchain or not.
Toolchains are not included with the E100 emulator. Toolchains can be used in environment in which the C/C++ compiler

package is installed.
Follow the procedure below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button with the caption “Create a new project workspace” and click on the OK

button.

| % Create a new project workspace i

Cancel

" Open a recent project workspacs:
I j Adminiztration...

J

j " Browse to another project workspace

N x

Figure 4.2 Welcome! dialog box

(2) The Project Generator will start.

' 21|
Projects |
| {
Proiect Tues ‘Wotkspace Mame

E Drabumgar only £ 1 I
Progect M arre:
Directon:
I Browee..
LCPU family:
J 0 [-]
Tool chat;
{hone =l

KN E— i3

Proparties.

| 0k, | Cancel

Figure 4.3 New Project Workspace dialog box

Workspace Name: Enter a workspace name here.

Project Name: Enter a project name here. You do not need to enter any name if you wish this to be the

same as the workspace name.

Directory: Enter the directory in which you want the workspace to be created. Alternatively, click on

the Browse button and select a workspace directory from the dialog box.

CPU family: Select the CPU family of the MCU you are using.
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The other list boxes are used for setting up a toolchain. If no toolchains are installed, fixed information is displayed here. Click
on the OK button.

(3) Select the target for debugging.
Setting the Target System for Debugging ﬂﬂ

— Targats :
2 00 E100 Erulaion

Taget type: |4l Targets =
Taigel CPU: [l CPUs =
< Back Meast » Fiish | Cancel |

Figure 4.4 Setting the Target System for Debugging dialog box

Select the target platform you wish to use by placing a check mark in its checkbox and click on the Next button.

(4) Set a configuration name. Configuration refers to a file in which information on the state of the High-performance
Embedded Workshop for use with target software rather than emulators is saved.
Setting the Debugger Oplions ﬂﬂ

TuE Fame ©

Coie
|<shgl¢ o j

Configuration name ;
IDuhug_bW{}{_E'lElElj rulatan

— Diatail options -
[hem | Walye

I Iritial session —Iﬁudﬁ

<Back | tedo | Firith | Caneal |

Figure 4.5 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click on the Next button and then set a configuration name for each of the
selected target platforms.
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When you have finished setting the configuration names, emulator-related settings are completed.

Click on the Finish button, and the Summary dialog box will be displayed. Clicking on the OK button in this dialog box starts
the High-performance Embedded Workshop.

(5) After starting the High-performance Embedded Workshop, connect the E100 emulator.

4.3 Creating a New Workspace (with a Toolchain in Use)
Follow the procedure below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click on the OK button.

Welcome!

| % iCieate a new project workspace

" Dpen a recent project workspace:

2%
oK

Cancel

-

j " Browse to another project workspace

j Adrministation. .

e

Figure 4.6 Welcome! dialog box

(2) The Project Generator will start.

flew Project Workspace
Projects |
Project Types

l"E’E source satup Spplhcation
175 Empty Application

5 Irpar Makefile

'E]_lbran,l
v Diebuger only - 3000 E100E
F+ Debugger only - 300 Simulat

wWnkspace Name:

Project Hame:

Directon:

2 family:

| roe
Toal cham:

IFIeﬂcsas M0 Standard

| 0K, | Cancel

Figure 4.7 New Project Workspace dialog box
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Workspace Name: Enter a workspace name here.

Project Name: Enter a project name here. You do not need to enter any name if you wish this to be the
same as the workspace name.

Directory: Enter a directory in which you want a workspace to be created. Alternatively, click on the
Browse button and select a workspace directory from the dialog box.

CPU family: Select the CPU family of the MCU you are using.

Toolchain; To use a toolchain, select the appropriate toolchain here. If you do not use any toolchain,
select None.

The other list boxes are used for setting up a toolchain. If no toolchains are installed, fixed information is displayed here. Click
on the OK button.

(3) Set the CPU and options for the toolchain and make other necessary settings.

(4) Select the target for debugging.

Setting the Target System for Debugging 20|

— Targats :

E100 E rmulztor

Taget type: |4l Targets =
Taigel CRU; |4l CPUs =

< Back Meast » Firish | Canecal |

Figure 4.8 Setting the Target System for Debugging dialog box

Select the target platform you wish to use by placing a check mark in its checkbox and click on the Next button.
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(5) Set a configuration name.
Setting the Debugger Dptions i

Ta% mame ©

Cove :
| csingle corex =]

Configuration name :
|Debun_x000_ET00_Emulstor

— Diatail options -
Item Walue

e adiy I

[~ Initial zezzion

Back | tewo | Fnsh | Cancal |

Figure 4.9 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click on the Next button and then set a configuration name for each of the
selected target platforms. When you have finished setting configuration names, emulator-related settings are completed. Click
on the Finish button, and the Summary dialog box will be displayed. Clicking on the OK button in this dialog box starts the

High-performance Embedded Workshop.

(6) After starting the High-performance Embedded Workshop, connect the E100 emulator.
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4.4 Opening an Existing Workspace
Follow the procedure below to open an existing workspace.

(1) In the Welcome! dialog box, select the radio button with the caption “Browse to another project workspace” and click on
the OK button.

Welcome! 2 x|

OF.

; | " Create a new project workspace

Cancel

" Open arecent project workspace;
I j A drinigtration...

o
s J

ie i_ﬂmwse to anather project work space

QLA

Figure 4.10 Welcome! dialog box

(2) The Open Workspace dialog box shown below will appear.

':'FIEEFI 'l,l'l,l'|:|r'l::5|:|.5||:|3 _?I EI
Look in: | =l E100 <] « & ok B

l E100

File name: IE'IEIEI_hws Select I
Files af type: IHEWWnrkspaces [* bz) j Cancel |

Figure 4.11 Open Workspace dialog box

v

Specify the directory in which the workspaces was created, select the workspace file (extension “.hws”), and click on the
Select button.

(3) The High-performance Embedded Workshop will start, and its state will be restored to the state at the time the selected
workspace was saved. If the emulator was connected at the time, the workspace is automatically connected to the emulator.
If the emulator was not connected but you want to connect it, refer to “4.5.1 Connecting the Emulator” (page 78).
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4.5 Connecting the Emulator

4.5.1 Connecting the Emulator
The following methods for connecting the emulator are available.

(1) Making the emulator settings in booting-up before connection

Choose Debug Settings from the Debug menu to open the Debug Settings dialog box. In this dialog box, you can register
download modules and the command chain to be automatically executed. When you are finished filling in the Debug Settings
dialog box, the emulator will be connected.

(2) Loading a session file

Switching to a session file in which settings for emulator usage have been made in advance simplifies the procedure of
connecting the emulator.

4.5.2 Reconnecting the Emulator
While the emulator is disconnected, you can reconnect it in one of the ways described below.

(1) Choose Connect from the Debug menu.

P
(2) Click on the Connect toolbar button [l=2_1].

(3) Enter the connect command in the Command Line window.

4.6 Disconnecting the Emulator

4.6.1 Disconnecting the Emulator
To disconnect the emulator while it is active, do so in one of the ways described below.

(1) Choose Disconnect from the Debug menu.

(2) Click on the Disconnect toolbar button [--F ].

(3) Enter the disconnect command in the Command Line window.

4.7 Quitting the High-performance Embedded Workshop

Choosing Exit from the File menu closes the High-performance Embedded Workshop.
Before it closes, a message box will be displayed asking you whether you want to save the session. To save the session, click
on the Yes button.
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4.8 Making Debugging-Related Settings

Register download modules, set up automatic execution of command line batch files, and set download options, etc.

4.8.1 Specifying a Module for Downloading

Choose Debug Settings from the Debug menu to open the Debug Settings dialog box.

Debug Settings _

[Session yo0x_E100_Emulator_oox ¥]  Target | Options |

[ E100

2ix|

I-Smg!e Caore Taget

[etbag fomat:

1

|EN/Dwiait2

Dieawnlosd modules:

Filenane | Offzet Address | Famat

HCONRIGDIRS(PRO.., 00000000 ElffDvvarf2

=l
| Add
i it
Fremoye
L
D
| *]

Figure 4.12 Debug Settings dialog box

In the Target drop-down list box, select the name of the product you want to connect.

In the Default debug format drop-down list box, select the format of the load module you want to download. Then register a

module in the selected format in the Download modules list box.

CAUTION
At this point in time, no programs have been downloaded yet.

For details on how to download a program, refer to “5.2.1 Downloading a Program” (page 91).
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4.8.2 Setting Up Automatic Execution of Command Line Batch Files
Click on the Options tab of the dialog box.

2
[S ession oex_E100_Emulstor_eox  ¥]  Target Opbons |
Iz} |E100
Command line batch processing:
Add..
fil eifs,.
Hemove

[v Dizable batch file execution when downloading debua infoemation
¥ Download modules aftsr build
v Femove breakponts on download

I~ Disshle memaony sccess untl altes target connection command file execution
[ Limit dizazsembly memony access

™ Da nat perfam automatic target connection
[v Feset CPU after download maoduls
™ Digable memony sccess by GUI when target is executing

OE. I Cancel

Figure 4.13 Debug Settings dialog box

Here, register a command chain to be automatically executed with the specified timing.
Select your desired timing from among the following four choices:

- When the emulator is connected
- Immediately before downloading
- Immediately after downloading

- Immediately after a reset

In the Command batch file load timing drop-down list box, select the timing with which you want a command chain to be
executed.
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5. Debugging Functions

The E100 emulator supports the functions listed in the table below.

Table 5.1 List of Debugging Functions

Item

No. Item

Specification

1 Software break

4,096 points

Number of event points

Maximum number of effective points: 16

Content of event
2 Event

Executed address detection

Data access detection

Interrupt generation or exit detection

External trigger detection

Task ID Can be set separately for each event
Condition for number of times an event has
occurred Up to 255 times

3 Exception detection

Violation of access protection

Reading from non-initialized memory areas

Stack access violation

Performance-measurement overflow

Realtime profile overflow

Trace memory overflow

Task stack access violation

OS dispatch

Hardware Event combination OR, AND (cumulativ_e_), AND (simultaneous), subroutine,
4 Hardware breakpoints . _ sequ_entlal and state transition
break Exception detection See item No. 3
Delay Up to 65,535 bus cycles
Trace size Up to 4-M cycles
Fill until stop Trace acquisition continues until the program stops running.
Fill until full Trace acquisition stops when trace memory becomes full.
Fill around TP Trace acquisition proceeds for a delay in cycles after the trace point
Trace mode has been reached.
Information for a total of 512 cycles before and after each trace
Repeat fill until stop | point are acquired, and this continues until the program stops.
Information for a total of 512 cycles before and after each trace
Repeat fill until full point are acquired, and this continues until trace memory is full.
5 Trace E A OR, AND (cumulative), AND (simultaneous), subroutine,
. vent combination . .
Trace point sequential and state transition
Exception detection See item No. 3
Delay Up to 4-M bus cycles

Extraction/deletion of trace data

Extracting or deleting data by specifying events
- Between two events
- Duration of an event
- Duration of an event occurring in a subroutine

Instruction accessing specific data

Content of measurement

Measures maximum, minimum and average execution time in up to
8 sections and pass counts

Timeout detection

6 Performance

Resolution 10nsto 1.6 us

Measurement —— Between two events, Period of an event and Interrupt-disabled
Event combination

mode range between two events

7 RAM monitor

512 hytes x 32 blocks
- Shows last read/write accesses performed
- Comes with initialization-omitted detect function

8 Realtime Profile

128 Khbytes x 8 blocks (1-Mbyte space)

Cumulative time and number of passes overflow detection
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CO level code coverage
256 Kbytes x 8 blocks (2-Mbyte space)
Address range and source file

9 Coverage
Data coverage
64 Kbytes x 8 blocks (512-Khbyte space)
Address range, section, and task stack
Trigger output p!gger p!ns gé to gﬁll éspecifie_d pattern is ouLput.k .
10 | (only when an external trigger cable* is connected) rigger pins 23 to 21: Output is in response to breakpoints being

Note: The external trigger cable is optional.

encountered.
Trigger pins 20 to 16: Output is in response to a specified event.
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5.1 Setting Up the Emulation Environment

When the emulator is connected, the Device setting and the Configuration properties dialog boxes are displayed. Here, select
the general options associated with the emulator. Note that the target MCU to be debugged, etc. can only be set once each time
the emulator is booted-up.

5.1.1 Emulator Settings During Booting up
While the emulator is booting up, the following three dialog boxes are opened in sequence.

(1) Device setting dialog box

Use this dialog box to select the target MCU and establish communication.

This dialog box can be re-opened by selecting Emulator -> Device setting from the Setup menu after the emulator has been
booted up. In this case, however, be aware that changes of setting made after boot-up will not be reflected immediately but will
be set as initial values when the emulator is reconnected.

(2) Configuration properties dialog box

This dialog box is opened after the Device setting dialog box. Use this dialog box to make settings related to the emulator and
debugger functions.

This dialog box can be re-opened by selecting Emulator -> System from the Setup menu after the emulator has been booted up.
Settings for certain options in this dialog box can be changed after boot-up. Those that can be changed are active while those
that cannot are inactive (grayed out), but with their settings displayed.

(3) Connecting dialog box

This dialog box shows the progress of boot-up processing.
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5.1.2 Setting Up the Target MCU
(1) Selecting the target MCU

On the Device page of the Device setting dialog box, specify the target MCU to be emulated. For details, refer to the hardware
manual supplied with each product.

|

Dresvice |

Bioup [ - |
Device [RaF20203 =]
Mode |7 (Single-chip mode) =l

Communicalion Setting

usB EA00; 000X - en

Setial Mo, =] Hefres |

[ Start booting up on successhul completion of sef-checking.

0K | Cacdl | Hep

™ Do ot shows i dialog bos again,

Figure 5.1 Device setting dialog box (Device page)

The target MCU you have set here cannot be changed after the emulator is connected. To change the target MCU, you need to
disconnect and then reconnect the emulator.

(2) Selecting an operation mode

For details, refer to the hardware manual for the MCU in use.

(3) Setting up communications

You can select another target emulator for connection via USB.
The ‘USB Serial No.” list box shows unique identifying information on the emulator connected via USB. Clicking on the
Refresh button updates the information.

(4) Performing self-checking

If you click on the OK button with the ‘Start booting up on successful completion of self-checking.” checkbox selected,
hardware self-checking proceeds after connection to the emulator according to the communications condition you have set.
The results are shown on completion of self-checking. If the results are normal, boot-up processing continues. If an error is
found, boot-up processing stops.
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5.1.3 Setting Up the System

On the System page of the Configuration Properties dialog box, specify the configuration of the emulator system as a whole.
During the boot-up process, this dialog box appears after the Device setting dialog box.

Although it is possible to open this dialog box even after the emulator has been booted up, some items will be grayed-out since
they cannot be changed.

Configuration properties [ |

Syshem | Irtemal Hagh ramony oveswrie | E xcephion Waming[

Clack. -
Man ¥ ‘ELrnu'Iaba; ™ Uzes " Germrate

--------- I 10 MHz

Sub % Emufater O Uger
Triggst
~ EXT 015 INFUT

External tngger cable @ EXT 0.31 [MPUT ExT1631 OUTRUT

. - EXT 0:15 TTL
Input bigger lerval  EXT 031 CMOS EXTi6-31 CHOS

— Sl hirg funetion
(¥ Code coverape  © Data coverape " Bealime profile

— Diebusg function
[~ Emable ntenupts during step execution

[ Debug the program using the CPU Reprogramming Mode
[ bask the Reminal M),

[ Mask the teimmnal RESET.

| ok | cancel |  Hen |

[~ Dt show this dialog box again

Figure 5.2 Configuration properties dialog box (System page)

(1) Selecting the operating clock

In the Clock section on the System page, select the sources of the clock signals supplied for the main clock and subclock.

The main clock can be selected from among three choices: Emulator, User and Generate (by default, Emulator is selected).
Select Emulator when the main clock is supplied from an internal source and User when the main clock is supplied from an
external source. To use a user-defined clock, select Generate and enter the clock frequency in the text box.

The clock frequency can be set in the range from 1.0 to 99.9 MHz in 0.1-MHz units. The clock frequency for Generate can be
set only once each time the emulator is booted-up.

Subclock options are only selectable for MCUs that support a subclock function. ‘Emulator’ or ‘User’ can be selected (by
default, Emulator is selected).

CAUTION
The frequency accuracy for Generate is +5%. Please make sure that final evaluation is performed with a resonator or oscillator
module mounted to generate the actual frequency for use on the target board.
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(2) Selecting the direction of the external trigger cable

For the external trigger cable, select the direction of EXT pins 16-31 as input or output. EXT pins 0-15 are fixed as inputs.
Select either of the following options:

- EXT 0-31 INPUT (default)
- EXT 0-15 INPUT, EXT 16-31 OUTPUT

(3) Selecting a trigger input level

Select CMOS level or TTL level as the trigger input level. Select either of the following options:

- EXT 0-31 CMOS (default)
- EXT 0-15 TTL, EXT 16-31 CMOS

(4) Selecting an exclusive function

The code coverage, data coverage and realtime profile functions cannot be used at the same time. Select one from among these
functions.

Code coverage is selected by default.

The setting of this option can be changed even after the emulator has been booted up.

(5) Enabling interrupts during stepped execution

Select whether interrupts should be enabled or disabled from the start of stepping until an instruction is executed. Interrupts are
always accepted while a subroutine is being invoked by step-over or step-out execution.

(6) Debugging the program using the CPU Reprogramming mode

Select whether or not to debug programs in the CPU Reprogramming mode.

(7) Masking the NMI pin

Select whether you want masking of input signals to the NMI pin of the target system.

(8) Masking the RESET pin

Select whether you want masking of input signals to the RESET pin of the target system.
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5.1.4  Setting for Overwriting Blocks of the Flash ROM

The Internal flash memory overwrite page of the Configuration properties dialog box allows you to specify whether or not
individual blocks of flash ROM should be overwritten.

Configuration properties . |

System  Iniemnal flash memery overite | Exception Wiaming |

Mo | Addiess

1) 000000 - NOFFF
B 0z 004000 - DOBFFF
[ 02 00CO0D- 013FFF
Bl 04 014000- DEFFF
B 05 01Co00- DIFFFF
06 FOO000 - FODEFF
[ 07 Fo000- FOIFFF

Clear al

Selected blocks will be covenuntten rather than deleted when the wsar
prograr i downloaded
LUnzelected blocks will be cvenanitien after deleted.

ok | cancel | Hep |

[~ Dot show thiz dialog box a0ain

Figure 5.3 Configuration properties dialog box (Internal flash memory overwrite page)

Settings for all blocks are automatically shown in the list according to the information on the target MCU. When a checkbox is
selected, the block will be overwritten rather than deleted when the user program is downloaded.
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5.1.5 Settings to Request Notification of Exceptional Events
The Exception Warning page of the Configuration properties dialog box allows you to select whether or not to display
warnings in the Status window and as a balloon on the status bar when exceptional events occur.

Configuration properkies . |

System | Intemal flash memory ovenwrke Exception Waming ]

[+ Wiclation of agcass protection
[ Riead fom uninitisized memon

I+ Stack access viclalion

™ Pedomance overflow
I”| Bedlime profile coverfiow

[ Trace memany el

]: l"': k sleck eooess wislalioe
[T o5 dispatch

Checked tems wil dizplay warrmg in a dialog baloon

[~ Dot show thiz dialog box again

Figure 5.4 Configuration properties dialog box (Exception Warning page)

The ‘Violation of access protection’, ‘Read from uninitialized memory’ and ‘Stack access violation” checkboxes are initially
selected.

When a load module that includes an OS has been downloaded, the ‘Task stack access violation’ checkbox is also initially
selected.

Other items are non-selected by default.

If you deselect a checkbox, the corresponding item will appear as ‘-’ in the Status window.
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5.1.6 Viewing the Progress of Boot-Up Processing

You can check the progress of boot-up processing in the Connecting dialog box.

This dialog box appears when boot-up processing is started and remains open until it is completed.

As long as display of the Device setting and the Configuration properties dialog boxes continues, you cannot manipulate this
dialog box.

Conmnecking.. ||
Trace Block Ver.  =AEVE a| Stalus
Eﬁﬂ%ﬂiﬁ ‘f&é’fc USERSYSTEM  DISCONNECT
EV Detact By =FAEVE [Dizconnect: CHHO, CHH1]
e e e Tpaies0 | POWERSOURCE DISCONNECT

EW Datect Rew. =HREV.A (05 )
|Estemal Trigger Cable Infio.
Cable Connact Stabuz = NOT COMMEC] TEST ;

Power On Test, RESET# High
12 Buz Access Check = 0K _
Man CPU-SSRAM Check = 0E Ml High

Mon CRU-LSE Check = 0K
H-TAG chain inbalzation
Selting of MCU supph edack

MairClock Emudator

SubClock Emulatar
Selbtng of mbcermaban o irdividual MCL.
Sattrg of debugging oplicn
Selting of MCU signal lalch Bmmng infaimation
Setbrg of ragiter data only for bool.
Selting of monkor CPU space data, ~ Clock
Setbng of target MCU space data,
S atting of debugging infomation. CPU Clack 1E0MHz
Seliing of emiulates genesalion clock heguen__| " 20.0 MMz
Irdsalzation of nternal seting of emulaion. - Main Clock{D3L1)

i | [ | SCckiXl] 220 kHz

| —
Iniliafization of intemal selling of emulator.

¥ Clos= the dizlog bos when e connection iz completed.

Cancel I

Figure 5.5 Connecting dialog box

(1) Description of progress

The progress history box on the left-hand side of the dialog box shows the history of progress.
The information shown here is saved in a bug report. To check the contents of the bug report, select Technical Support ->
Create Bug Report from the Help menu.

(2) Display of pin states

The pin states are updated when you close the Configuration properties dialog box.
A warning will be shown in the progress history box if the pin states do not match the settings made in the Device setting
dialog box.

(3) Display of states of clock signals

This information will be updated on completion of processing for the clock settings.
Only information on the clock signals that are actually operating is shown here.
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(4) State of progress as progress bars

The upper progress bar shows the state of progress through the overall process of booting up.
The lower progress bar shows the state of progress through the current part of the process of booting up.
The name of the current part of the overall process is shown under the progress bar.

(5) Canceling the connection

Click on the Cancel button to cancel the process of booting up.
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5.2 Downloading a Program

5.2.1 Downloading a Program

Download the load module to be debugged.

To download a program, choose Download from the Debug menu and select a desired load module or right-click on a load
module under Download modules of the Workspace window and then choose Download from the popup menu.

CAUTION
Before a program can be downloaded, you must have it registered as a load module in the High-performance Embedded
Workshop. For details on how to register load modules, refer to “4.8 Making Debugging-Related Settings” (page 79).

5.2.2  Viewing the Source Code
Select either of the following ways to view the source code.

- Double-click on the name of the source file in the Workspace window.
- Right-click on the name of the source file and choose Open from the popup menu.

[#Tutorisle =lol x|
Efll=
Lire | Seur.. | E.] C.] 5.] Source I

21 void tutorial (void) Zl

22 |FE224 {

23 long a[10] 2

=4 long 3:

25 ine 1;

25 struct S=ample far *p_sam_:

27

28 |FE2z27 p_sam= malloc(sizect (struct Sample]]

Z9 |FEZ3E » init (p_sam) :

3o

31 (FE247 (=3 for| i=0; i<10:; i++ ){

32 |FE252 4 = randi):

33 |FEZ25E|HY i£(3 <« O0){

34 |FEZ63 3= -3

35 H

36 |FEZ6C|7 [ a[i] = j:

3% H

38 |FE23:2 sart(a) ;! bt
| | H

Figure 5.6 Editor window

The columns listed below are to the left of the Source column.
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This column shows the line numbers of lines in the source file.

(2) Source Address column

When a program is downloaded, this column shows the addresses that correspond to the lines of the current source file. This
function is convenient for determining values for the PC and where to set breakpoints.

(3) Event column

This column shows the following:

Table 5.2 Icons in the Event column

H! | Hardware breakpoint is set

+& | Trace point (fetch condition) is set

A hardware breakpoint can be set by double-clicking in the Event column.

A trace point is only displayed when a fetch condition has been set.

[*] after the title on the title bar of the Hardware break, Trace conditions and Performance Analysis Conditions dialog boxes
shows that a setting is being edited. You cannot change the settings from the Event column of the Editor window while editing
is in progress.

(4) Code Coverage column

This column graphically shows the CO code coverage information.

(5) S/W Breakpoints column

This column shows the following:

Table 5.3 Icons in the S/W Breakpoints column

= | Bookmark
@ | Software break

= | PC position
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5.2.3  Turning columns in all source files off
(1) From the Editor window

1. Right-click in the Editor window and choose Define Column Format from the popup menu.

2. The Global Editor Column States dialog box will be displayed.

Global Editor Column States 7] x|

Code Coverage -
[w|CodeCoverage - A5 :
Dizazzembly Address Cancel |
Event
Label
Line

Obj code

[w] S Ereakpn?nts =
A | 3

Figure 5.7 Global Editor Column States dialog box

3. Deselect the checkboxes of columns you want to turn off. Click the OK button, and the new settings you have made will
take effect.

5.2.4  Turning columns off for one source file
(1) From the Editor window

1. Right-click in the Editor window and choose Columns from the popup menu.
2. A cascaded menu will be displayed. A check mark is to the left of the names of currently enabled columns.
Columns v Code Coverage

v CodeCoverage - A5MM

v Disassembly Address

Turn Header OnjOFF

Inistant: Watch v Event
v Label
LETa M | R
il
seb e Here P L";E 4
v Obj code
Display PC !
IT S/ Breakpoints
Yiew Disassembly « S Breakpoints - ASM
- v Source Address
Properties. ..

i

Figure 5.8 Popup menu window

3. Clicking on a column name toggles the setting between enabling and disabling of the column.
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5.2.5 Viewing Assembly Language Code

While a source file is open, click the right mouse button in the Editor window and choose View Disassembly from the popup
menu. The Disassembly window will be displayed.

The first address shown in the Disassembly window corresponds to the cursor position in the Editor window.

You can also use the View Disassembly button in the Editor window to view code produced by disassembly.

If there is no source file, you can still view the disassembly by one of the following methods.

— Click on the Disassembly toolbar button [l ].

— Choose Disassembly from the View menu.
— Use the “Ctrl + D” shortcut keys.

In this case, the Disassembly window opens with a listing from the position currently indicated by the PC.

The emulator also supports a mixed mode as an optional way to show all source lines from the address where disassembly
started. To view disassembly code in mixed mode, click the View mixed mode button.
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Figure 5.9 Disassembly window
The columns listed below are to the left of the Disassembly column.
(1) Event column
This column shows the following:
Table 5.4 Icons in the Event column
HY Hardware breakpoint
=& | Trace point (fetch condition)
A hardware breakpoint can be set by double-clicking in the Event column.
A trace point is only displayed when a fetch condition has been set.
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(2) Code Coverage - ASM column

This column graphically shows the CO code coverage information.

(3) S/W Breakpoints - ASM column

This column shows the following:
Table 5.5 Icons in the S/W Breakpoints — ASM column

@ Software break
o PC position

(4) Disassembly Address column

This column shows the address of the machine code corresponding to the disassembly. Double-clicking in this column brings
up the Set Address dialog box. Enter the address where you want the display of disassembly code to start in this dialog box.

(5) Obj code column

This column shows the object code.

(6) Label

This column shows labels. This column is not usable if no module has been downloaded.

5.2.6 Correcting Assembly Language Code
Double-click on the instruction you want to correct in the Disassembly window or choose Edit from the popup menu. The
Assembler dialog box will open. Use this dialog box to correct the assembly-language code.

Assembler ilil
Addrezs Code _I:IK
00412 Fasv

. Cancel |
Mnemonic:
MOY.E  #H'37 RO

Figure 5.10 Assembler dialog box

The dialog box shows the address, instruction code and mnemonic of the selected instruction.

Enter a new instruction (or edit the old instruction) in the Mnemonic edit box. When you have finished, hit the Enter key. The
value in memory is overwritten by the new instruction code, and the pointer is moved to the next instruction.

Click on the OK button to overwrite the current value in memory with the new instruction code and close the dialog box.

CAUTION

The assembly-language code shown in the Disassembly window and the Assembler dialog box is based on the data currently in
memory. When you modify data in memory, the new assembly-language code is shown in the Disassembly window and the
Assembler dialog box. However, the source file being displayed in the Editor window remains unchanged, even if it includes
assembly-language code.
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5.3 Viewing Memory Data in Real Time

5.3.1 Viewing Memory Data in Real Time

Use the RAM Monitor window to monitor data in memory while the user program is running.

The RAM monitoring function permits recording and inspection of the data in an area of memory for which monitoring has
been assigned and the states of access in real time without obstructing execution of the user program.

The RAM Monitor window shows the access states (read, written, non-initialized or not inspected) in different colors.

(1) Allocating an area for RAM monitoring

A 16-Kbyte RAM monitoring area is provided.

This RAM monitoring area can be allocated to a desired contiguous address range or up to 32 blocks of 512 bytes.

By default, a maximum of 16 Kbytes of space from the first address of the internal RAM is allocated as the RAM monitoring
area.

(2) Monitor display

Access states are indicated by different background colors according to the access attribute as listed below (the background
colors are customizable).

The access attributes “read” and “written” indicate the last access to each memory location.

To view detected errors, choose Error Detection Display from the popup menu. In this case, the information on reading and
writing is not displayed.

Table 5.6 Access attribute and background color

Access attribute Background color

Read Green
Written Red
Error Non-initialized memory (the location has Yellow
detected been read but nothing has been written to it

yet)

Non-inspected memory (a value has been Sky blue

written to the location but it has not been

read)
No access White

CAUTION

The contents of the RAM Monitor window are acquired from bus access. Therefore, changes made to memory by access that
was not through the user program (e.g. writing to memory directly from external 1/0) are not reflected in the RAM Monitor
window.
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(3) Detecting reading from non-initialized areas

If a memory location is read but nothing has been written to that location, the emulator detects “a non-initialized area” and
indicates the error.

To view errors of this type, choose Error Detection Display from the popup menu.

Non-initialized memory locations are shown against a yellow background.

Errors of this type can be detected as exceptional events and used as conditions of hardware breakpoints and trace points (also
refer to “5.14 Detecting Exceptional Events” (page 183)).

(4) Detecting non-inspected areas

If a memory location has been initialized but has not been read, the emulator detects this as “a non-inspected area” and
indicates the error.

To view errors of this type, choose Error Detection Display from the popup menu.

Non-inspected memory locations are shown against a sky blue background.

5.3.2 Setting the Update Interval for RAM Monitoring
Choose Update Interval Setting from the popup menu of the RAM Monitor window. The Update Interval Setting dialog box
shown below will appear.

Ipdate Inkerval Setking ed |

Interval (10 - 10000mzec : 10ms unit):

100 msec

ak. I Canzel

Figure 5.11 Update Interval Setting dialog box

A separate Update Interval can be specified per RAM Monitor window.
The initial value is 100 ms.

5.3.3 Clearing RAM Monitoring Access History
Choose Access Data Clear from the popup menu of the RAM Monitor window. The history of all access to the RAM
monitoring area will be cleared.

CAUTION
If clearing proceeds while the user program is being executed, the realtime characteristic of execution may be lost because
clearing produces a memory dump.

5.3.4 Clearing RAM Monitoring Error Detection Data
Choose Error Detection Data Clear from the popup menu of the RAM Monitor window. All information on the detected errors
in the RAM monitor area will be cleared.

R20UT0967EJ0402 Rev.4.02

Page 97 of 230
Sep.01.21 ENESAS



ROE420000MCUO00 User’s Manual

5. Debugging Functions

5.4 Viewing the Current Status

5.4.1 Viewing the Emulator Status

To find out the current status of the emulator, open the Status window.

To open the Status window, choose CPU -> Status from the View menu, or click on the View Status toolbar button |l o ].

The information shown in this window is not updated while the program is running.

Status =
Item |Status |
[MCT status Ready
PC:FOOOO
TaskID: -

Wiolation of access protection
Fead from uninitialized memory
Stack access wviolation
FPerformance owverflow

Fealtime profile owerflow
Trace mwemory overflow

Tazk stack access wiolation

03 dispatch

Run time count Qo:00:00.000.000, 000
Cause of last break -
L I FI'-. ety }1. Platfarm }1. Events hTarget {r
Figure 5.12 Status window
The Status window has the following four sheets.
Table 5.7 Sheets of the status window
Sheet Description
Memory Shows information on memory resources.
Platform Shows information on the emulator and debugging.
Events Shows information on events.
Target Shows information on the target MCU.
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5.4.2 Viewing the Emulator Status in the Status Bar
The status of the emulator can be displayed in the status bar.
Right clicking on the status bar brings up a list of the available items. Check the items you want to view in the status bar.

bugger

T De
+ Application

v BC

[ v TaskiD

[ v BreakCondition
v ExecutionTime

: ¥ Exception B
Hormal |- |Saftware break TIO0, 001 306,220 |4

Figure 5.13 Status bar

Table 5.8 Items regarding emulator status shown in the status bar
Item Description
PC PC value

During execution: PC value
During a break: Normal

Task ID Task ID, task entry label

BreakCondition Source of a break in the user program
ExecutionTime Result of time measurement

Exception Whether or not an exceptional event has occurred

(1) When more than one break source is present
When you click on the status bar indicating the source of a break (“Some factors exist” when there is more than one), a
balloon appears.
Read the contents of the balloon to check the source of the break.

v %]
Break cause

- Saltweare break
- Hardware break, (OR] Ev=1

Formal F [5ame Factors exist 44 Chck here 00:00:00,001,3%6,200 |4

Figure 5.14 Checking the source of a break

(2) When an exceptional event has occurred

When an exceptional event has occurred, a warning is displayed in a status bar balloon.
However, exceptional events of types that are not selected on the Exception Warning page of the Configuration properties
dialog box are not shown.

A ]

Waming: Excephion event detection

- Access protechion

Addesx0071C AttibutewRITE]

- Trace memony overflow
i

- b

Figure 5.15 Example of warning display when exceptional events have occurred
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5.5 Periodically Reading Out and Showing the Emulator Status

5.5.1 Periodically Reading Out and Showing the Emulator Information

To find out about changes in emulator information whether the user program is running or idle, use the Extended Monitor
window.

The extended monitor function only monitors the signals output from the user system or MCU, so it does not affect execution
of the user program.

To open the Extended Monitor window, choose CPU -> Extended Monitor from the View menu, or click on the Extended

The displayed items are updated at an interval of about 1,000 ms during user program execution or about 5,000 ms during a
break.

Monitor toolbar button |

CAUTION
“CPU Clock” can only be measured while the user program is running.

Extended Monitor |
5}

Item |Value

User 3System Connection DISCONNECT (Disconnect: CNNO, CNN1)

User System Power Source CONNECT (0.9 )
Uzer System TEST -

User System RESETH High

User System NMIH High

CPU Clock -

Main Clock(ogcl) Emulator Z0.0 MHz
Sub Clock(X1) Erwulator 33.0 kHs

.‘I | _'I

Figure 5.16 Extended Monitor window
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5.5.2 Selecting the Items to Be Displayed
Choose Properties from the popup menu of the Extended Monitor window. The Extended Monitor Configuration dialog box

will be displayed.

— Update millzecond
Ok
Bunning: I 1000 Ereak: I RO00
Cancel

Settings:

[kem | W alue

Idzer Syzten Connection DISCOMMECT [Dizconnect: CMMO, CHHT]

Idzer Syztemn Power Sournce COMMECT [0.9 4]

[¥] User System TEST -

[¥] User System RESETH High

[#] Uzer Spstemn Ml High

CPU Clack -

tain Clack[05C1] Ernulator 2000 MHz

Sub Clock(+1] Ermulator 33.0 kHz

1| | i

Figure 5.17 Extended Monitor Configuration dialog box

This dialog box allows you to select items to be shown in the Extended Monitor window.
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5.6 Using Software Breakpoints

5.6.1 Using Software Breakpoints

In a software break, the instruction code at a specified address is replaced with a BRK instruction, which causes the user
program to stop running by generating a BRK interrupt. In that sense, this is a pre-execution break function.

Up to 4096 breakpoints can be set.

If multiple software breakpoints are set, program execution breaks when it arrives at any of the breakpoints reached.

(1) When stopped at a software breakpoint

When the program you have created is run and arrives at an address you have set as a software breakpoint, the program stops
and the message “Software Break” is displayed on the Debug sheet of the Output window. At this time, the Editor or
Disassembly window is updated, and the position where the program has stopped is marked with an arrow [ =] in the S/W
Breakpoints column.

CAUTION

When a break occurs, the program stops immediately before executing the line or instruction at which the software breakpoint
is set. If Go or Step is selected after the program has stopped at the breakpoint, the program restarts from the line marked with
an arrow.

5.6.2 Adding and Removing Software Breakpoints
Select either of the following ways to add or remove software breakpoints.

- From the Editor or Disassembly window
- From the Breakpoints dialog box (only for removal)
- From the command line
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(1) From the Editor or Disassembly window

1. Check that the Editor or Disassembly window that is currently open shows the position at which you want to set a software
breakpoint.

2. In the S/W Breakpoints column, double-click on the line where you want the program to stop.

=0l x|
Elll=

Line Source... | E.| C.| 5. Scurce |
55 :I
e
s6 002130, [ woid Sample::change({long *a)
57 i
S5 Long tmp[10] :
59 int 1i:
&0 |‘/
61 |00Z213C = for{i=0; i<10; i++)(

62 OO0Z144 E@[i] = al[i]l:
&3

64 002168 for [1=0; 1€10: 14++)4

&5 O0Z170 ali] = twpl[9® - i):

56 i

567 |00Z 198 i

66 -
4| | K| 2

Figure 5.18 Editor window

Alternatively, you can select Toggle Breakpoint from the popup menu or press the F9 key.

3. When a software breakpoint is set, a red circle [®] is displayed at the corresponding position in the S/W Breakpoints
column of the Editor or Disassembly window.

ET TR
Elll=
Ling Source.. | E.] C) 5. Sowce |
=5 Zl
L6 (002130 - void Serople: icheange (long *a)
57 {
58 long tmp[10]:
59 int 1;
&0
61 |00213C L for (i=0; i<10: i++) |
62 |00E144 tmp[i] = ali];
63 i
64 |D0Z165 Tor (1=0; 1<10:; i++){
&5 |D0Z170 a[i] = cwp[9 - i]:
(=14 }
57 |00E198 H
1]
| |

Figure 5.19 Editor window

Double-clicking one more time removes the breakpoint.
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5.6.3 Enabling and Disabling Software Breakpoints
Select one of the following ways to enable or disable software breakpoints.

- From the Editor or Disassembly window
- From the Breakpoints dialog box
- From the command line

(1) From the Editor or Disassembly window

1. Place the cursor at the line where a software breakpoint exists and then select Enable/Disable Breakpoint from the popup
menu. Alternatively, press the Ctrl and F9 keys at the same time.

=101.x]

Line Sow... | E.[ C.| 5. Source |

’ B

=] init (struet 3Jsmple *p Sam)

9 |F30C2 1 J

10 |F8OCS p_sam->=0 = 0O;

11 |F80OD7 p_sam->=1 = 0O;

12 |FBOED p_sam->352 = 0;

13 |FE105 L p_sam->s3 = 0;

14 |F311D p_sam->5%4 = 0;

15 |F5135 p_sam->s35 = O; Bonkmatks b

16 |FS14D p_samw-rs6 = 0; Templates k
1] |

Enable/Disable Breakpoink Chrl+F3

Figure 5.20 Editor window and popup menu

2. The software breakpoint is alternately enabled or disabled.
RI=ES
&\

Line Souwr.. | E.| C.| 5. Source |
’ =
g init (struct 3Jample *p sam)
o [F20C2 i J
10 |F80CS p_ssw-»=0 = 0O;
11 |Fs0D7 p ssm-»=1 = 0O;
12 |FSOED p ssm-»s2 = 0O;
13 |FB105 o p_sam->=3 = 0
14 |F511D p ssm-»s4 = 0O;
15 |F5135 p sSsm-»s5 = 0O;
16 |F514D p_samw->s36 = 0; -
1] | W

Figure 5.21 Editor window
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(2) From the Breakpoints dialog box

1. Select Source Breakpoints from the Edit menu to bring up the Breakpoints dialog box. In this dialog box, you can alternately
enable, disable, or remove a currently set breakpoint.

X,

Breakpoints ll_l

Ok

Cancel

Edit Code

Bemove

4

R emowve Al

Figure 5.22 Breakpoints dialog box
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5.7 Using Events

5.7.1 Using Events

An event refers to a combination of phenomena that occur during program execution.

The E100 emulator permits you to use an event you have set as a condition for the break, trace or performance-analysis
function.

Events can be set at up to 16 points at the same time.

These 16 points can be placed as desired.

Events you create can be registered for reuse at a later time.

(1) Types of events

Events are of the following types.

Table 5.9 Event types list

Instruction fetch The emulator detects that the CPU has executed the instruction at the specified address.
Detection is in the cycle of execution by the CPU rather than the cycle of prefetching by
the instruction queue.

Data access The emulator detects access under a specified condition to a specified address or
specified address range.

Interrupt The emulator detects interrupt generation or return from an interrupt handler.

Trigger input The emulator detects a signal fed in from the input cable for external trigger signals being

in a specified state.

(2) Event combinations

The following types of combination can be specified for two or more events.

Table 5.10 Types of event combination

OR The condition is met when any one of the specified events occurs.

AND (cumulative) The condition is met when all of the specified events occur regardless of the timing.
AND (simultaneous) The condition is met when all of the specified events occur at the same time.
Subroutine The condition is met when a specified event occurs within a specified address range.
Sequential The condition is met when the specified events occur in a specified order.

State transitions ;jrigzrc;rzdition is met when the events occur in an order specified in the state transition

5.7.2 Adding Events
Select one of the following ways to add events.

- Create a new event
- Add by dragging and dropping from another window
- Add from the command line
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(1) Creating a new event

[Creating an event in the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box]

1. Click on the Add button or double-click on the line where the new event is to be added.

Hardware Break

—Event:

Event | T.I Descriptions | Co... | Ta... | Comrment

Add... Delete | Enabile | Disable |

Figure 5.23 Hardware Break dialog box

2. The Event dialog box shown below will be displayed. In this dialog box, set the details of the event condition and then click

on the OK button.

[Cenetion || counk snd Task 30 | Commant |

Bl |

Evant type [Insm.l:limfr:.::h d 1™ Countf1-255)8 -
- Condition sattings I—
hdd'mmﬂ:mliﬂﬁfﬂdmt-: ;|
[ Taskim
Stact; | (OOCO0 - End: | (0000 -
- C e | ——
[ Speci'y & function nase | = —

rhnm:l

Bisin Carcel

= |

[ ]

concel_|

Figure 5.24 Event dialog box

3. An event will be added at the specified position.

Hardware Break OR |

Event:

Event T, I Descriptions

Court | TaskID | Commenk

F  [Address] _main

Figure 5.25 Hardware Break dialog box

4. If you create an event that would make the total number of events exceed 16, an error message is displayed. In this case, the

event you have added is invalid.
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[Adding an event from the Registered Events dialog box]

1. Click on the Add button in the Registered Events dialog box.

<o
Events
Type | Descriotions | court | Taskip | comment
1 | =
Dupicate || add... ] [relete | [Delete .f-.II|
Save... | Load... | Help Close
i

Figure 5.26 Registered Events dialog box

2. The Event dialog box shown below will be displayed. Set details of the event condition in this dialog box. Enter a comment
if any is necessary. Then click on the OK button.

event Eillevent |
Condiian | Count and Task 30 | Comment | Condthn | Count and Task D Cement |
Event bype [Irstaction fatch = Comment: | main Function
r—Condition settngs
Ackdress condbian |Specied value (=) =l
F' A d | this et o e et
o I | [ e | = |
[T Speciy a funckion neme
Fhm:l d |-’I"‘.‘<"-"‘:...I
Function name: | E
pp [ e ] cown pep [ e ] coma

Figure 5.27 Event dialog box
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3. The event is added to the list of registered events.

ioix
Events
Type | Descriptions | court | Taskip | comment
F  [Address] _main - - mzin Function
1] | =
_,lup.:al.'-':[ Add... I [helete | DEIEJ:EAII|
Save... ] Losd... | Help l close |
E

Figure 5.28 Registered Events dialog box

(2) Adding an event from the Event column of the Editor window
[Adding a hardware breakpoint]

1. Select HW Break Point from the popup menu opened by double-clicking or right clicking in the Event column of the Editor
window.
This sets fetching from the corresponding address as the condition for a hardware breakpoint, i.e an instruction fetch
condition.

Eel@

Line Sour.. | B C.| 5. Sowce
14 wold main(wold)
15 |FEZDC {
16 F82DC E/ vhile (1) 4
17 |FEZED cutarial (]2

18 |FE2E3 ‘W Break Point

19 FE2ES Trace Fort

20

21 mold tutorial (void)

22 |FBZEG {

23 long a[10]

Z4 lorwg 3:

25 int iz

28 atruct Sample far Tp sSam;

e

| |

Lt zorkc v Tutoriale I

Figure 5.29 Editor window
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2. If the number of events currently set allows room for another, the event you have added from the Editor window is added as
an OR condition. If there is no room, an error message is displayed.

CAUTION

If you are editing the contents of the Hardware Break dialog box, you cannot set a hardware breakpoint from the Event column
of the Editor window.

Hardware Break QR l

—Ewent:
Event I Type | Descriptions | Counk | TasxID | Comment
T ¢ (adovess]Fazeo . -

Figure 5.30 Hardware Break dialog box

[Adding a trace point]

1. Double-click or right click in the Event column of the Editor window then select Trace Point from the popup menu.
This sets fetching from the corresponding address as the condition for a trace point, i.e an instruction fetch condition.
Double-click on the instruction fetch event in the Event column of the Editor window to delete it.

CAUTION
Trace points cannot be set in the Event column of the Editor window in the following cases.

- The contents of the Trace conditions dialog box are being edited.

- The selected trace mode is Fill until stop or Fill until full.
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(3) Adding events by dragging and dropping

[Dragging and dropping a variable or function name in the Editor window]

1. By dragging and dropping a variable name into the Event column, you can set access to that variable as an event to be

detected, i.e. a data-access condition.

At this time, the size of the variable is automatically set as a condition of the data access event.

Only global or static variables taking up 1, 2, or 4 bytes can be registered for event detection. Static variables in functions

cannot be registered.

2. By dragging and dropping a function name into the Event column, you can set instruction fetching from the address where

that function starts as an event to be detected.

Il Hardware Break *

Hardwere Bresk OR |

Evenk:

| Event | T..| Descriptions

Line Sour..  E. CJ 5| Sowce
25 L e ————
26
27 (
£8 |Fa1BD
23 long t;
30 int i, 4, kK,
31
32 |FaiBs o ==
33 |F31ES while| gap > 0 ){
a4 Falcz for | k=0; kg
35 |F1CF for{ i=k+

Figure 5.31 Editor window and Hardware Break dialog box

[Dragging and dropping an address range in the Memory window]

F [address] $sort
[Address] Q060 [Size] WORD. ..

| Counk | Tastip | Camme

Select an address range in the Memory window and drag and drop it into the Event column. In this way, you can set access to

an address in the selected address range as a data access event to be detected, i.e. a data access condition.

[Dragging and dropping a label in the Label window]

You can set fetching from the label as an event to be detected, i.e. an instruction fetch condition.
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5.7.3 Removing Events
The following ways of removing events are available.

[Deleting an event from the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box]

1. To remove one point, select the line you want to remove in the Event list and then click on the Delete button (or use the
keys Ctrl + Del instead of clicking on the button).
The selected event will be removed from the Event list.

Hardware Break ©OR |

—Event:

Event | T.I Descripkions | Cu:uuntl TaskID | Zammerkt |
F [Address] _start
F [Address] _initsck - -
F [Address] _exit - -

add. .. ' Delete Enable | Disable |

Figure 5.32 Hardware Break dialog box

2. Toremove multiple events, hold down the Shift or the Ctrl key while you select lines you want to remove in the Event list
and then click on the Delete button (or use the keys Ctrl + Del instead of clicking on the button).
The selected events will be removed from the Event list.

Hardware Break  ©R |

—Event:

Event | T.I Descripkions | Cl:uuntl TaskID | Carmment |

Add... I Delete | Enable | Disable |

Figure 5.33 Hardware Break dialog box
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[Deleting an event from the Registered Events dialog box]

To remove one point, select the line you want to remove in the Registered Events dialog box and then click on the Delete
button (or use the keys Ctrl + Del instead of clicking on the button).

The selected event will be removed from the list of registered events.

To delete all events, click on the Delete All button.

[N rRegistered Events =10l x|

Events
Twpe | Descripkions | Cournk I TaskID I Caomrnenk
F [Address] _PowerQnl_,.,
F [Address] _main - -
F [Address] tutarial() - -
F [Address] Sample::sor,., - -

4| | |

Cuplicate | add... Delete Celete all
SAVE. .. | Load... | Help I Close I
P

Figure 5.34 Registered Events dialog box
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5.7.4 Registering Events

“Registering an event” refers to placing an event in the list of registered events. A registered event can be reused at a later time.
Select one of the following ways to register an event. Up to 256 events can be registered.

(1) Registering events

[Creating an event in the Event dialog box]

1. Open the Comment page of the Event dialog box and select the “Add this event to the list” checkbox. Then click on the
OK button.

x

Conditinnl Count and Task ID  Comment I

Comment: | BreakPoint

Iv ndd this event ta the list

Help | Ok I Cancel

Figure 5.35 Event dialog box

2. The event is added at the specified position and registered in the Registered Events dialog box at the same time.

Hardware Break O | Bl Riogistered Evers * , =101 x|
—Ewvent: Events
Ewanit | T.I Descriphons | Zounk [ TaskID [ Commeant [ _TE;LlEﬂ_dmaﬁ]Tunm I Courk I Tooi T | ;:Ia_mtnt |
FEDM F  [Address] 00000 . . BreakPoirt -

Figure 5.36 Hardware Break dialog box and Registered Events dialog box
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[Registering an event by dragging and dropping]

An event you have created can be registered in the Registered Events dialog box by dragging and dropping it into the list.

Hardware Break  OR ] Bl F:0isbered Events * =10] =|
—Ewent: Events
Ewanit | T.I Descriphons | Zounk [ TaskID [ Commeant [ —TEL[D—WEMM I il I e | A |
F [address] 00000 - - BreakPoint
FEDM F  [Address] 00000 . . BreakPoirt

Figure 5.37 Hardware Break dialog box and Registered Events dialog box

[Registering an event in the Registered Events dialog box]

Click on the Add button to create an event. Any event you create here is added to the Registered Events dialog box.

[Nl Registered Events

Events

=10 x|

Tvpe | Descriptions | Zounk | TaskID I Camrnenkt

<

2]

Duplicate add... Delete | Delete .ﬁ.lll

Save. .. | Load... |

Help | Close |

Z

Figure 5.38 Registered Events dialog box

(2) Attaching comments

An explanatory comment for the event can be attached. Check the Registered Events dialog box to see the registered events

and comments.
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5.7.5 Creating Events for Each Instance of Usage or Reusing Events

The following two approaches are available for setting events in the Hardware Break, Trace conditions, or Performance
Analysis Conditions dialog box.

One is to create events in the dialog box each time they are to be used. The other is to choose a condition from the Registered
Events dialog box and drag and drop it into the Event list in the Hardware Break, Trace conditions, or Performance Analysis
Conditions dialog box.

Here, we refer to the former as creating events per usage and the latter as reusing events.

[Creating events per usage]

Select this method if you intend to use a specific condition only once. The event you have created is used without ever being
registered.

Once the event is no longer in use (i.e., it has been changed or deleted), its setting is nonexistent.

Any event created by a simple operation such as double-clicking in the Event column of the Editor window constitutes an
event created per usage.

[Reusing events]

Any event registered in the Registered Events dialog box can be reused by dragging and dropping it into the Event list in the
Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box.

e prara BoR I [N Registered Events [ o ]
Event: Events
et I T I Descrinti ‘ Count l TaskD l C : Type | Descriptions | Count | TaskiD I Comment
Yen 1pe | Lescrptions o 2 Smmen F  [Address]0O00000 - - BreakPoint
F [Address]oo0000 - - BreakPaint

Figure 5.39 Reusing an event

(1) Dragging and dropping an event into multiple dialog boxes

An event in the Registered Events dialog box can be dragged and dropped into multiple dialog boxes.
If a condition of an event is altered after the event has been dragged and dropped, the alteration is not reflected in the setting of
the original event in the Registered Events dialog box.

(2) Registering duplicates in the Registered Events dialog box

Even duplicate events that have the same conditions can be registered in the Registered Events dialog box.
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5.7.6  Activating Events

To activate the settings for events that you have created, click on the Apply button. Settings you make do not become effective
until you click on the Apply button.

[*] after the title on the title bar of the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box
indicates that some setting is being edited. While you are editing an event, you cannot change the settings via the Event
column of the Editor window or the command line.

1ol

Hardware Break ©OR I

rEvent:
Evert | T..] Descrintions | count | Taskip | comment |
Ewdl F [Address] _main = rivain Function

Add... I Delets | Enabls ] Dissble |

Event used 1 Free 15 Detail Ra-g'rstraradavmts...l
save.. | Losd. | Help rpq:plg.r Close
p s

Figure 5.40 Activating the settings
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5.8 Setting Hardware Break Conditions

5.8.1 Setting Hardware Break Conditions
A hardware break causes the user program to stop running a specified number of cycles after a specific event or phenomenon
is detected (i.e., a hardware breakpoint is encountered). Up to 16 events can be specified as hardware breakpoint conditions.

5.8.2 Setting Hardware Breakpoints
(1) Setting Hardware Breakpoints

For a hardware breakpoint, you can set an OR condition, other conditions (AND (cumulative), AND (simultaneous),
subroutine, sequential or state transitions) and detection of exceptional events.

For each hardware breakpoint, you can specify all or only one from among the OR condition, other conditions, and detection
of exceptional events.

Program execution

{
OR condition | ->
Other conditions
AND (cumulative)
AND (simultaneous) -> Hardware breakpoint
encountered
Subroutine
Sequential
State transitions
Exceptional event ->
2 } Delay value
Break

Figure 5.41 A hardware break in outline
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(2) Setting an OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

To disable the OR condition, deselect the checkbox to the left of “OR condition.”

If you add an event by double-clicking in the Editor window while the OR condition is disabled, the OR condition is
automatically enabled.

When the OR condition is re-enabled, the previous event settings on the OR page (with their checkboxes being selected) are
restored.

However, if re-enabling the OR condition would bring the total number of events to more than 16, the events are restored with
their checkboxes not selected (disabled) on the OR page.

condition and combination setting
v OR condition:

Eventinuse: 0  Detai |

I other conditions:

IAND(.ﬁ.ccumuIatinn} j
Event inuse : 0 [etai |

1 Exception:

Taotal ; O Ewent

Delay(cycle) —

Exceptional m—— | ........... . "
events I ]

Figure 5.42 Hardware Break dialog box

Table 5.11 OR condition

Type Description

OR condition A breakpoint is encountered when any of the specified events occurs.
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(3) Setting other conditions

You can select one from among five available choices: AND (cumulative), AND (simultaneous), Subroutine, Sequential and
State transitions. To set any condition, select the checkbox to the left of “Other conditions.” Other conditions are disabled by
default (the checkbox to the left of “Other conditions” is not selected). Cumulative AND is listed as “AND(Accumulation)” in
the dialog box.

Hardware Break |OR I ANDEACcumulation) I

condition and combination setking
—v OR condition:

Evertinuse: 0  Detai |

IAND(.ﬁ.ccumuIatinn} j

Event inuse : 0 Dretail |

1 Exception:

Taotal ; O Ewent

) Delay(cycle) —
Bceptonal | e [ - [I—n
Figure 5.43 Hardware Break dialog box
Table 5.12 Other conditions
Type Description

AND (cumulative) A breakpoint is encountered when all of the specified events have occurred regardless of
their timing and order.

AND (simultaneous) A breakpoint is encountered when all of the specified events occur at the same time.

Subroutine A breakpoint is encountered when a specified event occurs within a specified address range
(subroutine or function).

Sequential 6 steps (forward direction) + reset point
A breakpoint is encountered when the specified events occur in a specified order.

State transitions 3 steps, 9 paths + reset point
A breakpoint is encountered when the specified events occur in a specified order.

The events shown in the list for each condition can be deleted by the keys Ctrl + Del.

CAUTION

When a time-out condition is set in State transitions (Hardware break point) dialog box, the time to make transition from a set
state to another then back to the original set state must be 10 ps or more. Transition time of less than 10 ps will result in an
incorrect timeout detection.
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(4) Detection of exceptional events
Specify whether you want detection of the following exceptional events to be used as a breakpoint.

- Violation of access protection

- Reading from a non-initialized memory area
- Stack access violation

- Performance-measurement overflow

- Realtime profile overflow

- Trace memory overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

If this checkbox is selected, program execution breaks the specified humber of bus cycles after the breakpoint is encountered.
The delay value is specifiable in the range from 0 to 65,535 (default = 0).

5.8.3 Saving/Loading Hardware Break Settings

(1) Saving hardware break settings

Click on the Save button of the Hardware Break dialog box. The Save dialog box will be displayed.
Specify the name of the file where you want the break settings to be saved. The file-name extension is “.hev”. If this is omitted,
the extension “.hev” is automatically appended.

(2) Loading hardware break settings

Click on the Load button of the Hardware Break dialog box. The Load dialog box will be displayed. Specify the name of the
file you want to load.

When you load a file, the previous hardware break settings are discarded and the new settings appear in the dialog box.

Click on the Apply button of the Hardware Break dialog box to activate the new hardware break settings you have loaded.
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5.9 Viewing Trace Information

5.9.1 Viewing Trace Information

Tracing means the acquisition of bus information per cycle and storage of this information in trace memory during user
program execution. You can use tracing to track the flow of application execution or to search for and examine the points
where problems arise.

The E100 emulator allows acquisition of up to 4-M bus cycles.

When program execution stops (due to an exception break, forced stop or breakpoint), the contents of trace memory at the time
the program has stopped are displayed as the result of tracing, even if no trace points have been encountered yet.

5.9.2 Acquiring Trace Information

In cases where no trace acquisition conditions are set, the default behavior of the E100 emulator is to acquire information on
all bus cycles unconditionally (trace mode = Fill until stop).

In “fill until stop” mode, the emulator starts trace acquisition as soon as the user program starts running. When the user
program stops, the emulator stops tracing.

The acquired trace information is displayed in the Trace window.

T C e ————— 4

uVE|Faxzhi# Fdr |F QGG
[Riange: -000L204E, 00000000 Fie: [Cyde: 00000016 [address: DOZLAD [Tine: 00:00:00.100.782.300 |
cyele | Tobel | Address | Doce | BOS | Sime | B/u | BuT | Scotus | IMDO | IMDL | BOBACC | Debug | BV | EL< | Timedcemp |himea.ma.m]=]
-000AaNn1E ODELAD 0110 16 WORD R 0 FETCH . . - [i ] 00n0aNnnnInnnnaa - n0:00:00. 100, 782 310
-000]001s ODZLa0 000D 16k  WORD - 1 DAT e - a o a0ooJooondaononia - 00;00:00, 100,730,700
00000014 PFEFGC 000D 16k LOBF WORD R i} DAT Ju] O 0000I00000000030 O0;00:00, 100, 799,080
-00000013 FFEFGE 000A 16b LORSG WORD R a DAT - a o Q00000000J300000 - O0:00:00. 100,207 . 460
-000aa012 ODE1AZ  EDTE  18h  WORD R o FETCH - a ] 0000000300000 - 00:00:00. 100, 215850
-00noaanil ODZ1lkd 5470 16k WORD R 0 FETCH - a ] annnJoonniaonnda - On:00:00.100.524.220
=00030010n oDZlad 000D 16k  wWORD - 1 DAT - o] D Q00CI000000000I0 - 00;00:00, 100,524,320
=000doooe FFEF?0 000D 16k LORF WORD R i} DAT - Ju] D 0000d00000000000 - 000000, 100,240,240
~00D00008 FFEFT? 0024 18b LOEG WORD R 1] IAT . ] i 0000300003000030 - 00:00:00. 100, 249280
~000a0007 FFEF74 OOFF 15%  LONG WORD R 0 AT .- 0 o 0000aNnnDInnnoan - 00:00:00. 100, 857 . 620
-000J0006 FEEFTE  EODE  16b  LobEs WORD R ] DAT v = a 0 a000Iaa00Jd0003d - 00;00:00. 100,565,550
0000005 oDZine  concd 16k WORD R i} FETCH Ju] D 000DI0000I000030 00;00:00, 100,874,300
-000a0004 FFEFM 000D 16k LOBF WORD R 0 DAT - Ju] o 0000I00000000000 - 00:00:00, 100,282 .70
-00030003 FFEFTA  10B0 15b LOKG WORD R ] TAT - il o 0000300003000030 - 00:00:00. 100, 291040
-0noaanng FFEFTA  0ODD 18k WORD - 1 DAT - a ] anoneJaonnoaonnga - oD:00:00, 100,599,410
-000J0onL anlosn 5TR0 16k WORD R ul FETCH - a o a0oDi0onoJaaonig - 00;00:00. 100,599,510
0000000 ooi0s2 G970 16k WORD R L} FETCH - Ju] o 0000200000000000 - 0000 :00, 100,299,570 j

Figure 5.44 Trace window
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The following items are shown in the Trace window (in bus display mode).

Table 5.13 Items shown in the Trace window

Column Description

Cycle Number of the cycle within trace memory. By default, the number of the last cycle to have been acquired
is 0, and earlier cycles are assigned progressively lower numbers in sequence, i.e. -1, -2, etc. If a delay
count is set, the cycle on which the trace stop condition is met is numbered 0 and the cycles that were
executed until the program actually stopped (cycles during a delay period) are assigned progressively
larger numbers +1, +2, etc. in sequence up to the last cycle to be acquired.

Label Label corresponding to the address (displayed only when a label has been set)
Address Address on the address bus
Data Data on the data bus (in hexadecimal)
BUS Data bus width indicated as ""8b" when the bus is 8 bits wide, or "16b" when 16 bits wide.
Size Unit of access (byte, word, or longword)
R/W Data bus state, indicated as “R” for reading, “W” for writing, or “~” for no access
RWT Whether the bus cycle is valid or not. The value “0” indicates a valid bus cycle. The Address, Data and
BIU information is valid when RWT is “0”.

Status Operating state of the target MCU.

Display form Description

DTC Access by DTC operation

MSCI Access by MSCI operation

FETCH Instruction fetch by CPU operation

STANDBY CPU is in the standby mode

SLEEP CPU is in the sleep mode

DAT Data access by CPU operation
IMDO States of interrupt mask bits of the condition code register in interrupt control mode 0.

Display form Description

Bit CCR |
. 0
I 1

- The entry under IMDO is "-" if IMD2 values are being displayed.

IMD2 Interrupt mask levels of the extend register in interrupt control mode 2.
Value Description
Bit EXT I1 Bit EXT 10
0 0 0
1 0 1
2 1 0
3 1 1

- The entry under IMD2 is "-" if IMDO values are being displayed.

BUSACC 0 indicates that the emulator has taken over the MCU bus while the user program was running. The
emulator takes over the MCU bus when access to memory is attempted by a debugger operation.
Note: Execution of the user program is temporarily stopped during such access to memory.

DEBUG 0 indicates that the emulator has taken over the MCU bus while the user program was running. The
emulator takes over the MCU bus when access to memory is attempted by a debugger operation.
Note: Execution of the user program is temporarily stopped during such access to memory.

EV If an event occurred, the number of the event.
To show the EV column, you need to select Event number on the Option page of the Trace conditions
dialog box opened by choosing Acquisition from the popup menu of the Trace window.
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Column Description

TID Task ID (when the RTOS is in use)

Task IDs are shown in the form “task ID (task entry label)”, such as 1 (_Taskl). To show the Task ID
column, you need to select Task ID on the Option page of the Trace conditions dialog box opened by
choosing Acquisition from the popup menu of the Trace window.

EXT Signal fed in from the external trigger cable; “1” and “0” indicate the signal being at the high and low
levels, respectively.

To show the EXT column, you need to select External trigger on the Option page of the Trace conditions
dialog box opened by choosing Acquisition from the popup menu of the Trace window.

ELC Name of the module requested by the event link controller to start up.

TimeStamp Time elapsed since the target program has started.

Each time the user program starts running, timestamping starts from 0.

Note: After the counter has overflowed, the times displayed will not be correct. The maximum timestamp
value is 3 hours 03 minutes 15 seconds.

Columns of the Trace window can be hidden if you do not require them. To hide a column, right-click in the header column
and select the column you want to hide from the popup menu.

5.9.3 Setting Conditions for Trace Information Acquisition

Since the size of the trace buffer is limited, the oldest trace data is overwritten with new data after the buffer has become full.
You can set trace conditions to restrict the acquired trace information to that which is useful, thus more effectively using the
trace buffer.

To set trace conditions, use the Trace conditions dialog box that is displayed when you choose Acquisition from the popup
menu of the Trace window.

(1) Selecting the trace mode
Start by selecting the trace mode.

Trace | Opkion |

Z"I'\|.|
Trace Mode: an Fill until skop j

ill until stop

v
¥ [ OR cong A Fill unkil Full
Event in s B
i «'.:-—"I celar Fill around TP
| Gther c o7

I
-[ [ r | Repeat fill until stop

IAND{A-:::L T |L JI._ i

] ]' Repeat fill unkil Full
Eventinusg 0 o= 1

Figure 5.45 Trace conditions dialog box

(2) Setting trace points

If you have selected Fill around TP, Repeat fill until stop or Repeat fill until full, you need to set a trace point.
For trace points, you can specify conditions using events and/or the detection of specific exceptional events.
For Fill around TP, you can also specify a delay value.
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(3) Selecting Capture or Do not capture

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture or Do not capture in the
Record condition group box.

Record condition:
Al s urej " Do nok capture ¥ | Step executionis recorded

I BBVl W Ev]_ Between bwo events j Dk il |

Eventin use ; O

Figure 5.46 Record condition group box

You can specify events so as to extract only the required portions or to eliminate non-required portions of the trace information.

(4) Recording step execution

If the selected trace mode is Fill until stop, you can record step execution. To record step execution, select the Step execution
is recorded checkbox in the Record condition group box.

~Record condition:
@ @l  Capture { Donot capture v Step execution is recorded

Evenktinusa : 0

Figure 5.47 Recording step execution

The recordable modes of step execution are Step In, Step Over and Step Out.

(5) Selecting the type of trace information to be acquired

Use the Option page of the Trace conditions dialog box to select the type of trace information to be stored in the trace memory.
By default, ‘Event number’ is selected as the type of trace information.
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5.9.4 Selecting the Trace Mode
(1) Selecting the trace mode

The following five trace modes are available.

Table 5.14 Trace modes

Trace mode Description
Fill until stop Trace acquisition continues until the program stops running.
Fill until full Trace acquisition stops when the trace memory becomes
full.
Fill around TP Trace acquisition stops a specified number of cycles after a

trace point is encountered. A delay value can be specified in
the range up to the maximum value of trace capacity.

Repeat fill until stop For each trace point encountered in program execution,
information for a total of 512 cycles* before and after the
point is acquired, and acquisition continues in the same way
until the program stops running.

Repeat fill until full For each trace point encountered in program execution,
information for a total of 512 cycles* before and after the
point is acquired, and acquisition continues in the same way
until the trace memory is full.

CAUTION
*Recording is for 512-cycles units, consisting of the lines for the cycle at the trace point, for the 255 cycles before that point,
and for the 256 cycles after that point.

Execution start

trace pointis
encountered

trace pointis
encountered

trace pointis
encauntered

Execution stop

Figure 5.48 Differences between the trace modes
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Specifiable conditions vary with the trace mode, as summarized in the tables below.

1. Fill until stop
The trace memory can hold up to 4-M bus cycles. When the buffer becomes full, the oldest data among the acquired trace
information are overwritten with new data. The emulator continues acquiring trace information in this way until the
program is stopped.

Table 5.15 Specifiable conditions: Fill until stop

Trace point Delay Specifying capture/do not Recording of step
capture execution
- - Possible Possible
2. Fill until full

Once the trace memory of the emulator overflows during trace acquisition, the emulator stops acquiring trace information.

Table 5.16 Specifiable conditions: Fill until full

Trace point Delay Specifying capture/do not Recording of step
capture execution
- - Possible -

3. Fill around TP

Trace acquisition is halted a specified number of cycles after a trace point is encountered. In this mode, the user program
continues running and only trace acquisition is halted. Sophisticated conditions can be set using a maximum of 16 event
points. The delay value can be chosen as 0-M, 1-M, 2-M, 3-M or 4-M cycles.

Table 5.17 Specifiable conditions: Fill around TP

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible Possible Possible -

4. Repeat fill until stop
For each time trace point encountered, information for a total of 512 cycles before and after that point is acquired, and
acquisition continues in the same way until the program stops running. Acquisition continues until it is halted by a break or
forced stop. The positions where trace points have been encountered can be checked in the Trace window.

Table 5.18 Specifiable conditions: Repeat fill until stop

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible - - -
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5. Repeat fill until full
For each time trace point encountered, information for a total of 512 cycles before and after that point is acquired.
Acquisition continues in the same way until the trace memory overflows, at which time acquisition is halted. The positions
where trace points have been encountered can be checked in the Trace window.

Table 5.19 Specifiable conditions: Repeat fill until full

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible - - -
CAUTION

If trace points are encountered in consecutive cycles in the repeat fill until stop or repeat fill until full mode, the yellow
highlight that indicates a trace point only appears for the trace point in the first of the cycles.

5.9.5 Setting Trace Points
(1) Setting trace points

For trace points, you can set an OR condition, other conditions (AND (cumulative), AND (simultaneous), subroutine,
sequential or state transitions) and detection of exceptional events.
You can specify all or only one of the OR condition, other conditions and detection of exceptional events at a time.

Trace acquisition

\

OR condition | ->

Other conditions
AND (cumulative)

AND (simultaneous) -> Trace point encountered
Subroutine

Sequential
State transitions

| Exceptional event | ->

J } Delay value
Trace acquisition halted
Figure 5.49 A trace point in outline
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(2) OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

When the OR condition is re-enabled, the previous event settings on the OR page (with their checkboxes being selected) are

restored.

However, if re-enabling the OR condition would bring the total number of events to more than 16, the events are restored with
their checkboxes not selected (disabled) on the OR page.

Trace ]DR | option |

Trace Made: | — T
condition and combination setking
v R condition:

Eventinuse: 0 Detall |

1 Other condiblons: ————

|1r:r {Acoumulation) L] i

Eventinuse: 0 Detai |

= Excepbion:;

Excepbional T |.---_--____.
e oLl

- Fill around TP j

Toktal : 0 Event
—Delaviovclel ——
ord4 w

—Record condkion:

+ al  Capture © Danokcaphure

™ Step exenston isrecorded

Event inuse : 0

Figure 5.50 Trace conditions dialog box

Table 5.20 OR condition

Type

Description

OR condition

A trace point is encountered when any of the specified events occurs.
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(3) Other conditions

You can select one from among five available choices: AND (cumulative), AND (simultaneous), Subroutine, Sequential and
State transitions. To set any condition, select the checkbox to the left of “Other conditions.”

Other conditions are disabled by default (the checkbox to the left of “Other conditions™ is not selected). Cumulative AND is
listed as “AND(Accumulation)” in the dialog box.

Trace l AMD{Accumulation’) ] Cption |

Trace Muda:l | o Fill around TP j

condition and combination setting

= OR condition:
Eventinuse: 0 Cetal |

v Other conditions: ————
[anD(pcoumustion) ]

AMD Sirultaneouws )

Subroukine Tokal : O Ewent
Sequential ' —Delaylovole):
State bransitions [|-======-==--=
Events ] ar4 =
—Record condkion:
&+ gl  Capture . Donotcaphure ™ Stenexecution s recorded

Ewenkinuse ;0

Figure 5.51 Trace conditions dialog box

Table 5.21 Other conditions

Type Description

AND (cumulative) A trace point is encountered when all of the specified events have occurred, regardless of the
timing.

AND (simultaneous) A trace point is encountered when all of the specified events occur at the same time.

Subroutine A trace point is encountered when a specified event occurs within a specified address range
(subroutine or function).

Sequential 6 steps (forward direction) + reset point
A trace point is encountered when the specified events occur in a specified order.

State transitions 3 steps, 9 paths + reset point
A trace point is encountered when the specified events occur in a specified order.

CAUTION
When a time-out condition is set in State transitions (Trace) dialog box, the time to make transition from a set state to another

then back to the original set state must be 10 ps or more. Transition time of less than 10 pus will result in an incorrect timeout
detection.
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(4) Detection of exceptional events
Specify whether you want detection of the following exceptional events to be used as a trace point.

- Violation of access protection

- Reading from a non-initialized memory area
- Stack access violation

- Performance-measurement overflow

- Realtime profile overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

If this checkbox is selected, tracing stops the specified number of bus cycles after the trace point is encountered.
The delay value is selectable as 0-M, 1-M, 2-M, 3-M or 4-M bus cycles (default: OM).
Select the desired value from the Delay drop-down list box.

Figure 5.52 Selecting a delay value
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5.9.6  Setting Extraction or Elimination Conditions

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify a condition for capturing or not
capturing information.

You can specify events so as to extract only the required portions or to eliminate non-required portions of the trace information.

(1) Extraction and elimination conditions

The following types of condition are available.

Table 5.22 Extraction and elimination conditions

Type Description

Extraction WEML T E]_ Between two events Trace information is extracted from the cycle in which the
event set as [Start event] occurs to the cycle preceding the
event set as [End event] (information is not acquired for the
cycle where [End event] occurs).

N PR = Duration of an event Trace information is extracted over the cycles
corresponding to occurrence of the specified event.
P Duration of an event Trace information is extracted over the cycles
occurring in a corresponding to occurrence of the specified event within
subroutine the specified address range (subroutine or function).
1o Instruction accessing Information is extracted for instructions that access
specific data specified data.
Elimination B W[Ev]_ Between two events Trace information is eliminated from the cycle in which the

event set as [Start event] occurs to the cycle preceding the
event set as [End event] (information is not acquired for the
cycle where [End event] occurs).

N PR =T Duration of an event Trace information is eliminated over the cycles
corresponding to occurrence of the specified event.
L Duration of an event Trace information is eliminated over the cycles
occurring in a corresponding to occurrence of the specified event within
subroutine the specified address range (subroutine or function).

Select the desired condition from the list box that is displayed when you select Capture or Do not capture in the Record
condition group box of the Trace conditions dialog box.

Record condition:
Al % Capture; © Da not capture ¥ | step execution s recarded

I BBV _Ev]_ Between bwo events j Dk il |

Eventinuse ; 0

Figure 5.53 Record condition group box

Then click on the Detail button. The Event dialog box will appear.
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CAUTION

When you specify conditions for extraction or elimination, you cannot select DIS (disassembly mode) or SRC (source mode)

from Display Mode in the popup menu of the Trace window.

When you specify a data-access event as a condition for extraction or elimination, be sure to specify MCU bus as the access

type.

Condition |C|:u_|nt and Task ID I Camment I

Event bype IDaI:a access j

— Condition settings

—ACcess bype
i Mnemu:uniu: level |LomG j

[#] cPu
DTe

1 Address condition ISpemﬁed value (=]

Skart: E End: I I E

[

1 Data condition ISpeclﬁed walue (=)

Yaluel: I Yaluez: I
Mask.
(I' Eniabiled Masking walue: I FFFFFFFF

A

Read/write IRead,l'Write j

X

Help | Ik I

Cancel

Figure 5.54 Event dialog box
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5.9.7 Selecting the Type of Trace Information to be Acquired
Select the type of trace information to be stored in the trace memory. Make this selection on the Option page of the Trace

conditions dialog box.

M Trace condtions =101 x|

Trace E':'F'”mj

~Selecting the bype of brace information
' Event number

O TaskID

(" Extemal tigger

Evert used 0 Free 16 Detail,.. Reqistered events. .

save.. | Load.. | Hep | peply [ s |

p

Figure 5.55 Trace conditions dialog box

Select which signal you want to acquire from three choices available: Event number, Task ID or External trigger. By default,
Event number is selected.

CAUTION
If you want to view the history of tracing information on a realtime OS program, select Task ID.
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5.9.8 Viewing Trace Results

To check trace results, open the Trace window. Trace results can be shown in one of the following display modes: bus,
disassembly, source, or mixed. The display can be switched by changing the selection of Display Mode in the popup menu of
the Trace window.

(1) Bus Display Mode
In the popup menu, select Display Mode -> BUS. Bus information is displayed for all traced cycles (this is the default display
mode).
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Figure 5.56 Trace window

(2) Disassembly Display Mode
From the popup menu, choose Display Mode -> DIS. This mode shows a disassembly of the machine-language instructions
that have been executed.
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Figure 5.57 Trace window

R20UT0967EJ0402 Rev.4.02

Page 135 of 230
Sep.01.21 RENESAS




ROE420000MCUO00 User’s Manual 5. Debugging Functions

(3) Source Display Mode
From the popup menu, choose Display Mode -> SRC. This mode shows the flow of execution of the source program.
You can check the flow of execution by stepping forwards and backwards through the source code from the current trace cycle.
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Figure 5.58 Source mode screen

(4) Mixed Display Modes

Two or all of the basic modes can be selected at the same time, providing mixed displays of bus, disassembly, and source
information.

After choosing Display Mode -> BUS from the popup menu, select Display Mode -> DIS. This produces a mixed display of
bus and disassembly modes.

In the same way, you can produce mixed displays of bus—source, disassembly—source, or bus—disassembly—source.

To revert to bus mode after viewing a bus—disassembly mixed display, reselect Display Mode —> DIS from the popup menu.
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Figure 5.59 Trace window
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5.9.9 Filtering Trace Information

Use the filtering facility to extract only the records you need from the acquired trace information. This facility is achieved by
software filtering of the trace information that has been acquired by hardware.

Unlike “Capture/Do not Capture”, where the conditions must be set before getting the trace information, the filter settings can
be changed any number of times. This makes it easy to extract required information, significantly facilitating data analysis.
Filtering does not affect the trace memory, so that its contents remain intact.

Filtering is available when the selected trace mode is Fill until stop, Fill until full or Fill around TP and the selected display
mode is bus or disassembly.

(1) Auto-filtering
To use the filtering facility, choose Auto Filter from the popup menu of the Trace window. When Auto Filter is turned on, each

of the columns in the Trace window is marked with an auto-filter arrow [j].

By simply clicking on the arrows [j] and selecting desired conditions from the drop-down lists, you can filter the records to

get those that meet the conditions. Selecting Option in the drop-down list brings up the Option dialog box. In this dialog box,
you can set detailed conditions.

Items such as Address and Data do not have a manageably small fixed set of items, so the only entry in the drop-down list for
these columns is Option... Selecting All returns the window to the non-filtered state.
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Figure 5.60 Trace window

If you switch the display mode to disassembly or source after filtering records in bus mode, Auto Filter is deselected. Similarly,
if you switch the display mode to bus or source after filtering records in disassembly mode, Auto Filter is deselected.
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If you have specified multiple items in an Option dialog box, these items constitute an OR condition for use in filtering.
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Figure 5.61 Option dialog box
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5.9.10 Searching for Trace Records

You can search the acquired trace information for a specific trace record.

To search for trace records, use the Find dialog box. Open this by choosing Find -> Find from the popup menu of the Trace

window or clicking on the Find toolbar button |l

#h

] in the toolbar.
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Figure 5.62 Find dialog box

In the Combination column, select the checkboxes for the items of trace information for which you want to set up criteria.

The criteria that correspond to the currently selected items appears in the Find Item column. Select the required criteria.

If you have checked more than one item in the Combination column, set criteria for each of them. The items you have set are
used as an AND condition.

The criteria you have set are shown in Find Setting Contents.

After setting the criteria, click the Find Previous or Find Next button to start a search. Searching then proceeds forwards or
backwards through the trace records from the line you have clicked in the Trace window (the line highlighted in blue).

When a matching trace record is found, the corresponding line is highlighted in the Trace window. If no matching trace records
are found, a message dialog box is displayed.

When an instance of the trace record was successfully found, choose Find Previous or Find Next from the popup menu. This
initiates a search for the next instance of the trace record.
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(1) Search history

The search conditions that have been used are recorded in the History column and are retained throughout a session of the
High-performance Embedded Workshop.

If you want to perform a search again, choose the corresponding line from the history and click on the Add button to initiate a
new search for trace information with the same condition.

Up to the last 10 searches are retained in the search history.

(2) OR search

You can perform a search with two or more search conditions combined in an OR condition.

To set an OR condition, begin by setting the first condition (shown on the first line in the Find Setting Contents column) and
then click on the New button.

Then enter the second condition. At this time, the second condition is added as a second line in the Find Setting Contents
column.

In this case, the search is for lines satisfying the logical OR of the conditions on the first and second lines in the Find Setting
Contents column.

Up to 16 conditions (16 lines) can be set.

CAUTION
Conditions set on the same line of the Find Setting Contents column are treated as an AND condition.

5.9.11 Saving Trace Information in Files

Il . The

To save trace information in a file, choose File -> Save from the popup menu or click on the Save toolbar button [l

trace information displayed in the Trace window is saved in a binary or text format.

(1) Saving in the binary format

To save trace information in the binary format, choose “Trace Data File: Memory Image (*.rtt)” in the Save As Type list box
of the dialog box that is displayed when you choose File -> Save from the popup menu.

When information is saved in the binary format, information for all cycles is saved. This type of file can be loaded back into
the Trace window.

(2) Saving in the text format

To save trace information in the text format, choose “Text Files: Save Only (*.txt)” in the Save As Type list box of the dialog
box that is displayed when you choose File -> Save from the popup menu.

When information is saved in the text format, saving of information for a range of cycles can be specified. This type of file can
only be saved and cannot be loaded back into the Trace window.

R20UT0967EJ0402 Rev.4.02

Page 140 of 230
Sep.01.21 ENESAS



ROE420000MCUO00 User’s Manual 5. Debugging Functions

5.9.12 Loading Trace Information from Files

To load trace information from a file, choose File -> Load from the popup menu or click on the Load toolbar button |l = ].
Specify a trace information file that was saved in the binary format. The current results of tracing are overwritten.

Before loading a file saved in the binary format, switch to the trace mode in which the saved trace information was acquired.
This switching should be performed in the Trace conditions dialog box that is displayed when you choose Acquisition from the
popup menu of the Trace window.

If the current trace mode differs from that in which the saved information was acquired, an error occurs. Trace information
files saved in the text format cannot be loaded back into the Trace window.

5.9.13 Temporarily Stopping Trace Acquisition
To temporarily stop the acquisition of trace information during user program execution, choose Trace -> Stop from the popup

menu of the Trace window or click on the Stop toolbar button [l ].

Trace acquisition will be stopped, with the trace display updated. Use this function when you only want to stop acquisition and
check the trace information but not to stop program execution.

5.9.14 Restarting Trace Acquisition
If you want to restart trace acquisition after it has temporarily been stopped during user program execution, choose Trace ->

Restart from the popup menu of the Trace window or click on the Restart toolbar button |l v ].

5.9.15 Switching the Timestamp Display
The display of timestamps in the Trace window can be switched to absolute time, differential time or relative time. In the
initial state, the timestamps are displayed in absolute time.

(1) Absolute time

Choose Time -> Absolute Time from the popup menu or click on the Absolute Time toolbar button [ﬁ . The displayed

timestamps will be displayed in absolute time since the program started running.

(2) Differential time

Choose Time -> Differences from the popup menu or click on the Differences toolbar button [l ]. Each displayed timestamp

is the difference in time from the preceding cycle.

(3) Relative time

Choose Time -> Relative Time from the popup menu or click on the Relative Time toolbar button [a . The displayed

timestamps are times relative to the time of a specified cycle.

R20UT0967EJ0402 Rev.4.02

Page 141 of 230
Sep.01.21 ENESAS



ROE420000MCUO00 User’s Manual 5. Debugging Functions

5.9.16 Viewing the History of Function Execution
To view the history of function execution extracted from the acquired trace information, choose Function Execution History ->

i3}

Function Execution History from the popup menu or click on the Function Execution History toolbar button [i

An upper pane will be opened in the Trace window (the pane is blank by default).
When you choose Analyze Execution History from the popup menu or click on the Analyze Execution History toolbar button

[ e ], the emulator starts analyzing the history of execution history from the end of the results of tracing. The results of

analysis are displayed in a tree structure.

Teace E
myr|saxrz(p®@ =4 | aea |
E- _main (001044 <= 00043E =

= tutorial|)y (0010&X) <= 001059
T Sampples i Sawple ) (DI2D0]] <- Q010D J

fvdrnd (0012785 <- 003054
#_rand |DOL1AE} <= O010TE
fEedlred (001278 <- D005
eapd [DOL1AE) <- DO1DTE &l

Pange: DIOLETE, (00000 Fie: |Cyche: DO00HTE ckbess: O0L1BS [Tires: 000000068 (25 690

Addcen= Status | THDO bl
B ETi: 1
000 FEE4D0 0000 16  LONG WIRD F Q DATA 1 1 Q0000000 000
-00008744 FEEAOZ 0001 185  LONG WORD R 1} DATA - 1 1 QDACOCACaCon0onn - a0 00:00. =
=00000743 0011Ed 4106 1ék  GAORD E i} FETCH 1 1 Q00000000 0a00000 00 00:00,
-00008 742 0D11BA  AEEL  1&&  WORD 3 o FETCH - 1 1 0DICOCAC0Cononon - Q0 00 : 00
=00008741 O011RC SE00 18k  WORD E Ju] FETCH = 1 1 Qoo eanooan = 000000,
-00008744 OD1LEE 1516 1&&  WORD B o FETCH - 1 1 apaCdCaCacononon - a0: 0000 =

Figure 5.63 Trace window

The lower pane of the window shows results of tracing from the cycle in which the function selected in the upper pane was
called.
Results in the lower pane can be displayed in disassembly, source, or a mixed mode.

CAUTION
If extraction or elimination conditions are specified, the history of function execution cannot be displayed.
If the ‘repeat fill until stop’ or ‘repeat fill until full’ mode is selected, the history of function execution cannot be displayed.
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5.9.17 Viewing the History of Task Execution

The history of task execution can only be displayed when you are debugging a realtime OS program.

Furthermore, to view the history of task execution, you need to select Task ID on the Option page of the Trace conditions
dialog box that is displayed when you choose Acquisition from the popup menu of the Trace window.

To show the history of function execution extracted from the acquired trace information, choose Show Function Execution

History from the popup menu or click on the Show Function Execution History toolbar button |i e ].

The upper pane of the window will be opened (the pane is blank by default).

When you choose Analyze Execution History from the popup menu that is displayed when you right-click in the upper pane or
%

In the history of task execution, note that function calls from within tasks are not displayed in a tree structure. Only the order in
which the functions were executed is displayed.

click on the Analyze Execution History toolbar button | ], the emulator shows the history of task execution.
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Figure 5.64 Trace window

The lower pane of the window shows results of tracing from the cycle in which the task selected in the upper pane was called.
The lower pane of the window can show trace results in disassembly, source, or a mixed mode.

CAUTION
If extraction or elimination conditions are specified, the history of task execution cannot be displayed.
If the ‘repeat fill until stop’ or ‘repeat fill until full’ mode is selected, the history of task execution cannot be displayed.
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5.10 Measuring Performance

5.10.1 Measuring Performance

The performance measurement facility of the emulator is capable of measuring the maximum, minimum, average and total
execution times and the number of passes for each of up to eight specified sections of the user program, and shows ratios of
time relative to the overall execution time (Go—Break) as percentages and graphically.

Since this facility uses the emulator’s performance measurement circuit to measure the execution time, it does not impede
execution of the user program.

Performance measurement conditions cannot be manipulated during program execution.

5.10.2 Viewing the Results of Performance Measurement
Results of measurement are displayed in the Performance Analysis window.
To open the Performance Analysis window, choose Performance —> Performance Analysis from the View menu or

E]

click on the Performance Analysis toolbar button [==—1].
Performonce dnalzsin e 4
2% H | = H
Hnl_can.dltlnn__Run Cime (him:a.ma... C.. Staciabic  Max (him:a.m2.us. 0] |_mnih:m:s.m.ua.ns:l _avetageih:m:s.wa.ua.nsbl
1 Enable 00:00:01.254.556.150 5 ass [ 00:00:00.268,341.700 00:00:00,227.113.400 00:00:00.250,911.230
? Enable 00:00:01.982.471.9680 4 715 [ 00:00:00.514.026.900 00:00:00.472.936. 250 00:00:00.485.617.970
3 Enable 00:00:01.254.556.150 5 455N 00:00:00.268.311.700 00:00:00,227.113.400 00:00:00.250.911.230
4 Disable oz I
5 Dissble 0+ I
§ Disable o I
7 bisable o: I
§ Dissble o5 I

Figure 5.65 Performance Analysis window

The Performance Analysis window shows the ratios of execution time per condition you have set for the most recent execution
of the program as percentages and graphically.

Any unnecessary columns in this window can be hidden.

To hide any column, right-click in the header column and select the column you want to hide from the popup menu.

To view any hidden column, reselect that column from the popup menu again.
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The contents displayed in this window are listed below.

Table 5.23 Columns and contents

Column Description
No Numbers from 1-8 that are assigned to the measurement sections set up in the Performance
Analysis Conditions dialog box.
Click Settings on the popup menu to open the Performance Analysis Conditions dialog box.
Condition The entry is “Enable” when a measurement condition is set in the Performance Analysis
Conditions dialog box.
Otherwise, the entry is “Disable”.

Run time Cumulative execution time. This is the cumulative total of measured execution times.
(h:m:s.ms.us.ns)

Count Shows the number of times measurement for the section has proceeded.

Statistic Shows the ratio of the cumulative execution time relative to the Go—Break execution time.

[Ratio calculation formula]
(Cumulative execution time / Go—Break cumulative execution time) * 100

Max (h:m:s.ms.us.ns) Maximum execution time per measurement performed
Min (h:m:s.ms.us.ns) Minimum execution time per measurement performed
Average (h:m:s.ms.us.ns) Average execution time per measurement performed

5.10.3 Setting Performance Measurement Conditions
In the Performance Analysis window, select the line of a section number to use for the condition and choose Set from the
popup menu. The Performance Analysis Conditions dialog box will be displayed.

W Performance Anabysis Conditions - _Il:llil
1t 2] s ] ¢+ | s s | 7] 8|
Registered events, .,
Cundltinn:| Bebween bwo evenks j
~Detsils:
-~ Start event:[OR]
Event | T.] Descriptions | court | Taskip | cor | add.. |
FER 7 [addesslnotooooo 1 . Deleke |
Enable |
4] ] _bJ Disable
~End event:[OR]
Event | T.] Descriptions | coure | Taskio | con | add... |
FEEE 7 [addess] 00000-0... 1 - Deleke |
Enable |
1| | LI Disahle I
Evert used 2 Free 14 Debai!l...| Tirne unik: | 10ns -

SEVE, .. | Load... [ Help | Apaly | Close |

g

Figure 5.66 Performance Analysis Conditions dialog box
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(1) Setting measurement conditions

The measurement mode can be selected from among the four choices listed in Table 5.24. Select one measurement mode for
one section. Use events to specify the beginning and end of a section. The value of Count is fixed to 1. The event count is

always 1, even if you have attempted to specify some other value.

Table 5.24 Measurement modes

IEN | [Disabled]

Measurement is disabled.

WEV] _Ev]_ | [Between two events]

—Start event:[OR]

Event | T.) Descriptions | count | TaskiD | cor | Add. .. I
F [Address]notooooo 1 - peiste |
Enatle |
d\ | _PI Disable |
—End event:[OR]
Event | T.) Descriptions | count | Taskio | can | Add. .. I
MR F [address]ooooo- 0., 1 - Delete

Enable

1] | _PI Disable

L

Figure 5.67 Between two events

Measurement is performed between the start event and the end event.
Specifically, the time execution takes and number of passes through the
range between the start event and the end event are measured. The
measurement of time starts when the start event occurs and is suspended
when the end event occurs. The number of passes through the section is
incremented by one each time the pair of the start event and end event for the
specified range occur.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

[Period of an event]

Event:

Event | T.I Descripkions | Counkt | TaskID | Con | Add,.,
FREN F  [Address]oooot -F... 1 - Dolte
4] | i

Figure 5.68 Period of an event

Measurement is performed during the event.

Namely, the period between occurrences of the event the number of times it
occurs are measured. The time from one occurrence of the event to the next
is measured as one instance. The number of times is incremented by one
each time the event occurs.

Event: Only one event point can be set.
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Table 5.25 Measurement modes (continued)

[Evg [Interrupt-disabled range between two events]
—Skark event:[OR]
Event | T.] Descriptions | ca... | Ta.. | comm | add... I
S0 - [address] outside ... 1 - Deleke

Enable

1] | _FI Disakle

End event:[OR]
Ewent I T.I Descriptions | Co... | Ta... | Zarnrm
2Nl F  [Address] 00000 -F.., 1 - Delete

A

Enable

1] | _PI Disakle

e |
e |

Figure 5.69 Interrupt-disabled range between two events

Measurement is of ranges over which interrupts are disabled from the start
event to the end event.

Specifically, the intervals over which interrupts are disabled and number of
times interrupts are disabled within the range specified by Start event and
End event are measured. The measurement of time starts when interrupts are
disabled and is suspended when interrupts are re-enabled. The number of
times is incremented by one each time interrupts are disabled.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

[CAUTION]

To measure the execution time of a function (maximum, minimum or average execution time of a function), use Between two
events.

Specify fetching from the first address of the function as the start event and fetching from the exit point of the function (point
corresponding to the line containing the function’s return statement) as the end event. If there is more than one exit point, set a
fetch condition that covers each of them as the end event.

(2) Selecting the unit of measurement

This setting applies in common to all 8 sections. The following units of measurement are available:
10 ns (default), 20 ns, 40 ns, 80 ns, 160 ns, 1.6 ps
The maximum measurement time varies with the unit of measurement you set.

5.10.4 Starting Performance Measurement

When the user program is run, performance measurement is automatically started according to the conditions set on
performance measurement.

When the user program is halted, the results of measurement are displayed in the Performance Analysis window.

When execution of the user program is halted and then restarted without changing the conditions of measurement, the newly
measured times are added to the previous values.

To perform the measurements afresh, clear the results of measurement before running the program.
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5.10.5 Clearing Performance Measurement Conditions

Select the measurement condition you want to clear in the Performance Analysis window and then choose Set from the popup
menu to display the Performance Analysis Conditions dialog box. In the Performance Analysis Conditions dialog box, disable
the condition you want to clear.

1 | 2 | = 4+ | s | & | 7| 8 |
Reqistered events. .. |

T [

|—Detalls: |

Condition: (disabled)

Figure 5.70 Performance Analysis Conditions dialog box

5.10.6 Clearing Results of Performance Measurement

In the Performance Analysis window, select the section corresponding to the results you want to clear and then choose Clear
Data from the popup menu. The results of measurement for the selected section will be cleared. To clear all results of
measurement, choose Clear All Data from the popup menu.

5.10.7 Maximum Time of Performance Measurement
(1) Maximum measurement time

The timer used for performance measurement is comprised of a 40-bit counter.

The maximum measurement time varies with selected unit of measurement.

To select the unit of measurement, use the Time unit list box of the Performance Analysis Conditions dialog box.
The maximum measurable times for the respective units are listed in the table below.

Table 5.26 Maximum measurable times

Resolution Maximum measurable time
10 ns Approx. 3 hours, 03 minutes, 15 seconds
20 ns Approx. 6 hours, 06 minutes, 30 seconds
40 ns Approx. 12 hours, 13 minutes, 00 seconds
80 ns Approx. 24 hours, 26 minutes, 00 seconds
160 ns Approx. 48 hours, 52 minutes, 01 seconds
1.6 s Approx. 488 hours, 40 minutes, 18 seconds

CAUTION

Note that results of performance measurement carry an error equal to +1 times the resolution (e.g. +20 ns when the resolution
is 20 ns).

(2) Maximum measured number of passes

Numbers of passes through sections are measured by a 32-bit counter. Measuring up to 4,294,967,295 passes is thus possible.
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5.11 Measuring Code Coverage

5.11.1 Measuring Code Coverage

Code coverage refers to measures of the condition of a program in terms of ‘digestion’ by tests, i.e., the degree of thoroughness
of tests of the software code (and the paths within it).

Information on instruction execution is displayed for the C/C++ and assembly-language levels.

This function collects information on instruction execution without causing execution of the program to break. Therefore,
measuring code coverage does not affect the realtime characteristic of user-program execution.

The results of coverage are updated when a break is encountered.

The E100 emulator supports CO (instruction) coverage.

Table 5.27 Code coverage definition
CO: Instruction coverage | All statements within the code are executed at least once.

The E100 emulator comes with up to 2 Mbytes of code-coverage memory for CO level coverage.
With the initial settings, code-coverage memory is automatically allocated to addresses in the ROM area.

5.11.2 Opening the Code Coverage Window

Choose Code -> Code Coverage from the View menu or click on the Code Coverage toolbar button [l

The Code Coverage window is initially empty.
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Code Coverage

o | 64 =t % X | 8

Addresz Range |£‘-El Coverage |

Executed | Address | Assembler | Source

4 I PI"MdI‘ISS Range ;'iiqu';;\q f

Figure 5.71 Code Coverage window

(1) Measurement method

The Code Coverage window has two sheets.

Table 5.28 Sheets of the Code Coverage window

Sheet

Description

Address Range Measurement is performed on any address range.

Source Measurement is performed on a specified source file

The respective sheets permit registration of multiple ranges.

Up to two instances of the Code Coverage window can be open at the same time.

5.11.3 Allocating Code Coverage Memory (Hardware Resource)

(1) Memory allocation

Before code coverage can be measured, code-coverage memory must be assigned to the target address range. Coverage data
can only be obtained from an address range to which memory has been allocated.

To allocate code coverage memory, use the Allocation of Code Coverage Memory dialog box.

To open this dialog box, select [Hardware Settings...] from the popup menu of the Code Coverage window.
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Allocation of Code Coverage Memory ﬂ
Allozation of Coverage kemaony:
Address | Block | Add..
Q0000 - 1FFFF 1
EQO00Q - FFFFF 2
Clear
Al Clear
Default
Help k. Cancel

Figure 5.72 Allocation of Code Coverage Memory dialog box

You can specify a number of blocks from 1 to 8 (for a total of up to 2 Mbytes) each beginning on a 256-Kbyte boundary as
areas for code coverage measurement.
The blocks may be contiguous or hon-contiguous.
With the initial settings, the coverage memory is automatically allocated to addresses in the ROM areas.

noooon

040000

07FFFF

240000

27FFFF

Faooon

FCooon

FFFFFF

Area where coverage can
bhe measured

Area where coverage can
bhe measured

Area where coverage can
bhe measured

Area where coverage can
be measured

Figure 5.73 Schematic view of coverage memory allocation
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(2) Changing memory allocation

When the allocation of coverage memory is changed, the coverage data acquired from the target address ranges prior to the
change is retrieved from coverage memory into a dedicated coverage buffer.

Buffer for
COVerage

nagnoo

040000

07FFFF

Area where coverage can
be measured

(Z) Data acguisition

240000

1"llllllllllllllllll

Area where coverage can
be measured

27FFFF

Faoooo

FCoooo

Area where coverage can
be measured

FFFFFF

Area where coverage can
be measured

Figure 5.74 Schematic view of a change in coverage memory allocation

(1) Allocation change

Acquired coverage information is accumulated in the coverage buffer until it is cleared by the user. However, coverage
information is not updated for areas to which coverage memory is not allocated.
The coverage information shown in the Code Coverage window includes the information from the contents of the coverage

buffer.
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5.11.4 Code Coverage in an Address Range
The Address Range sheet shows the code-coverage information (CO coverage) acquired by the emulator from a user-specified

address range.

Multiple address ranges can be registered.
An address range larger than 2 Mbytes or even an area to which no coverage memory has been allocated can be specified.
However, when coverage memory has not been allocated to an area, coverage information on that area is not updated.

Avreas for which coverage information is not updated are grayed-out.
An example display is shown below.

#|
Address Range |£‘-El Coverage |
001036 = 00Z050 15. 24%.
DOZ0S0 - ODZOEC 85, DD%__
Executed | Address IA;sseran.er | Source I ,,‘:,l
1 001076  SUB.W ... for( i=0; i<l0; d... —
1 01078 CHMP.T0 ...
1 0o107e BGE .
1 DD107E J3E So0 9 = rand();
1 opi10sz EXTS.L...
1 oo1084 MOV.L ...
1 oo108& MOV.L ... if(3 < 0 ¢
1 001038 BGE .
_ 001084  HEG.L ... 4= -4;
00108C  MOV.L ... alil = 5; -]

4 I h]".l.ﬂddrl:: Range ;';.S'Ul.lﬂ f‘

Figure 5.75 Code Coverage window (address specification)

The Code Coverage window is vertically divided in two by the splitter.

The upper pane shows the address ranges to be measured, and the degree of CO coverage.

Table 5.29 Contents of the upper pane of the Code Coverage window

[Address Range]

Address range for which coverage is measured

[CO Coverage]

CO0 coverage as a percentage and graph

The lower pane shows a detailed (assembly-language level) view of the address range selected in the upper pane.

Table 5.30 Contents of the lower pane of the Code Coverage window

[Executed] 1: The instruction was executed.

0: The instruction was not executed.
[Address] Address of the instruction
[Assembler] Disassembled program
[Source] C/C++ or assembly source program
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The acquired coverage information is accumulated in memory until the user clears it.

Acquired coverage information is accumulated in memory until it is cleared by the user.

When you double click on an assembler instruction in the Address Range sheet, the corresponding source code is shown in the
Editor window.

Be aware that the source code will not be displayed in the cases listed below.

- Asource file that corresponds to the assembler line does not exist.

- No source line corresponds to the assembler line.

- Where no debugging information was included, such as when the assembler line is for a library.

5.11.5 Code Coverage in a Source File

The Source sheet shows the code-coverage information (CO coverage) acquired by the emulator from a user-specified source
file.

Multiple source files can be registered.

A source file larger than 2 Mbytes or even an area to which no coverage memory has been allocated can be specified.
However, when coverage memory has not been allocated for a portion of the code, coverage information on that area is not
updated.

Address lines where coverage information is not updated are grayed-out.

An example display is shown below.

£
o | MWt X i i
File I Function I cl Coverage |
sort.cpp Sample: :Sample () 1oo.oos

sort.opp Sample: :=sort(long *) oo, 0z [
gort.cpp Sample: :change (long *) 55,32+

Executed | Address | Assenbler | Source I Al
1 00Z19E SUB.W ... for {i=0; i<10; i++) |
1 00z1a0 CHME.T ...
1 00Z1a4 BGE ...
002146  MOV.L ... ali] = twp[9 ...

002 148 MOV.W ...
00Z1an EXTS.L.. s

.4 | Pr" Addrez: Range hSll.rﬂI"l

Figure 5.76 Code Coverage window (source file specification):

The Code Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges to be measured (file and function names) and CO coverage.

Table 5.31 Contents shown in the upper pane of the Code Coverage window

[File] File name
[Function] Function name
[CO Coverage] CO0 coverage as a percentage and graph
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The lower pane shows a detailed (assembly-language level) view of the address range selected in the upper pane.

Table 5.32 Contents of the lower pane of the Code Coverage window

[Executed] 1: The instruction was executed.

0: The instruction was not executed.
[Address] Address of the instruction
[Assembler] Disassembled program
[Source] C/C++ or assembly source program

The acquired coverage information is accumulated in memory until it is cleared by the user.

5.11.6 Showing Percentages and Graphs
After the program has stopped, right-click in the upper pane of the Code Coverage window and choose Percentage from the
popup menu. The emulator will start calculating CO (instruction) coverage for each address range.

When the calculation is completed, coverage information is displayed in the upper pane as percentages and graphs.

|
o | M|t X i
Addresz Fange |¢EI Coverage |
001036 = 00ZO050
002050 - D0ZOEC SR aOs
Percentage Auto Caloulate
fdd Range...
EdE Range...
[elate Range
Code Coverage IR |
% | M =Wt < my i
Address Range ICEI Coversge I
15, 24:
o0zos0 - oozoee  £5.00: Y

Figure 5.77 Percentages Shown in the Code Coverage window

If you have selected [Percentage Auto Calculate] in the popup menu, the emulator calculates the CO coverage of the
selected address ranges and displays the result every time there is a break in user program execution.
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CAUTION

While [Percentage Auto Calculate] is active, stepping may take more time because the emulator calculates the coverage every
time there is a break in user program execution. The larger the areas specified for coverage measurement, the longer the
calculation of percentages takes. In cases where the speed of debugging must be given priority, deselect [Percentage Auto
Calculate].

5.11.7 Sorting Coverage Data
Clicking on a header column in the upper pane of the Code Coverage window allows the coverage data to be sorted.
(1) Clicking on the File column

The data can be sorted by file name. Lines for the same file are sorted by function name.
Example:

File Function  CO Coverage

filel.cpp funcl  40% mmmm
filel.cpp func2 10% m

filel.cpp func3  80% mmmmmmmm
filel.cpp funcd  70% memmmmm
file2.cpp funcl  20% mm

file2.cpp func2 60% umEmEE
file2.cpp func3  90% EmEEEEEEE
file3.cpp funcl 0%

file3.cpp func2  30% mmm
file3.cpp func3 10% m

(2) Clicking on the CO Coverage column

The data can be sorted by coverage rate.

Clicking on the column once sorts the values into descending order. Clicking on the column a second time sorts the values into
ascending order.

Example:

File Function  CO Coverage

file2.cpp func3  90% wemEEEEEm
filel.cpp func3  80% wemmmEEm
filel.cpp func4  70% mmmmmmm
file2.cpp func2  60% mEmmEmm
filel.cpp funcl  40% mmmm
file3.cpp func2  30% mmm
file2.cpp funcl  20% mm

filel.cpp func2 10% m

file3.cpp func3 10% m

file3.cpp funcl 0%
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(3) Clicking on the CO Coverage and File columns, in that order

The data for each file is sorted by coverage rate in descending order.
Example:
File Function  CO Coverage

filel.cpp func3  80% mwmmEmmmm
filel.cpp func4  70% mmmmmmm
filel.cpp funcl  40% mmmm
filel.cpp func2 10% m

file2.cpp func3  90% EmEEEEEEE
file2.cpp func2  60% Emmmmm
file2.cpp funcl  20% mm

file3.cpp func2  30% mmm
file3.cpp func3  10% m

file3.cpp funcl 0%

5.11.8 Searching for Nonexecuted Lines

Search for nonexecuted lines in a selected address range or function. When you click on the Find toolbar button [l

Find dialog box shown below appears.

nd 2|
Cancel |

Find /hat:

Figure 5.78 Find dialog box

The following three search options are available.

Table 5.33 Search options

Unexecuted Line | Instructions not executed yet

il
Clicking on the Find Next button [i H ] starts a search.

When a matching instruction is found, the corresponding line is highlighted.

When no matching instructions are found, a message is displayed.

.

], the
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5.11.9 Clearing Code Coverage Information
(1) Clearing the code coverage information for a specified range

Selecting Clear Coverage Range from the popup menu opens the Clear Address Range dialog box.

Clear Address Range ilil

Start Address: IEIEIEEI?E j
End Address: [DDCTTE =] Cancel |

Figure 5.79 Clear Address Range dialog box

Enter the addresses where the range to be cleared starts and ends. Clicking on the OK button then clears the coverage
information for the selected range.

(2) Clearing all of the code coverage information

Selecting Clear the Entire Coverage from the popup menu clears all of the code coverage information.

5.11.10 Updating Coverage Information

Selecting Refresh from the popup menu updates the contents of the Code Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when program execution breaks. To view the
latest information, therefore, you must manually select updating.

5.11.11 Preventing Updates to Coverage Information
Selecting Lock Refresh from the popup menu prevents updates to the Code Coverage window while the execution of the user
program is stopped.
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5.11.12 Saving the Code Coverage Information in a File
You can save the code coverage information for the currently selected sheet in a file.
Selecting Save Data from the popup menu opens the Save Coverage Data dialog box.

werage Data - Address Ranges llﬁl
File: name: ]

I Ll Browse, .. | Cancel |

¥ Always save to this file when saving the session

Figure 5.80 Save Coverage Data dialog box

Enter the name of the file where you want the information to be saved.
If the file-name extension is omitted, “.cov” will automatically be appended as the extension.
If you specify an existing file name, that file will be overwritten.

5.11.13 Loading Code Coverage Information from a File
You can load code-coverage information files.
Selecting Load Data from the popup menu opens the Load Coverage Data dialog box.

Load Coverage Data

Load Mods | File Mame | Diffzet | o

X

Bemowe

fowe

i !

td mwee o

[T Clear coverage RAM before loading

[ &lways load these files when loading the seszion

k. Cancel |

Figure 5.81 Load Coverage Data dialog box
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Clicking on the Add button opens the Add Coverage Files dialog box shown below.

Add Coverage Files e e
File Mame:
I | 3 | Browse,.. |
Offzet;
| 0000000
Coverage Data Load Mode
’75' Ovenurite i Merge
0K LCancel |

Figure 5.82 Add Coverage Files dialog box

Use this dialog box to specify the coverage information file you want to load. You can also specify a mode of loading and
offset for each file you load.

The only file-name extension allowed is “.cov”. An error message will appear if any other extension is entered.
The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are
listed. If necessary, use the Move Up or Move Down button to change the order.

CAUTION
If the coverage information file you’re loading is of the source-file type, you cannot specify an offset.

5.11.14 Modes of Loading for Coverage Information Files
Two modes of loading are available for coverage information files. They are schematically depicted below.

(1) When “Overwrite” has been selected

COvVErage Memory
[Before loading]  [After loading)

Coverage file

O 2000 O 2000 O 2000
-] The coverage memory is overnritten with
1] the data of the loaded coverage file.
Ox2FFF Ox2FFF Ox2FFF

Figure 5.83 Schematic view of the overwrite mode
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(2) When “Merge” has been selected

Coverage memory
[Before loading]  [After loading]

Coverage file
02000 02000 02000 1y Existing data is read.
*'1{” """"" 23 The data ofthe coverage file is
." merged with the existing data.
0x2FFF 0x2FFF x2FFF
i : (3 The merged data is written to
the coverage mermory.
2 ¥
......... >
(3]

Figure 5.84 Schematic of the merge mode

(3) Example of application of the merge mode

Coverage memory

Test & Test B Test C [after loading in the merge moade)
COvVErage  COvVEraQe  COVErage
file file file
:. ........ [Examme]
e Az the result of test
oo A B, and C, the CO
coverage is 79%.

Figure 5.85 Schematic view of a merge-mode application

[Procedure]

(1) Open the Load Coverage Data dialog box.
To begin with, select the “Clear coverage RAM before loading” checkbox.
(2) In the merge mode, add the coverage file for test A.
(3) In the merge mode, add the coverage file for test B.
(4) In the merge mode, add the coverage file for test C.
(5) Click on the OK button.

You have now finished merging three files.
By re-calculating the percentages in the Code Coverage window, you can view the coverage (as percentages) of the tests as a
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whole.
Furthermore, you can save the merged data in a single file and manage the data accordingly.

5.11.15 Displaying Code Coverage Information in the Editor Window

When the Editor window is open in the source mode, the results of coverage are displayed in the Code Coverage column.

Rows of the Code Coverage column that correspond to source lines where the instructions have been executed are highlighted.
If the user changes any setting related to coverage information in the Code Coverage window, the contents of the
corresponding Code Coverage column will also be updated.

i Tutorial.c ;lglﬂ
= &8
Line Sour.. | Event | C.| 5. Source |

21 roid tutorial (void) ZI

22 |FB2ZD2 i

23 long a[10] :

24 long j:

25 int ir

26 Struct Sample far *p Sam;

27

28 |FaZDkb p_Sawm= malloc(sizecf(struct Sample)):

29 |FEZEQ init (p sSam):

30

31 [FE2ZFE for( i=0; i<10; i4++ )4

32 [FE300 j = randi():

33 [FE30cC if{j < 014

34 |FE311 N i = -j:

35 B

36 [FE31h ali]l] = 3: b

37 B

3g |Fa330 Sortial:

39 |Fa337 change (a)

40

41 |FE833E b Sam->=0=a[0] :

42 |F234E b _Sam->=1=a[1]: -
1| | v

Figure 5.86 Example of code coverage results
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5.12 Measuring Data Coverage

5.12.1 Measuring Data Coverage

The code coverage, data coverage and realtime profiling functions of the E100 emulator are mutually exclusive.

To use the data coverage function, choose Data coverage in the Switching function section on the System page of the
Configuration properties dialog box.

Data coverage indicates the kinds of access to data areas. The emulator is capable of acquiring information on access per byte
without causing program execution to break. Therefore, the realtime characteristic of user-program execution will not be
affected.

The coverage results are updated upon a break.

The E100 emulator comes with 512 Kbytes of data coverage memory.
With the initial settings, the data coverage memory is automatically allocated to addresses in the ROM and Data Flash areas.

5.12.2 Opening the Data Coverage Window

Choose Code -> Data Coverage from the View menu or click on the Data Coverage toolbar button [l

The Data Coverage window is initially empty.

DataCoverage ﬁ;
o | B [ | =t W X \

Range I Access Rate |

Address | Label I Area I Data

mﬁddress Range .f{. Section h Tazk Stack f

Figure 5.87 Data Coverage window
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(1) Measurement method

The Data Coverage window has three sheets.

Table 5.34 Sheets of the Data Coverage window

Sheet Description
Address Range Measurement is performed on any address range.
Section Measurement is performed on a specified section.
Task Stack Measurement is performed for all task stack areas.

The respective sheets permit multiple ranges to be registered.
The Task Stack sheet only supports automatic registration.
Up to three instances of the Data Coverage window can be opened at the same time.

5.12.3 Allocating Data Coverage Memory (Hardware Resource)
(1) Memory allocation

Before data coverage can be measured, data-coverage memory must be assigned to the target address range. Coverage data can
only be obtained from an address range to which memory has been allocated.

To allocate data coverage memory, use the Allocation of Data Coverage Memory dialog box. To open this dialog box, select
[Hardware Settings...] from the popup menu of the Data Coverage window.

Allocation of Data Coverage Memory x|

Allocation of Coverage Memone

Address | Block | Add, .. |
0o0oa - OFFFF 1
10000 - 1FFFF 2
EOQQDO - EFFFF 3 Clear |
FOO00 - FFFFF 4
Al Clear |
Drefadt |

Hep | ok ]| cancel |

Figure 5.88 Allocation of Data Coverage Memory dialog box

You can specify any number of blocks from 1 to 8 (for a total of up to 512 Kbytes), each beginning on a 64-Kbyte boundary,
as areas for data-coverage measurement.

The blocks may be contiguous or non-contiguous.

With the initial settings, the coverage memory is automatically allocated to addresses in the RAM and Data Flash areas.
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noooon

010000

01FFFF

240000

24FFFF

FEOOOD

FFOOOD

FFFFFF

Area where coverage can
he measured

Area where coverage can
he measured

Area where coverage can
he measured

Area where coverage can
be measured

Figure 5.89 Schematic view of data coverage memory allocation

(2) Changing memory allocation

When the allocation of coverage memory is changed, the coverage data acquired from the target address ranges prior to the
change is retrieved from coverage memory into a dedicated coverage buffer.

Buffer for
coverage

noooon

010000

01FFFF

Area where coveraige can
be measured

(2) Data acquisition

240000

—

Area where coverage can
be measured

24FFFF

FEQOOD

Area where coverage can
be measured

FFOOO0

FFFFFF

Area where coverage can
be measured

(1) Allocation change

Figure 5.90 Schematic view of a change in data coverage memory allocation

Acquired coverage information is accumulated in the coverage buffer until it is cleared by the user. However, coverage
information is not updated for areas to which coverage memory is not allocated.
The coverage information shown in the Data Coverage window includes the information from the contents of the coverage

buffer.
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5.12.4 Data Coverage in an Address Range
The E100 emulator is capable of collecting the access information for a user-specified address range and of displaying the
information.

|
% | %M | =W i |

Fange |Access Fate |
FFDFE0 - FFDFFF 1z.50%

Address | Lahbel I Area I Data | :I
FFDFE4 RAM Zc 41 d4 51

FFDFES RAM 76 51 15 1d

FFDFEC RAM 47 kd 54 07

FFDFFO RAT

FFDFF4 RAT

FFLFFG RAT]

5L

mnddress Range ;{. Section h Tazh Stack j‘

Figure 5.91 Data Coverage window (address specification)

The Data Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges to be measured and access rates.

Table 5.35 Contents of the upper pane of the Data Coverage window
[Range] Address range for which coverage is measured
[Access Rate] Access rate as a percentage and graph

The lower pane shows a detailed view of the address range selected in the upper pane.

Table 5.36 Contents shown in the lower pane of the Data Coverage window

[Address] Address value

[Label] Label name

[Area] Memory area (RAM, Data Flash, 10, or Flash ROM).
This column is blank when the area is unused.

[Data] Memory data.
Data that have been accessed are displayed against a purple
background.

Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.
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5.12.5 Data Coverage in Sections
The E100 emulator is capable of collecting the access information for a user-specified section and of displaying the
information.

=
% | %M | =W i |
Section |Access Rate I
FFFFOO - FFFFYF (3 0.00%

FFFDSA - FFFDAS (R} 1oo0. oo
FFFDE0 - FFFDE9 (E) 1oo. oo

Address | Lahel I Area I Data
FFFDE0  ad  RAM

FFFDE4

FFFDEA

L I hl'-. &ddress Range hSettinn lf'-r.. Tazh Stack j‘

Figure 5.92 Data Coverage window (section name specification)

The Data Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges (section names) to be measured and access rates.

Table 5.37 Contents of the upper pane of the Data Coverage window
[Section] Address range (section) for which coverage is measured
[Access Rate] Access rate as a percentage and graph

The lower pane shows a detailed view of the address range selected in the upper pane.

Table 5.38 Contents of the lower pane of the Data Coverage window

[Address] Address value

[Label] Label name

[Area] Memory area (RAM, Data Flash, 10, or Flash ROM).
This column is blank when the area is unused.

[Data] Memory data.
Data that have been accessed are displayed against a purple
background.

Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.
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5.12.6 Data Coverage in the Task Stack
The E100 emulator is capable of collecting the access information for the task stacks and of displaying the information.
The task stack is automatically registered when a load module that includes an OS has been downloaded.

You cannot add, remove or change any task.
If tasks are changed pursuant to alterations of the user program, for example, the window is automatically updated.

Data Coverage =

op | N8 | =t % X

Tazk

| Aocesz Rate |

Address | Label I Area I Data

L I hl'-. &ddress Range }1. Section hTask Stack l{'

Figure 5.93 Data Coverage window (task stack specification)

The Data Coverage window is

vertically divided in two by the splitter.

The upper pane shows the automatically registered task stacks and access rates.

Table 5.39 Contents of the up

er pane of the Data Coverage window

[Task]

Task stack (task ID and task entry label)

[Access Rate]

Access rate as a percentage and graph

The lower pane shows a detailed view of the task stack selected in the upper pane.

Table 5.40 Contents of the lower pane of the Data Coverage window

[Address] Address value

[Label] Label name

[Area] Memory area (RAM, Data Flash, 10, or Flash ROM).
This column is blank when the area is unused.

[Data] Memory data.
Data that have been accessed are displayed against a purple
background.
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Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.

5.12.7 Clearing Data Coverage Information
(1) Clearing the data coverage information for a specified range

Selecting Clear Coverage Range from the popup menu on the Address Range or Section sheet opens the Clear Coverage Range
dialog box.

2
Start Addrezs; IDDDE24 j
End &ddress: IE":” 287 j Carcel |

Figure 5.94 Clear Coverage Range dialog box

Enter the addresses where the range to be cleared starts and ends. Clicking on the OK button then clears the coverage
information for the selected range.

(2) Clearing all of the data coverage information

Selecting Clear the Entire Coverage from the popup menu clears all of the data coverage information.

5.12.8 Updating Coverage Information

Selecting Refresh from the popup menu updates the content of the Data Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when program execution breaks. To view the
latest information, therefore, you must manually select updating.

5.12.9 Preventing Updates to Coverage Information
Selecting Lock Refresh from the popup menu prevents updates to the Data Coverage window while the execution of the user
program is stopped.
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5.12.10 Saving the Data Coverage Information in a File

You can save the data coverage information for the currently selected sheet in a file.

Selecting Save Data from the popup menu opens the Save Data dialog box.

Save Data - Seckions 7] x|

OF.

File M ame:

I Ll Emwse...l Cancel |

¥ Always save to this file when saving the session

Figure 5.95 Save Data dialog box

Enter the name of the file where you want the information to be saved. If the file-name extension is omitted, “.cdv” will

automatically be appended as the extension. If you specify an existing file name, that file is overwritten.

5.12.11 Loading Data Coverage Information from a File
You can load data-coverage information files.

Selecting Load Data from the popup menu opens the Load Coverage Data dialog box.

2

[T Clear coverage FAM befare loading

(] Cancel |

Load Mode | File Name | Offset | Add..
Overwrite  ${CONFIGDIR] 000000000
Merge $w/DRKSPNAME] 000000000
Merge ${CONFIGNAME] 000000000 Remove
Move Up
Move Down

Figure 5.96 Load Coverage Data dialog box
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Clicking on the Add button opens the Add coverage data file dialog box shown below.

21x]
File Marme;
I | 2 | Browsze. .. |
Offzet:
|nxunnnun
Coverage Data Load Mode
’Vﬁ' Owenwrite = Merge
oK _ Caneel |

Figure 5.97 Add coverage data file dialog box

Use this dialog box to specify the coverage information file you want to load. You can also specify a mode of loading and
offset for each file you load.

The only file-name extension allowed is ".cdv". An error message will appear if any other extension is entered.

The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are
listed. If necessary, use the Move Up or Move Down button to change the order.
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5.13 Viewing Realtime Profile Information

5.13.1 Viewing Realtime Profile Information

The code coverage, data coverage and realtime profiling functions of the E100 emulator are mutually exclusive.

To use the realtime profiling function, choose Real-time profile in the Switching function section on the System page of the
Configuration properties dialog box.

Realtime profiling refers to the measurement of performance per function or task within an area allocated as a range for
profiling. Realtime profiling will help you find where and how deterioration in the performance of application programs arises.
The process of measurement does not interfere with execution of the user program.

The results of measurement are updated when execution of the program breaks.

(1) Function profiles

Performance of individual functions can be measured.

For a function, the Realtime Profile window shows its name, the address where it starts, its size, the number of calls,
cumulative execution time, the ratio of this to the overall execution time, and the average execution time.

In function profiling by the E100 emulator, execution times for subroutines are not included in the indicated cumulative
execution time.

CAUTION
A function profile is subject to the following limitations:

(a) Areas to be measured

The E100 emulator can acquire profile information on all functions in up to 8 blocks, with each block a 128-Kbyte unit.

The blocks can be contiguous or non-contiguous.

Functions located beyond the boundaries of the blocks are not specifiable. In such cases, the entries for the functions (or tasks)
are grayed-out.

(b) Limit on the number of functions

Measurement of up to 8K — 1 (= 8,191) functions is possible.

A limit of 8K — 1 (= 8,191) applies to the number of functions within the above scope of measurement. Measurement will not
be performed for the functions beyond this limit. In such cases, the names, addresses, and sizes of the excess functions are
grayed-out.

(c) In-line expansion

The functions that have been written for in-line expansion (optimization by the compiler) are not displayed in the Realtime
Profile window.

(d) Recursive functions

Although the execution times of recursive functions can be measured correctly, they are only executed once.
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(e) Relationship between the address where Go was executed and the address of a break within a measurement range, and the
measurable range

i Execution =tart from function g
g
/1(){
k(3
gl
Ry
ki
1 1 1 h

Range that can be measured

Figure 5.98 Measurable range

The measurable range will be as follows.

When execution of the program breaks at the location of a black dot [e]: Execution time and number of passes for functions h
and k

When execution of the program breaks at the location of a red dot [e]: Execution time and number of passes for functions h
and k

When execution of the program breaks at the location of a blue dot [e]: Execution time and number of passes for functions h
and k

For the function g, the number of passes and time for the executed portion can be measured.

Even after execution has returned to a function higher in the hierarchy of calls, the number of calls cannot be measured for a
function from which execution of the program started.

() Function measurement
Accurate measurement requires that execution of the function remained in progress for at least 100 ns. If this is not the case,
the execution time and number of passes may be incorrect.

(9) Debugging information option

To get the execution time and number of passes for a function, you need to specify the option to output debugging information
for the source file or library that includes the function at the time of compilation. If this option has not been specified,
measurement of the execution time and number of passes for a function will not be possible.

(h) Maximum and minimum execution time
You cannot use the realtime profiling function to measure the maximum and minimum execution times for a function. To
measure the maximum and minimum execution times for a function, use the Performance Analysis window.
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(2) Task profile

Performance of individual tasks can be measured.
For a task, the Realtime Profile window shows its ID, the number of passes, cumulative execution time, the ratio of this to the
overall execution time, and the average execution time.

5.13.2 Selecting a Realtime Profile Measurement Mode

Choose Set Range from the popup menu that is displayed when you right-click in the window.

The Realtime Profile Setting dialog box will be displayed. In the Realtime Profile Mode list box of this dialog box, you can
select “Function Profile” or “Task Profile.”

When the profile mode is changed, all results of measurement are cleared.
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5.13.3 Measuring Function Profiles

The Function Profile mode allows measurement of performance per function.

S HE H#H

El

Bln:n:kl Functiomn

I Average [hiwia.m2.u2.03) |ﬂ

_ =hork_execution
Sammple: s Japle ()
Sample: tsort [long *]
Sample: ichange (Llong *|

[

alrendy_marked F...
record needed de...
=td__needed dest...

|.=u:i-:lrr-_'ss ]S.Lse | l:.'-nuntITJ.rr-e [him:a.ma.u=,.n=] | Statiatic

OO15EE
001572
001540
OO15ED
DozE000
O0EOE0
002162

i
£
4

4
an
274
120

0
0
0
[
28
8
27

O0:00: 00, 000, 000, 000
00:00:00.000.000.000
0000 00, 000, 000, 000
00:00:00. 000.000.000
O0:00:00,006.302.320
O0:00:00, 565,200,920
00:00:00,115.7705.730

o.oo3
0,o0s]
0.00%]
0.00s)
0,734
25415 [
5.195)

| D0 :00:00, 000,000,000
| 00:00:00.000.000.000
| 000000, 000,000,000
| 00:00:00.000.000.000
| O0:00:00,000,582.220

Q0:00:00.020.210.350 J

| 00:00:00.004.265.3590

Figure 5.99 Realtime Profile window (function profile)

The information in each of the columns is described in the table below.

Table 5.41 Details on each column

Block Block number

Function Function name

Address Address where the function starts

Size Function size

Count Number of times the function has been called

Time (h:m:s.ms.us.ns)

Cumulative time of function execution
The timestamp is in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds

Statistic

Ratio of the time for the given function to Go-Break time

Average (h:m:s.ms.us.ns)

Average of the execution times for individual passes

If a function is outside the areas to which profile memory is allocated, the address line is grayed-out.
Acquired results of profile measurement are accumulated in memory until the user clears them.
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5.13.4 Setting Ranges for Function Profile Measurement
Choose Set Range from the popup menu that is displayed when you right-click in the window.
The Realtime Profile Setting dialog box will be displayed. Set a profile measurement range in this dialog box.

[Function profile mode]

Realtime Profile Setting x|
Realtime Frofile Mode: [ RNl
— List
Allocation of Profile kemony: Add..
Addresz | Block |
Clear
00000 - 1FFFF 1
EQO00 - FFFFF 2 Al Clear
Default
Save... Load... Help ] Carnicel

Figure 5.100 Realtime Profile Setting dialog box

(1) Memory allocation

Before function profiles can be measured, profile memory must be allocated to the addresses at which measurement will be
performed. Profile data can only be obtained from address ranges to which memory has been allocated.

You can specify any number of blocks 1 to 8 (for a total of up to 1 Mbyte), each beginning on a 128-Kbyte boundary, as areas
for profile measurement.

The blocks may be contiguous or non-contiguous.

With the initial settings, the profile memory is automatically allocated to addresses in the ROM areas.

(2) Automatic detection of functions

When profile memory is assigned to an address range, the E100 emulator automatically detects functions within that range and
adds them to the window.
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5.13.5 Saving Function Profile Measurement Settings

You can save the current profile mode and measurement ranges (memory allocation) for function profiles.

Click on the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter the name of the file where you want the function profile measurement settings to be saved.

If the file-name extension is omitted, “.rpf” will automatically be appended as the extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.6 Loading Function Profile Measurement Settings
You can load function profile measurement settings.
Click on the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

Laoak jr: IaDebu j - I'j{ ER-

Savelatal0z rpf

File name:; |SaveDataElElEl.rpf Open I
Filez aof bype: IFEeaIF'n:ufiIe Files [*.rpf] j Cancel |

Figure 5.101 Open dialog box

v

Enter the name of the file you want to load.

Only files bearing the extension “.rpf” can be loaded. If you enter any other file-name extension, an error message will be
output.

When loading of the file is complete, the list in the Realtime Profile Setting dialog box is updated.

If the information in the loaded file is for a task profile, the profile mode in the Realtime Profile Setting dialog box is switched
to task mode.
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5.13.7 Measuring Task Profiles
The Task Profile mode allows measurement of performance per task.

Realtime Profile )
% B E M A

B. I Task ID [Cnunt [ Time [him:s.ms.us.ns) I Statistic [A.vera.g: (him:=.ms. us.nsj I =
1 0 (HIi000/4) O 00:00:00.000.000.000  o.o0s 00:00:00.000.000. 000

1 1 {_MainTask) 104 00:00:01.129.301.130 29, 46+ 00:00:00.010.958. 660

1 I |_taszk3) 52 D0:00:00.479.046.040 1. 40 00:00:00.009.212 . 420

1 3 (_task3) 103 D0:00:01.332.747.600 34,770 00:00:00.012.939.290

1 4 |_taskd) 51 00:00:00.%91.736.060 23.za:[ I C00:00:00.017.485.020

1 5 {_tasks) o 00:00:00.000.000.000  o.o00:sf00 00:00:00,000.000.000

1 & [TRCEUF) o 00:00:00.000.000.000 0,00 00:00:00.000.000.000

1 T |TRCEUE) O D0:00:00.000.000.000  o.o0s 0 00:00:00.000.000.000

1 8 (TRCEUE) 0 00:00:00,000.000.000  O.00%f 00:00:00.000,000.000

1 9 |TRCEUE) o 00:00:00.000.000.000 0,000 00:00:00.000.000.000

1 10 (TRCBUF) 0 00:00:00,000.000.000  o.o00sf ] 00:00: 00,000,000, 000 =]

Figure 5.102 Realtime Profile window (task profile)

The information in each of the columns is described in the table below.

Table 5.42 Details on each column

Block Block number
Task ID Task ID, entry address
Count Number of times the task has been called

Time (h:m:s.ms.us.ns)

Cumulative time of task execution
The timestamp is in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds

Statistic

Ratio of the time for the given function to Go-Break time

Average (h:m:s.ms.us.ns)

Average of the execution times for individual passes

Disabled tasks are grayed-out.

Acquired results of profile measurement are accumulated in memory until the user clears them.
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5.13.8 Setting Ranges for Task Profile Measurement
Choose Set Range from the popup menu that is displayed when you right-click in the window.
The Realtime Profile Setting dialog box will be displayed. Set a profile measurement range in this dialog box.

[Task profile mode]

Realtime Profile Setting

Bealtime Frofile Mode: ITask Profile

— Lizt
T azk, List:
Taszk D | Entry Addrezs | Block, il
1 _main 1 J
2 _tazk 002 1
3 _tazk003 1
4 _task004 1
a _task005 1
B _taskDOG 1 Enable All Task |
vl 7 tazk D07 1 b
y I Disable & Task |
Save... | Load... | Help | ] Carnicel

Figure 5.103 Realtime Profile Setting dialog box

(1) Automatic detection of tasks

If you have downloaded a load module that includes an OS, the E100 emulator automatically detects the tasks.

(2) Selecting tasks

Select the checkboxes next to the IDs of tasks you want to measure (by default, all checkboxes are selected).
The selected tasks will automatically be assigned block numbers (1-8).

CAUTION

When the eight blocks have been used up, the block number column for further tasks will be blank, indicating that
measurement for tasks with these IDs is not possible. In such cases, deselect checkboxes against the IDs of tasks for which

performance measurement is not necessary.
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5.13.9 Saving Task Profile Measurement Settings

You can save the current settings regarding tasks for measurement (task 1Ds and enabled/disabled states) in task mode.

Click on the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter the name of the file where you want the task profile measurement settings to be saved.

If the file-name extension is omitted, “.rpf” will automatically be appended as the extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.10 Loading Task Profile Measurement Settings
You can load task profile measurement settings.
Click on the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

2]

Laoak jr: IaDebu j - I'j{ ER-

Savelatal0z rpf

File name:; |SaveDataElElEl.rpf Open I
Filez aof bype: IFEeaIF'n:ufiIe Files [*.rpf] j Cancel |

Figure 5.104 Open dialog box

v

Enter the name of the file you want to load.

Only files bearing the extension “.rpf” can be loaded. If you enter any other file-name extension, an error message will be
output.

When loading of the file is complete, the list (of tasks) in the Realtime Profile Setting dialog box is updated.

Even if a loaded task ID does not currently exist, it will be temporarily displayed in the list of tasks in the Realtime Profile
Setting dialog box. However, only tasks with the existing 1Ds will actually be registered when you click on the OK button.
You can re-open the Realtime Profile Setting dialog box to check the currently registered tasks.

If the information in the loaded file is for a function profile, the profile mode in the Realtime Profile Setting dialog box is
switched to function mode.
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5.13.11 Clearing Results of Realtime Profile Measurement
Choose Clear from the popup menu of the Realtime Profile window, and all results of measurement are cleared.
Unless this is done, measurement results are accumulated in memory.

5.13.12 Saving Results of Realtime Profile Measurement
You can save the current results of realtime profile measurement as text.
Choose Save To File from the popup menu of the Realtime Profile window, and the Save As dialog box will be displayed.

Enter the name of the file where you want the results of measurement to be saved.
If the file-name extension is omitted, “.txt” will automatically be appended as the extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.13 Setting the Unit of Measurement
Choose Properties from the popup menu that is displayed when you right-click in the window.
The Properties dialog box will be displayed.

x

b eazurement mntereal |

Measurement interval: I_ vI

0K | Cancel |

Figure 5.105 Properties dialog box

The unit of measurement can be selected from the following options:
10 ns (default), 20 ns, 40 ns, 80 ns, 160 ns, 1.6 us

CAUTION
When the current selection is changed, the measurement results hitherto accumulated are cleared.
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5.13.14 Maximum Measurement Time for Realtime Profiles
(1) Maximum measurement time

The timer used for realtime profile measurement is configured with a 40-bit counter. The maximum measurement time varies
with the selected unit of measurement.

Select the unit of measurement from the Measurement interval drop-down list of the Properties dialog box.

The maximum measurable times for the respective units are listed below.

Table 5.43 Maximum measurable times

Resolution Maximum measurement time
10 ns Approx. 3 hours, 03 minutes, 15 seconds
20 ns Approx. 6 hours, 06 minutes, 30 seconds
40 ns Approx. 12 hours, 13 minutes, 00 seconds
80 ns Approx. 24 hours, 26 minutes, 00 seconds
160 ns Approx. 48 hours, 52 minutes, 01 seconds
1.6 ps Approx. 488 hours, 40 minutes, 18 seconds
CAUTION

Note that results of performance measurement carry an error equal to +(twice the resolution + 100ns), e.g. £140 ns when the
resolution is 20 ns, each time a function is entered. If the resolution is 20 ns and a function is entered 10 times, the error is
+1400 ns.

(2) Maximum measured number of calls
For a realtime profile, a 16-bit counter measures the number of times a task or function is executed. Measurement of up to
65,535 calls is thus possible.
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5.14  Detecting Exceptional Events

5.14.1 Detecting Exceptional Events
The E100 emulator permits you to detect the occurrence of various exceptional events during user program execution.
Exceptional events include abnormal behavior of the user program, as well as an overflow of the measurement counter for

break, trace, or performance analysis. Detection of a specific exceptional event can be set as a condition of a breakpoint or
trace point.

(1) Exceptional events

The E100 emulator detects the exceptional events listed below.

- Violation of access protection: An error is detected when access in violation of a specified access attribute is attempted.

- Reading from non-initialized memory: An error is detected when a non-initialized area (not written) is read.

- Stack access violation: An error is detected when the value of the stack register is beyond a boundary of the stack area.

- Performance-measurement overflow: An error is detected when the time measurement counter for a section has overflowed.

- Realtime profile overflow: An error is detected when the maximum measurable time or maximum measurable number of
passes is exceeded during profile measurement of a function (or a task).

- Trace memory overflow: An error is detected when the trace memory has overflowed.

- Task stack access violation: An error is detected when one task attempts writing to the task stack of another task.

- OS dispatch: An error is detected if a task dispatch has occurred.

5.14.2 Detecting Violations of Access Protection
Violations of access protection such as writing to a ROM area or access to an unused area (for reading, writing, or execution of
an instruction) can be detected as an error.

(1) Access attributes

The following attributes are specifiable in word units for any area.

Read/Write: Accessible for both reading and writing

Read Only: Only accessible for reading

Write Only: Only accessible for writing

Disable: Access prohibited

Disable (OS): Access other than from the OS is prohibited (this attribute is automatically assigned when a program that
includes an OS is downloaded).

(2) Protected areas

Any area in the entire memory space can be protected.
At the time the emulator is booted up, all areas are assigned the Read/Write attribute by default.
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(3) Methods of setting protection

There are the following two methods:

- Automatic setting by section information in a downloaded module
- Individually specifying an access attribute for an area

(4) Method of detection
Violation of access protection is detected by internal resources (blocks 1-16) of the emulator.

The blocks are automatically allocated by an original algorithm of the emulator.

CAUTION
Since the emulator’s internal resources are limited, not all blocks can be protected. If an error occurs, reduce the number of
assigned blocks by using the ‘Delete’ button before setting protection again.

Access attribute

Read/Write
Write -> Read Only -> Violation detected
Read -> Write Only -> Violation detected
Read -> Disable -> Violation detected
Write

Figure 5.106 Patterns for detecting violation

(5) Action taken when violation of access protection is detected

The following actions are selectable.

- Display a warning.

After the Violation of access protection checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of violation of access protection a condition of a hardware breakpoint.
- Make the detection of violation of access protection a condition of a trace point.
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5.14.3 Setting Protection for an Area
Follow the procedure below to set protection for an area.

(1) From the Hardware Break dialog box

1. Select the Exception checkbox on the Hardware Break sheet and then click on the Detail button.

B orare oreaict BES
Hardware Break, IQR i Exxteption |

condition and combination sexting

¥ OR condtion:

Eventinue: 0 Detal

1 Othar condthons: ———

AR A CoamLERinn ) i

Event i uge | O W[

7 Evckciian: = Tokal i 0 Event
i~ Delayioyde): ——
Exceptional
pirerel L ! | —
1
Eventuged 0O Freels Dubui.l Regishered events...
Savacan | ised mep | ey [ ces= |

Fo

Figure 5.107 Hardware Break dialog box

2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection
checkbox.

[N Hardware Break *

=[O0 =}

Harcuare Break | o Exceation |

[ Winlation of access protaction Dekai... I
[" Read from a unintislized memery
[T Stack access violation Diekal..,

[ Performanca overflow
[ Raltime profils ovesfices

I__ Trace memary gwerflaw

[T Task stack aceess vinlation Catal, . I
[ o5 dspatch

Ewent used 0 Free L6 Dutui.l Registered events. ..

Save.. | Losd.. ke | apnly [ ciose L
Figure 5.108 Hardware Break dialog box
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3. The Violation of access protection dialog box shown below will be displayed.
To have the access attributes automatically set according to the section information in the downloaded module when a
program is downloaded, select the checkbox labeled “Automatically set address areas at downloading.”

Yiolation of access protection X|

v automatically set address areas at downloading

Addrezs Areas:

Block Mo | Label | Start Addrezz - End Address | Access At | Update
01 [8KE) 00000000 - 00001 25F Read write Add
01 [BKE] 00007260 - 00001FFF Dizable =
02 [1kB] Q0002000 - 000EFFFF Dizable dindify...
02 [1k4B) 000OF0000 - 000F1FFF Read Only
03 [BKE) 000F2000 - 000F 39E 3 Read Only
03 [BKE] 000F35E4 - D00F 3FFF Dizable [elete
02 [1kB] Q00F 4000 - 000FDFFF Dizable —
04 [BKE) Q0OFEDCO - DOOFEOFF Read Only Dielete the block
04 [BKE] O0OFET00 - DOOFFFDE Dizable Delete
04 [8KE) 000OFFFDC - OOOFFFFF Read Only -
=[] 00100000 - 00FFFFFF Readfwfrite

Cancel

Help

Figure 5.109 Violation of access protection dialog box

4. Click on the Update button, and the access attributes will be updated according to the section information in the downloaded
module.

5. To add an access attribute manually, click the Add button. The Access protection condition dialog box shown below will
appear. Specify any address range and access attribute.

Access protection condition EI
Start Address: IEUUU j @
End Address:  [FFFF = =
attribute: winte Qi

] I Cancel |

Figure 5.110 Access protection condition dialog box
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6. The protected area you have added will be displayed in the Address Areas list of the Violation of access protection dialog
box.

x
¥ Automatically zet address areas at downloading
Addrezs Areas:
Block Ha. | Label | Start Addrezs - End Address | Access At |
01 (BB Q0000000 - 00001 25F Fead wite
01 [BKE) 00001 260 - 00001 FFF Dizable
02 [1ME] 00002000 - 000D FFF Dizable
0z [1E] O000E D00 - OO0JFFFE Wit Orly
02 [1ME] 0007 0000 - D00EFFFE Dizable
02 [1k4B) 000FQ000 - 000F1FFF Read Only [elete
03 [BkB] O00F 2000 - 000F39E 3 Fead Only —
03 (8KE) 000F33E 4 - O00F3FFF Disable elete the block
02 [1ME] 000F4000 - D00FDFFE Dizable Delate al
04 [BKE) O00FEQOO - OOOFEOFF Read Only -
04 [BEB] O00FE100 - OOOFFFDE Dizable
04 [BkEB] O00FFFDC - OOOFFFFF Fead Only K |
=[] 007 00000 - D0FFFFFF Fead it
Cancel
Help
Figure 5.111 Violation of access protection dialog box
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(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception checkbox and then click on
the Detail button.

-loix]
Trace JoR | Exception | Option |
E’rﬂ r-'ln&al 'm...' aly = Fll around TR j]
(-7 OR condiion;

| Event buse: 0 Detal |

i—l‘ou-ermﬂﬁm::—

AN Smutansos) o

| Evercinusazg | Detef _I

|' [¥ Excspticn: 'I rmﬁhﬁ"“_‘

| D-xm b I | T -
:'Rul:brrll:\mﬁﬁm:

| &+ Al Capbure Do nat capburs I7 Step exeeitionis racprded

| j Dl

I Ewant inuss: 0
Event ised @ Fres L6 D-Etﬂi---l Regstered events...
Sawm.. | Losd... web | oaepty [ chse |

Figure 5.112 Trace conditions dialog box

2. The Exception page shown below will appear. Click on the Detail button to the right of the Violation of access protection
checkbox.

inix)
Trce | OR Excopton | optim |

[ wicdation of access protection 1 Detal. .. ] .

™ Biead from & urinkisized memecy  Detal, ..
[ Stack avcess vaolaton Dol

™ Parformance overfion
[ Raakive peofile avarflos

I Task shack aocess violation petad.. | |

[ 0s dispatch
Evenkused © Frest6 Detai... | Fiexgstered myents...
save.. | Load... Heb | el | Clrses |

Figure 5.113 Trace conditions dialog box
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3. The Violation of access protection dialog box will be displayed.
The rest of the procedure is the same as if you opened the Violation of access protection dialog box from the Hardware Break
dialog box.

5.14.4 Detecting Reading from a Non-initialized Area
Reading from a non-initialized area, i.e. cases of reading from a memory location to which nothing has been written, can be
detected as an error.

(1) Method of detection

Reading from a non-initialized area is detected by the RAM monitoring facility.
Allocate a RAM monitoring area to a given address range and enable error detection in that area.

Detection circuit

Neither reading -> ->  Error

.. <Comparison>
nor writing has . detected
Has access proceeded in the order
proceeded at the

. “reading then writing”?
location g g

Figure 5.114 Outline of detection of reading from a non-initialized area

(2) Action taken when reading from a non-initialized area is detected

The following actions are selectable.
- Display a warning.

When the Read from uninitialized memory checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

Data is colored in the RAM Monitor window.

- Make the detection of reading from a non-initialized area a condition of a hardware breakpoint.
- Make the detection of reading from a non-initialized area a condition of a trace point.
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5.14.5 Detecting Stack Access Violations
Setting the size of the stack too small in software development raises the possibility of a program going out of control or
malfunctioning. The E100 emulator actively detects abnormal access by the stack pointer.

(1) Setting stack areas

Selecting a stack section automatically assigns the addresses of the section as a stack area. Alternatively, you can enter any
desired address range. Up to 4 stack areas can be specified.

(2) Initial settings when the emulator is booted up

At the time the emulator is booted up, the default section (‘s”) is automatically selected. However, automatic selection does not
proceed until a program is downloaded, because there is no address information before this.

(3) Method of detection

The emulator monitors the value of ER7 and detects if the value points to a location outside the stack areas.

Detection circuit

| ER7 value -> <Compare>
Whether the value of ER7 points | -> Error
Up to 4 stack -> outside the stack areas detected
areas

Figure 5.115 Outline of detection of a stack access violation

The emulator will detect the error if the value of the stack pointer is beyond the stack areas on

1. generation of an interrupt or return from an interrupt handler;
2. calling of a function or return from a function; or
3. the stack pointer pointing to a location outside reserved stack areas.

CAUTION

Detection does not cover cases of corruption of data within a stack area.
(4) Actions taken when a stack access violation is detected

The following actions are selectable.

- Display a warning.

When the Stack Access Violation checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a stack access violation a condition of a hardware breakpoint.
- Make the detection of a stack access violation a condition of a trace point.
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5.14.6 Detecting a Performance-Measurement Overflow
A time in performance measurement coming to exceed the maximum value can be detected as an error.
Timeout case in a performance measurement is referred to as a performance overflow.

(1) Action taken when a performance-measurement overflow is detected
The following actions are selectable:
- Display a warning.

A warning is displayed in the Performance Analysis window.

The section of the program where the performance overflow occurred is marked “overflow.”

When the Performance Overflow checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a performance-measurement overflow a condition of a hardware breakpoint.
- Make the detection of a performance-measurement overflow a condition of a trace point.

5.14.7 Detecting a Realtime Profile Overflow

A time or number of passes in realtime profile measurement coming to exceed the maximum value can be detected as an error.
Overflows of the counters for time and number of passes for realtime profiling are collectively referred to as realtime profile
overflows.

(1) Action taken when a realtime profile overflow is detected
The following actions are selectable.
- Display a warning.

A warning is displayed in the Realtime Profile window.

The line of the function or task in which a timeout or count-out occurred is marked “overflow”.

When the Realtime Profile Overflow checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a realtime profile overflow a condition of a hardware breakpoint.
- Make the detection of a realtime profile overflow a condition of a trace point.
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5.14.8 Detecting a Trace Memory Overflow

Overflows of the trace memory (4 M cycles) can be detected as errors.
(1) Action taken when a trace memory overflow is detected

The following actions are selectable.

- Display a warning.

When the Trace memory overflow checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a trace memory overflow a condition of a hardware breakpoint.

5.14.9 Detecting Task Stack Access Violations
This facility is only available when a load module that includes an OS has been downloaded. The emulator detects an error
when one task attempts writing to the task stack for another task.

(1) Initial settings when the emulator is booted up

At the time the emulator is booted up, the checkbox labeled “Automatically set address areas at downloading” is selected
(flagged by a check mark). However, automatic selection does not proceed until a program is downloaded, because there is no
address information before this.

(2) Action taken when a task stack access violation is detected

The following actions are selectable.

- Display a warning.

When the Task stack access violation checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a task stack access violation a condition of a hardware breakpoint.
- Make the detection of a task stack access violation a condition of a trace point.
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5.14.10 Setting a Task Stack Area

Follow the procedure below to set a task stack area.

(1) From the Hardware Break dialog box

1. Select the Exception checkbox on the Hardware Break sheet and then click on the Detail button.

Bardvware Brieak IQ,R I Exteption |

condition and combination setding
¥ OR condtion:

Eventinwe: 0 Dotal

1 Othar conditions:

|armacemission)

Eventifiuge | O

¥ Exception: —

Exceptiansl
e Dekai

e

- Dlayicydel ——
|| —1

Tokal: 0 Evenk

=[0f =

Event used 0 Freels {}ntui.l

Registered evenks. ..

Save. | Losd.. R | oapply [ s |

F

Figure 5.116 Hardware Break dialog box

2. The Exception page shown below will appear. Click on the Detail button to the right of the Task stack access violation

checkbox.
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[N Hardware Break * =10 =}

Hardware Bresk | 0  Excentian |

[T “iolation of access protaction Dekal...
[ Resd from a uninkizlzed memery  Dekal...

[ Stack access violation Detal...

[ Performance avarflowm
[ Pealtine profike ovesfos
[T Trace memary overflaw

[T Tesk stack access vialation Datal...
[ o5 dspatdh

Evertused 0 Free1s Debai.. | Registered cvenks. .
sava. | Losd.. ke | oapply [ cose |

g

Figure 5.117 Hardware Break dialog box

3. The Violation of task stack access dialog box shown below will be displayed. To have the task stack areas automatically set
when a program is downloaded, select the “Automatically set address areas at downloading” checkbox.

Yiolation of kask stack access . x|

[v &igomaticaly set address areas at downloading
Addiess aress [4KByte Block FFEDO - FFEFFF)

TazkiD | Label | Start Address - End Address
1 [_ManTazk] OOFFEQDD - DOFFEQOF
2 [task?) OOFFEQI0 - OOFFEQTF
2 taskd] DOFFEQ20 - DOFFEQZF
faleal i
[e|ete
Delete 4l
0K
Cancel
Help

Figure 5.118 Violation of task stack access dialog box

4. Click on the Update button, and the task stack areas will be automatically set.

5. To manually add a task stack area, click on the Add button. The Task stack access condition dialog box shown below will
appear. Specify any task ID and the address range of the corresponding task stack.
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Task stack access condition x|

TaskID |4 Select... |

Start Address: |ffen3n | @
End Address:  [ffe03f = @

ak. I Cancel |

Figure 5.119 Task stack access condition dialog box

6. The task stack area (or areas) you have added will be displayed in the Address Areas list of the Violation of task stack
access dialog box.
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(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception checkbox and then click on
the Detail button.

M Trace conditions *

Trace IQR | Excepkion I Crption I

E‘rmeh'lude: I ET tntee

' Fill around TP j]

condiion and combination setting
~¥ OR condtion:

Everkinuse: 0  Detai

—I Other conditons:
I.ﬁ.f{'i.ﬁ.ccumubhnn) _ﬂ

Eventinuse; 0 HEtSl ]

Total: O Event

¥ Exception: ‘I
( Emﬂl'f‘“:' Detai J

Dalay{opde): ——
I (ni] -

- Record conditon:
Al Capture T Donok capbure

T step execution is recardes

Event inuge ;0

Everk used 0 Freel6 Detail,.. Reqishered events. ..
save.. | Load.. | Hep | eeply [ close |
g
Figure 5.120 Trace conditions dialog box
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2. The Exception page shown below will appear. Click on the Detail button to the right of the Task stack access violation
checkbox.

[N Trace conditions * =0l x|

Trace | OR  Excception | option |

[ ¥iolakion of access probection Dekall...
[ Read from auninkialized memary  Dekall,.,
[ Skadk access vialabon Diekail,.,

[ Performance overflow
[ Reakime profile overflow

. [ Task stack access viclation I

[ 5 dispatch |
| Evertused 0 Free16 Detal... | Registered events.., |
SEVE, ., | Load. .. ] Help | Apnly I Cloze I

g

Figure 5.121 Trace conditions dialog box

3. The Violation of task stack access dialog box will be displayed. The rest of the procedure is the same as if you opened the
Violation of task stack access dialog box from the Hardware Break dialog box.

5.14.11 Detecting an OS Dispatch

This facility is only available when a load module that includes an OS has been downloaded. The emulator detects the
generation of task dispatch as an error.

(1) Action taken when an OS dispatch is detected

The following actions are selectable:

- Display a warning.

When the OS dispatch checkbox has been selected on the Exception Warning page of the Configuration properties dialog box,
you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of an OS dispatch a condition of a hardware breakpoint.
- Make the detection of an OS dispatch a condition of a trace point.
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5.15 Using the Start/Stop Function

The emulator can be made to execute specific routines of the user program immediately before starting and immediately after
halting program execution. This function is useful if you wish to control a user system in synchronization with starting and
stopping of user program execution.

5.15.1 Opening the Start/Stop Function Setting Dialog Box

The routines to be executed immediately before starting and after halting execution of the user program are specified in the
[Start/Stop function setting] dialog box.

To open the Start/Stop function setting dialog box, choose Setup -> Emulator -> Start/Stop function setting... from the menu.

StartStop Function sebting _ |

Wik addiess lm ﬂ @

u The specified rouine iz executed immediately before
ewection of the user's program.

Starting address =] @

|— The specified routing iz executed immediatel gfter the
stop of the user's program,

Stating addess | =] =
ok, | cancel ] Help |

Figure 5.122 Start/Stop function setting dialog box

5.15.2 Specifying the Work address
Use this command to specify the address of a work area for use by a routine to run before the user program execution is started
or after user program execution is stopped.

CAUTION
The specified address must be in the RAM area and not used by the user program.

5.15.3 Specifying the Routine to be Executed

The routines to run immediately before starting and after halting execution of the user program are specified separately.

When the [The specified routine is executed immediately before execution of the user’s program] checkbox is selected, the
routine specified in the [Starting address] combo box, which is below the checkbox, is executed immediately before execution
of the user program starts.

When the [The specified routine is executed immediately after the stop of the user’s program] checkbox is selected, the routine
specified in the [Starting address] combo box, which is below the checkbox, is executed immediately after execution of the
user program stops.
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5.15.4 Limitations of the Start/Stop Function

The start/stop function is subject to the following limitations.

- The debugging functions listed below are not to be used while the start/stop function is in use.
(a) Memory setting and downloading into the program area of a routine specified as a start/stop function.
(b) Breakpoint setting in the program area of a specified routine

- While either of the specified routines is running, the 4 bytes of memory pointed to by the interrupt stack are in use by the
emulator.

Table 5.44 Limitations to the registers and flags

Register/flag Name Limitations

ERY register When a specified routine has ended, the value of this register must be restored to one that
it had when the specified routine started.

CCR register, | flag Interrupts are disabled while a specified routine is executed.

- When either of the specified routines is running, the debugging functions listed below have no effect.
(a) Tracing
(b) Break-related facilities
(c) RAM monitoring
- While either of the specified routines is running, interrupts other than WDT are always disabled.
- The table below shows which state the MCU will be in when the user program starts running after execution of a routine
specified as a start function.

Table 5.45 MCU status at start of the user program

MCU Resource Status
MCU general-purpose These registers are in the same state as when the user program last stopped or in states
registers determined by user settings in the Register window. Changes made to the contents of

registers by the specified routine are not reflected.

Memory in MCU space | Access to memory after execution of the specified routine is reflected.

MCU peripheral Operation of the MCU peripheral functions after execution of the specified routine is
functions continued.

5.15.5 Limitations on Statements within Specified Routines

Statements within specified routines are subject to the limitations described below.

- If a specified routine uses a stack, the stack must always be the user stack.

- The processing of a specified routine must end with a return-from-subroutine instruction.

- Ensure that a round of processing by a specified routine is complete within 10 ms. If, for example, the clock is turned off and
left inactive within a specified routine, the emulator may become unable to control program execution.

- The values stored in the registers at the time a specified routine starts running are undefined. Ensure that each specified
routine initializes the register values.
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5.16  Using the Trigger Output Function

The trigger output function is for the output of signals through an external trigger cable (this is a separately sold product).
Connect the external trigger cable according to the instructions given in the user’s manual for the cable.

To make the trigger output function effective, trigger pin numbers 31 to 16 must be designated for output. Note, however, that
operation of a trigger pin depends on its pin number. Table 5.46 lists the trigger pin numbers and how they operate.

Table 5.46 Trigger Pin Numbers and Operation

No. Operation

31to24 These pins constantly output a signal; either high or low can be selected.

23 A high-level signal is output when a breakpoint is encountered.

22 A high-level signal is output when a trace point is encountered.

21 A high-level signal is output when specific trace data is extracted or discarded.

20to 16 An event can be specified for each of the signals and a high-level signal is output
when that event occurs.

Output is at the power voltage level of the target system. If the MCU in use has two power supplies, the level on VCC1 will be
applicable.

5.16.1 Using the External Trigger Cable for Output
You can specify input and output through the external trigger cable on the System page of the Configuration properties dialog
box. Select the ‘EXT 0-15 INPUT EXT16-31 OUTPUT’ radio button for ‘External trigger cable’.

Configuration propetrties 5[

System | Internal flash memary ovenarite I E scephion *Warning I

— Clack
ET &% Emulatar " User " Generate

I 10 MHz

Sub & Emulator 7 Usger

— Trigger

. ExT 0-15 IMPUT
External igger cable ¢ EXT 0-31 INFUT | & EXT16-31 OUTPUT

¢~ ExT 015 TTL

[rput trigger level ¥ ExT 0-31 CMOS ExT16-31 CMOS

Figure 5.123 Configuration properties dialog box (System page)
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5.16.2 Opening the Trigger Output Conditions Dialog Box
Choose [Event -> Trigger Output Conditions] from the View menu, or click on the ‘Trigger Output Conditions’ toolbar button

[

I Trigeer Cutput Conditions

Manual output | Event output I

—Current trigger oukpuk
31 30 29 28 27 26 25 24

Cutput contents | L " L || L " L || L " L " L ” L |

—Qwkpuk Erigger setkings
31 30 29 25 27 26 25 24

Cukpuk sekking : | ) | ) | _ | _ | ) I ) I _ I Okput I

| add pattern I

Qukbput pattern:

Mo.| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 |

elete |

Event used 2 Free 14 Detail...l Registered events...l
Save, ., | Load... | Help | Gl I Close I

4

Figure 5.124 Trigger Output Conditions dialog box

Note that you cannot open the Trigger Output Conditions dialog box in either of the following cases.
e ‘EXT 0-31 INPUT’ has been selected on the System page of the Configuration properties dialog box.
e  An external trigger cable is not connected.
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5.16.3 Manual Setting for Output through Trigger Pins 31 to 24
Make the manual settings for output through trigger pins 31 to 24 on the Manual output page.

I Trigeer Cutput Conditions

Manual output | Event output I

—Current trigger oukpuk
31 30 29 28 27 26 25 24

Cutput contents | L " L || L " L || L || L " L || L |

—Qwkpuk Erigger setkings
31 30 29 25 27 26 25 24

Cukpuk sekking : | ) | ) | _ | _ | ) I ) I _ I Ok put I

| add pattern I

Qukbput pattern:
Mo.| 31 | 30 | 23 | 28 | 27 | 26 | 25 | 24 | -
1 - - - - - - - L
2 - - - - - - H L
3 - - - - - L H L
4 - - - - H L H L —
5 - - - L H L H L
6 - - H L H L H L hd
Delete |
Event used 0 Free 16 Detail...l Registered events...l
Save, ., | Load... | Help | Gl I Close I

g

Figure 5.125 Trigger Output Conditions dialog box (Manual output page)

(1) Display of output states: ‘Output contents’

‘Output contents’ indicates the current signal levels on trigger pins 31 to 24.
H: High
L: Low
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(2) ‘Output setting’

‘Output setting’ indicates the levels of signals to be output through trigger pins 31 to 24. Clicking on one of these buttons
changes the state of the corresponding pin in the following order.

P L 2Ho»— —‘

L: Low
H: High
—: The previous setting is retained.

When the Trigger Output Conditions dialog box is opened, the states of all signals in the ‘Output setting’ section are always
indicated as ‘—’, whether the previous setting was L or H.

(3) Starting output of signals

Click on the ‘Output’ button to validate the settings and start output of signals.

(4) Saving output patterns

You can save the settings on trigger pins 31 to 24 and reflect a saved setting as the ‘Output setting’. This simplifies operations.
After making settings for an ‘Output setting’, click on the ‘Add pattern’ button. The new setting will be added as the last line
in the ‘Output pattern’ list.

Up to 256 patterns can be added.

Double-clicking on a line in the ‘Output pattern’ list reflects the information on the line as the ‘Output setting’.

The order of the lines (patterns) can be changed by dragging and dropping.

To delete a pattern, select the line and click on the ‘Delete’ button.
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5.16.4 Setting for Output through Trigger Pins 20 to 16
The Event output page allows manual setting for output through trigger pins 20 to 16.

M Trigeer Cutput Conditions

Manual oukput  Event output

—Default setking
Mo, 23: Breakpaoint is encountered,
Mo, 22: Tracepoint is encountered,
Mo, 21 Capkure or Do Mok Capture of trace dakta,

— Trigger oukpuk event

Ewvenk | Mo, | T.l Descriptions | Ca... | Ta... | Comrnenkt
SO ;0 F [Address] 000000
mlevo:  BE [Size] WORD [Type... - -
kIl 15 T [Trigger] - - o - -
17 1 [Interrupt] generate
A 15 F [Address] 000000

add),., | [Ielefe | Emakile | [isatle |

Eventused 5 Free 11 Detail...l Registered events...l

Help | Gl | Close |
B

Figure 5.126 Trigger Output Conditions dialog box (Event output page)

(1) Default setting

‘Default setting’ indicates the trigger output conditions on pins 23 to 21. These pins are always enabled. Signals are output
through these pins when the respective conditions are satisfied. Table 5.47 gives details on how the conditions control output.

Table 5.47 Trigger Output Conditions and Output

No. Condition Output
23 A breakpoint is Continued output of a high-level signal is started.
encountered
22 A trace point is A high-level signal is output only during cycles in which the
encountered trace-point condition is satisfied.
21 Specific trace data is A high-level signal is output only in cycles where trace data is
extracted or deleted being extracted or discarded.
R20UT0967EJ0402 Rev.4.02 Page 204 of 230

Sep.01.21 RENESAS



ROE420000MCUO00 User’s Manual 5. Debugging Functions

(2) Trigger output event

You can specify an event for trigger pins 20 to 16. A high-level signal will only be output while the event is occurring.

CAUTION
The actual trigger output follows event detection after some delay. The number of cycles of delay varies with the product. The
delay for trigger output in the ROE420000MCUOQO is 9 cycles.

5.16.5 Events
For details on the setting of events, refer to, “5.7 Using Events” (page 106).

5.17 Measuring the Execution Times in a Specific Section

Measurement of the execution times in a specific section of the program is possible. This facility takes the trace data for
instruction fetching at event points (start and end) used to specify the extraction of trace data and then outputs the timestamps
and their differences to a file in a format that is editable in Microsoft Excel.

Timestamps for up to 2-M cycles of trace data will be output to the file.

Each section is defined by two events (start and end events) and up to eight sections are specifiable.

Follow the procedure below to measure the execution times in a specific section of the program.

CAUTION

This facility is only supported by command-line operation. To measure the execution times for a specific section of the
program, be sure to specify the events on the same line as the command. Such measurement is not possible for events that have
been specified in the [Trace conditions] dialog box. Before using this facility, disable all events registered as hardware-break,
tracing, and performance-measurement conditions.

Follow the following procedures to measure the execution times in a specific section of the program.

5.17.1 Setting Trace Conditions
Trace conditions can be specified on the command line.

(1) Selecting the mode of tracing

Select “fill until stop’, “fill until full’, or “fill around TP’ as the trace mode. Examples of the commands are given below.

| event_trace_mode fr  (fill until stop) |

| event_trace_mode fu _(fill until full) |

| event trace mode po  (fill around TP) |
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(2) Specifying the start and end events

Specify the start and end events that define the points where the desired section starts and ends, along with the following
conditions.

Do not select any other event type or address condition.

Event type: Instruction fetch
Address condition: Specified value (=)

To specify sections from H’1000 to H’10FF and from H’2000 to H’20FF, for example, enter commands as follows.

event_set ev1 f address eq 0x001000 cnt 0x1
event_set ev2 f address eq 0x0010FF cnt 0x1
event_set ev3 f address eq 0x002000 cnt Ox1
event set ev4 f address eq 0x0020FF cnt 0x1

(3) Selecting an option for ‘Record condition’

You should specify extraction of trace data during the event. No other conditions should be selected.

An example of a command that specifies ‘Extraction” and ‘Duration of an event’ for the events set in step (2) is given below.

event_trace acquisition apo evl ev2 ev3 ev4

(4) Selecting an option for tracing

Select ‘Event number” as an option for tracing. Do not select any other options. An example is given below.

event_trace option ev |

5.17.2 Acquiring Trace Data
Run the user program and acquire the trace data.

5.17.3 Specifying a Section

You can use the TRACE_EXECUTE_SECTION_SET command to specify a section. An example of commands to specify
section 1 that starts with event 1 and ends with event 2 and section 2 that starts with event 3 and ends with event 4 is given
below.

trace_execute_section_set 1 start ev1 end ev2
trace_execute_section_set 2 start ev3 end ev4
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5.17.4 Saving the Execution Times to a File

After the trace data has been acquired, you can use the TRACE_EXECUTE_SAVE command to save the execution times in

the specified section to a file with extension .csv.

The command description given below is an example where the execution times for sections 1 and 2 are saved in result.csv
under the configuration directory.

trace_execute_save 1 2 $(CONFIGDIR)\\result.csv

The contents of the .csv file opened in Microsoft Excel will be as follows.

Example:
|l B | © | E |
1 |[<START1> < ENDY >
2 | 1000 10FF < Section 1 (start: 0x1000, end: 0x10FF)
3 |BExecution time |Start time End time
4 | 100 0 100
.5 | 102 1000 1102
6 100 2100 2200
L7 | 58 3000 3088
N 1200 5000 fiz 00
5 103 7000 7103 Within the acquired data, an execution
10 - geo0 - time is not given if a start event has no
11 1201 8000 10201 corresponding end event.
12
(13 [<STARTZ> < ENDZ >
14 2000 | 20FF < Section 2 (start: 0x2000, end: 0x20FF)
15 |Execution time Start tirme  End time
16 | 100 0 100
17 | 102 1000 1102
18 | 100 2100 2200
15 | 55 3000 30885
20 | 1200 5000 B200
21 103 7000 7103
o7 |- G200 -
23 | 1201 5000 1020
24 |

Figure 5.128 .csv file opened in Microsoft Excel

The execution time, in nanoseconds, is saved in the file.

Example:

1h 23 m 455678 ms 901 ps 234 ns = 01:23:45.678.901.234 -> 5025678901234

[CAUTION]

Measurement of execution times for specific sections is not possible with events set in the Trace conditions dialog box, so be

sure to specify the events on the command line.

In command files, execute the TRACE WAIT command before using the TRACE_EXECUTE_SAVE command. The
TRACE_WAIT command makes the emulator wait for successful acquisition of the trace data.
For details on commands, refer to the online help information.
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6. Troubleshooting (Action in Case of an Error)

6.1 Flowchart for Remediation of Trouble

Figure 6.1 shows the flowchart for remediation of trouble arising between activation of the power supply to the emulator
system and the emulator debugger starting up. Go through the checks with the user system disconnected. For the latest FAQs,

visit the Renesas Tools Homepage.

https://www.renesas.com/tools

Turn on the power to the emulator

Not normal

Check the LEDs on the emulator

Normal

iew the Device setting

v

1. Check the connection of power cable.
See “2.5 Connecting the Emulator Power Supply

”

Not normal/Error displayed

dialog box of the
emulator debugger

Normal

View the Configuration

v

1. Check the operating environment of the emulator debugger.
See ‘5.1 Setting Up the Emulation Environment”

2. Re-install the emulator debugger.

Not normal/Error displayed

properties dialog box of the
emulator debugger

Normal

View the Connecting

v

See “6.3.(2) On the system page of the Configuration properties
dialog box does not appear in booting-up of the emulator
debugger”

Not normal/Error displayed

dialog box of the
emulator debugger

View the Editor window of the

v

See “6.3.(3) Error occurs in the Connecting dialog box”

Error displayed

emulator debugger

Normal

The emulator debugger has started up

¥

See “6.3.(4) Errors occur in booting-up of the emulator debugger”

Figure 6.1 Flowchart for remediation of trouble
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6.2 Error in Self-checking
When an error occurs in self-checking, check the following items.

(1) Re-check the connection between the E100 emulator main unit and the MCU unit.

(2) Download the proper firmware again.

(3) Check the error log from self-checking by the debugger software, and refer to the instructions given therein (see Figure
6.2).

“Error occurred during the self-check test.”
dialog is displayed

Click on the OK button.

A 4

Check the log in the self-check dialog box.

|

Refer to any instructions in the log.

Figure 6.2 Flowchart for checking of an error in self-checking

Notes on the Self-checking:
Disconnect the MCU unit from a converter board and the user system before you start self-checking.

If the results of self-checking are not normal (excluding status errors of the target system), the product may have
been damaged. Contact your local distributor.
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6.3 Errors Reported in Booting-up of the Emulator

(1) States of the LEDs on the E100 are incorrect

Table 6.1 Points to check for errors indicated by incorrect states of the LEDs on the E100

Error

Connection to
the user system

Point to check

SAFE LED remains lit.

Check that the USB cable is connected.
See ‘2.4 Connecting the Host Machine” (page 28).

SAFE LED does not light up.

Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 27).

Target Status POWER LED Connected Check that power (Vcc) is being correctly supplied to the user
does not light up. system and that the user system is properly grounded (GND).
Target Status RESET LED does Connected (1) Check that the reset pin of the user system is being pulled up.
not go out. (2) When using the emulator without the user system, check if a
converter board is disconnected from the emulator.
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(2) Configuration Properties Dialog Box Does Not Appear in Booting-up of the Emulator Debugger

Table 6.2 Points to check for errors in booting-up of the emulator debugger (1)

Error

Point to check

Communication initialize error

A communication error.

Check all emulator debugger settings and the connection of the interface
cable.
See “4. Preparation for Debugging ” (page 71).

(3) Error Occurs in the Connecting Dialog Box

Table 6.3 Points to check for errors in booting-up of the emulator debugger (2)

Error

Point to check

MCU board is not connected.

Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 27).

The system configuration of the E100 emulator
is not corresponding to the content of the
E100.ENV file.

The combination between the emulator software and the MCU unit is not
correct. Refer to the release notes of the emulator software, and confirm
the combination between the emulator software and the MCU unit.

A timeout error. The MCU's internal clock is
halted. Is system reset issued?

A timeout error. No clock signal is supplied to
the MCU. Is system reset issued?

Check the oscillation of the oscillator module mounted on the MCU unit,
and confirm that the oscillator module is properly mounted.

A timeout error. The power supply to the MCU
is off. Is system reset issued?

Check that power is being correctly supplied to the user system and that
the user system is properly grounded.

(4) Errors Occur in booting-up of the emulator debugger

Table 6.4 Points to check for errors in booting-up of the emulator debugger (3)

Error

Point to check

A timeout error.

(1) Check that the NQPACK etc. mounted on the user system is
soldered properly.
(2) Check that the connector is installed properly to the user system.
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6.4 How to Request Support

After checking the items in "'6. Troubleshooting (Action in Case of an Error)", contact us from the following URL.

https://www.renesas.com/contact

For a prompt response, please fill in the following information;
(1) Operating environment

- Operating voltage: [V]
- Operating frequency: [MHZz]
- User-system; Connected/Disconnected

- Clock supply to the MCU: Emulator/User-system
(2) Condition
- The emulator debugger starts up/does not start up
- The error is detected/not detected in the self-checking
- Frequency of errors: always/frequency (
(3) Problem
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7. Hardware Specifications

This chapter describes specifications of the MCU unit.

7.1 Target MCU Specifications
Table 7.1 lists the specifications of target MCUs which can be debugged with the MCU unit.

Table 7.1 Specifications of target MCUs for the ROE420000MCUQ0

Item Description
Applicable MCU series H8S family H8S/Tiny series
Evaluation MCU R4E420000-EVA
Applicable MCU mode Single-chip mode
Supported MCU groups H8S/20103 group (with 96- or 128-Kbyte ROM and 8-Kbyte RAM)

H8S/20203 group (with 96- or 128-Kbyte ROM and 8-Kbyte RAM)
H8S/20223 group (with 96- or 128-Kbyte ROM and 8-Kbyte RAM)
H8S/20115 group (with 192- or 256-Kbyte ROM and 12-Kbyte RAM)
H8S/20215 group (with 192- or 256-Kbyte ROM and 12-Kbyte RAM)
H8S/20235 group (with 192- or 256-Kbyte ROM and 12-Kbyte RAM)
Power supply voltage Vce: 2.7t05.5V

Maximum operating frequency 20 MHz (power supply voltage: 2.7 to 5.5 V)
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7.2 Differences between the Actual MCU and Emulator
Differences between the actual MCU and emulator are shown below. When using the MCU unit in debugging an application
for the corresponding MCU, take care with regard to the following precautions.

Note on Differences between the Actual MCU and Emulator:
Operation of the emulator system differs from that of the actual MCU in the ways listed below.

(1) Values of General-Purpose Registers after a Reset

Register name MCU Emulator

PC Reset vector value Reset vector value
ERO to ER6 Undefined Undefined

ER7 (SP) Undefined H’10

CCR The | mask bit is 1. The | mask bit is 1.
Other Undefined Undefined

(2) Values of 1/0O Registers after a Reset

Register name Address MCU State.of the Emulator
Running Break
PMCR83 H'FF 005E H'40 H'44 H'44
RSTFR H'FF 0620 H'00 H'10 H'10
LDOCRL H'FF 0627 H'81 H'81 H'01

(3) Oscillator circuit
If the oscillator circuit has been set up by connecting an oscillator between pins PJO/OSC1 and
PJ1/0SC2/CLKOUT, oscillation oscillation is not possible because of the pitch-converter board between
the evaluation MCU and the user system. This is the same for pins X1 and X2.

(4) A/ID converter
The characteristics of the A/D converter differ from those of the actual MCU of the pitch-converter board
etc. between the evaluation MCU and the user system.

Note on RESET# Input:
A low input to pin RESET# from the user system is accepted only when a user program is being executed (only
while the RUN status LED on the E100 upper panel is lit).

Notes on Voltage Detection Circuit:
The MCU unit differs from the actual MCU because of the pitch converter board etc. between the evaluation
MCU and the user system. Final evaluation of the voltage detection circuit (generation of low-voltage-detection
interrupt, low-voltage-detection reset, etc.) must be executed on the actual MCU.

Notes on Maskable Interrupts:
Even if a user program is not being executed (including when run-time debugging is being performed), the
evaluation MCU executes a debug control program. Therefore, timers and other components do not stop running.
If a maskable interrupt is requested when the user program is not being executed (including when run-time
debugging is being performed), the maskable interrupt request cannot be accepted, because the emulator disables
interrupts. The interrupt request is accepted immediately after the user program execution is started.

Take note that when the user program is not being executed (including when run-time debugging is being
performed), a peripheral 1/O interruption is not accepted.
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Note on Software Reset:
When stepping ([Step In], [Step Over], or [Step Out]) through code for processing of a software reset is attempted,
the software reset will not occur.

Note on Final Evaluation:
Be sure to evaluate your system with an evaluation MCU. Before starting mask production, evaluate your system
and make final confirmation with a CS (Commercial Sample) version of the MCU.
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7.3 Connection Diagram

7.3.1 Connection Diagram for the ROE420000MCUQ0
Figure 7.1 shows a partial circuit diagram of the connections of the ROE420000MCUOQO0. This diagram mainly shows the
circuitry to be connected to the user system. Other circuitry, such as that for the emulator’s control system, has been omitted.

See this diagram for reference when you use the ROE420000MCUQO.

H8S/Tiny EV chip
R4E420000-EVA

7431093 -
P1_0toP1_7, P2_0toP2_7, 7 1 330 P1_0toP1_7, P2_0toP2_7,
P3_ 0toP3_7, P5_0toP5_7, . + ANN—>< P3_0to P3_7, P5_0toP5_7,
P8_5to P8_7, P9_0to P9_7 /J;opg—T i P8_5to P8_7, P9_0to P9_7
330
PA_OtoPA_7, PB_Oto PB_7 AV PA_OtoPA_7,
00
AvVCC Ji AvCC
T 99
AVSS - 4A%Y% AVSS
Vi
7451053 4 00
i 330
PJ_0/0OSC1 * + H ANMN—< PJ_0/0SC1
[_ * ;D". vCe
7431083 -
i H 330
PJ_1/0SC2/CLKOUT t t PJ_1/0SC2/CLKOUT
e S
r'\/\/vf 330
NMI# g ANV < NMI#
330
X1 X1
X2 (OPEN) X2 (OPEN)
330
TEST 7, TEST
VCL J_ VCL
% vce
510 kQ 510 kQ
330
RES# a%2%Y% RES#
vce vce
Vss Vss

*: Connected to the inside of the emulator

PB_0to PB_7

User
system

Figure 7.1 Connection diagram for ROE420000MCU00
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7.4 External Dimensions

7.4.1 External Dimensions of the E100 Emulator
Figure 7.2 shows the external dimensions of the E100 emulator.

D: 184 mm

H: 132 mm

Figure 7.2 External dimensions of the E100 emulator
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7.4.2 External Dimensions of the Converter Board (ROE420000CFJ30)

Figure 7.3 shows external dimensions and a sample pad pattern of the converter board (ROE420000CFJ30) for an 80-pin 0.65-

mm

pitch LQFP.
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Figure 7.3 External dimensions and a sample pad pattern for the ROE420000CFJ30
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7.4.3 External Dimensions of the Converter Board (ROE420000CFK30)
Figure 7.4 shows external dimensions and a sample pad pattern of the converter board (ROE420000CFK30) for an 80-pin 0.5-
mm pitch LQFP.
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Y
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Figure 7.4 External dimensions and a sample pad pattern for the ROE420000CFK30
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7.4.4 External Dimensions of the Converter Board (ROE420000CFG40)
Figure 7.5 shows external dimensions and a sample pad pattern of the converter board (ROE420000CFG40) for a 64-pin 0.8-
mm pitch LQFP.
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P4 e
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‘ H H H .......... H H
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Q
©
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=
17.2
N - Unit: mm
10.00 1.00
Figure 7.5 External dimensions and a sample pad pattern for the ROE420000CFG40
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7.4.5 External Dimensions of the Converter Board (ROE420000CFK40)
Figure 7.6 shows external dimensions and a sample pad pattern of the converter board (ROE420000CFK40) for a 64-pin 0.5-
mm pitch LQFP.
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Figure 7.6 External dimensions and a sample pad pattern for the ROE420000CFK40
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7.5 Notes on Using the MCU Unit
Notes on using the MCU unit are listed below. When using the MCU unit in debugging an application for the corresponding
MCU, take care with regard to the following precautions.

Note on the Version of the Emulator Debugger:
Be sure to use this product with the following emulator debugger.
- H8S/Tiny H8S/2400 E100 Emulator Software V.2.01 Release 00 or later

Notes on Downloading Firmware:
Before using this product for the first time, it is necessary to download the dedicated firmware (emulator’s control
software installed in the flash memory in the E100). If you need to download at debugger startup, a message will
appear. Download the firmware following the message.

Do not shut off the power while downloading the firmware. If this happens, the product will not start up properly.
If the power is shut off unexpectedly, re-download the firmware.

Disconnect the MCU unit from the user system before you start downloading the firmware.

Notes on Self-checking:
If self-checking does not result normally (excluding target status errors), the product may be damaged. Then
contact your local distributor.

Disconnect the MCU unit from the user system before you start self-checking.

Note on Quitting the Emulator Debugger:
To restart the emulator debugger, always shut off the power supply to the emulator and then turn on it again.

Note on Display of MCU Status:
The "Status" display you can view in the Connecting dialog box of the emulator debugger shows pin levels of the
user system. Make sure that the pin levels required to select the mode you wish to use are correct.

Note on Emulation of Erase-Suspend Function:
If the operating clock of the bus master (¢s) is at a frequency lower than 8 MHz, emulation of the erase-suspend
function is not possible. If this is attempted, erasure is suspended in response to an interrupt request but then
automatically resumes without the interrupt-exception handling routine being executed.

Note on Vector Offsets:
In cases of contention between activation of the DTC due to one interrupt source and a request for exception
handling due to another interrupt source, the vector-offset facility is not usable. If using the facility is attempted,
the offset for the interrupt vector is always handled as H’0000 regardless of the range written in the vector
definition.

If the DTC is to be used, set the interrupt vector offset register (VOFR) to H’0000 (default value).
*For restrictions imposed by the target MCU, refer to the MCU’s specifications.

Note on Use of Interrupts for the Event Function:
Event interrupts are supported only when the interrupt vector offset register (VOFR) is at its default value,H’0000.

R20UT0967EJ0402 Rev.4.02

Page 222 of 230
Sep.01.21 ENESAS



ROE420000MCUQ0 User’s Manual 7. Hardware Specifications

Note on Clock Supply to the MCU:
The source of the clock signal for supply to the evaluation MCU is selected on the System page of the
Configuration properties dialog box of the emulator debugger.
(1) When "Emulator" is selected:
The supplied clock signal is that generated by the oscillator circuit board on the MCU unit. This is
continually supplied regardless of the states of the user system clock and of user program execution.
(2) When "User" is selected:
The supplied clock signal is that generated by the oscillator in the user system. This depends on the state of
oscillation (on/off) on the user system.
(3) When "Generate" is selected:
The supplied clock signal is that generated by the dedicated circuit in the E100. This is continually supplied
regardless of the states of the user system clock and of user program execution.

Notes on the Watchdog Function:
If the reset circuit of the user system has a watchdog timer, disable the watchdog timer when using the emulator.

Notes on Access Prohibited Area:
You cannot use internally reserved areas. Write signals to these areas will be ignored, and values read will be
undefined.

Note on Breaks:
The following break functions are available in the emulator debugger.

(1) Software break
This is a debugging function which generates a BRK interrupt by changing the instruction at a specified
address to a BRK instruction (a dedicated instruction for use with the emulator) to break program
execution immediately before the system executes the instruction at a specified address. The instruction at
the specified address will not be executed.

(2) Hardware break
This is a debugging function in which detecting the execution of the instruction at a specified address is set
as a break event, and occurrence of the event leads to a break in program execution. The break in program
execution comes after execution of the instruction at the specified address.

(3) Exceptional event
This is a debugging function in which a program is stopped when abnormal operation of the user program
or an overflow of a measurement function’s counter, etc. is detected.

Notes on Software Breaks:
After you have selected the “Debug the program with overwriting of flash memory” checkbox on the [System]
page of the [Configuration properties] dialog box, the setting of software breakpoints in internal ROM becomes
impossible. If you remove the tick from the “Debug the program with overwriting of flash memory” checkbox,
setting such software breakpoints becomes possible.

Notes on Transitions to Low-Power Consumption Modes:

Generation of an interrupt while the emulator is in a low-power consumption mode causes the emulator to leave
the low-power consumption mode. However, the emulator generates an emulation-only interrupt as part of
processing in each of the following cases. Processing in each case will thus also lead to release from the low-
power consumption mode.

(1) Forcible break (caused by pressing the Esc key or the Halt toolbar button)

(2) Break specified in an event detection system

(3) Single-stepping (Step In, Step Over, or Step Out)

(4) Execution of the program by selecting Go at the address of a SLEEP instruction for which a software break

has been set
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Notes on WDT Clock Select Settings:
Since settings made on CKSJ[3:0] bits of the TMWD register are not reflected by single-stepping through the
program, WDT control by single-stepping cannot be exercised. If the settings made on the CKS[3:0] bits of the
TMWD register need to be reflected, execute an operation similar to the one that the limitations on the product
chip dictate (“The register must be written by using the MOV instruction twice in succession”).

Notes on Power Supply to the User System:
Pin Vcc is connected to the user system for monitoring of the voltage. Therefore, power is not supplied to the user
system from the emulator. Design your system so that power is separately supplied to the user system.

The voltage for the user system should be in the following range.
27V <Vce<s5V

Notes on Debugging in CPU Reprogramming Mode:
If you wish to debug programs in the CPU Reprogramming Mode, select the “Debug the program using the CPU
Reprogramming Mode” checkbox in the “Debug function” section of the Configuration properties dialog box.

Restrictions on Debugging in CPU Reprogramming Mode:
If you select the “Debug the program using the CPU Reprogramming Mode” checkbox in the “Debug function”
section of the Configuration properties dialog box, the following operations will be disabled while the user
program is running.
(1) Setting software breakpoints in an internal ROM area
(2) Programming in an internal ROM area

Data Shown during Debugging in CPU Reprogramming Mode:
In the read-array mode, which is one of the CPU Reprogramming Modes, the values shown in windows (e.g.
Memory window) while the user program is running are those of the status registers. When the user program is not
running, on the other hand, the windows show values in memory.

State Mode Values shown in windows

The user program is running | Read-array mode Values of the status registers
Other Values in memory

The user program is not Read-array mode Values in memory

running Other Values in memory

Until you click on the Refresh button on the Memory window or select Access Data Clear from the popup menu
on the RAM Monitor window, old values are shown in the window.

Trace Information on the Event Link Controller:
The [Trace] window of the emulator cannot show the names of event-link destination modules in the following
cases.
(1) Two or more event-link requests are in conflict (in such a case, only the smaller number will be displayed).
(2) Another event-link request is generated within several MCU-clock cycles after an event-link request has
been accepted.
(3) Event-link and program-stop requests are in conflict.

Trace Information in the Case of 32-Bit Access between the DTC and RAM:
The DTC’s register data is stored in the internal RAM. Although the DTC and the internal RAM are connected via
a 32-bit bus, the emulator is only capable of displaying the lower-order 16 bits of data (15 to 0) as trace
information. That is, the higher-order 16 bits (31 to 16) are not displayed.
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RAM Monitor Window in the Case of 32-Bit Access between the DTC and RAM:
The internal RAM, in which information about the registers of the data transfer controller (DTC) is stored, is
connected with the DTC by using a 32-bit bus. However, the E100 emulator can monitor the variations of
information only by 16 bits in length. So if you display contents of the internal RAM in the RAM Monitor
window, information about the registers of the DTC cannot correctly be provided.

Note, however, that even if memory contents are incorrectly displayed in the RAM Monitor window, the CPU is
functioning properly. And, memory accesses made by the CPU and the DTC transfers can be displayed correctly if
you use the RAM monitoring function of the RAM Monitor window.
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8. Maintenance and Warranty

This chapter covers basic maintenance, warranty information, provisions for repair and the procedures for requesting a repair.

8.1 User Registration
When you purchase our product, be sure to register as a user. For user registration, refer to “User Registration” (page 14) of
this user's manual.

8.2 Maintenance

(1) If dust or dirt collects on this product, wipe it off with a dry soft cloth. Do not use thinner or other solvents because these
chemicals can cause the surface coating to separate.

(2) When you do not use this product for a long period, disconnect it from the power supply, host machine and user system.

8.3 Warranty

(1) This product comes with a one-year warranty after purchase.
Should the product break down or be damaged while you’re using it under normal condition based on its user’s manual, it
will be repaired or replaced free of cost.

(2) However, if the following failure or damage occurs to the product under warranty, the product will be repaired or replaced
at cost.

a) Failure or damage attributable to the misuse or abuse of the product or its use under other abnormal conditions.

b) Failure or damage attributable to improper handling of the product after purchase, such as dropping of the product
when it is transported or moved.

c) Failure or damage to the product caused by other pieces of equipment connected to it.

d) Failure or damage attributable to fire, earthquakes, thunderbolts, floods, or other natural disasters or abnormal
voltages, etc.

e) Failure or damage attributable to modifications, repairs, adjustments, or other acts made to the product by other
than Renesas Electronics Corporation.

(3) Consumables (e.g., sockets and adapters) are not covered by the aforementioned repair.

In the above cases, contact your local distributor. If your product is being leased, consult the leasing company or the
owner.
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8.4 Repair Provisions
(1) Repairs not covered by warranty
Problems arising in products for which more than one year has elapsed since purchase are not covered by warranty.

(2) Replacement not covered by warranty
If your product's fault falls into any of the following categories, the fault will be corrected by replacing the entire product
instead of repairing it, or you will be advised to purchase a new product, depending on the severity of the fault.
- Faulty or broken mechanical portions
- Flaws, separation, or rust in coated or plated portions
- Flaws or cracks in plastic portions
- Faults or breakage caused by improper use or unauthorized repair or modification
- Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply
- Cracks in the printed circuit board or burnt-down patterns
- A wide range of faults that make replacement less expensive than repair
- Faults that are not locatable or identifiable

(3) Expiration of the repair period
When a period of one year has elapsed after production of a given model ceased, repairing products of that model may
become impossible.

(4) Carriage fees for sending your product to be repaired

Carriage fees for sending your product to us for repair are at your own expense.

8.5 How to Request Repairs
If your product is found faulty, fill in a Repair Request Sheet downloadable from the following URL. And email the sheet and
send the product to your local distributor.

https://www.renesas.com/repair

A CAUTION

Note on Transporting the Product:
When sending your product for repair, use the packing box and cushion material supplied with this product when
delivered to you and specify handling caution for it to be handled as precision equipment. If packing of your
product is not complete, it may be damaged during transportation. When you pack your product in a bag, make
sure to use conductive polyvinyl supplied with this product (usually a blue bag). When you use other bags, they
may cause a trouble on your product because of static electricity.
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24 | The specifications of the AC adapter were added.
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